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Safety Guidelines

This manual contains notices which you should observe to ensure your own personal safety, as well as to
protect the product and connected equipment. These notices are highlighted in the manual by a warning

triangle and are marked as follows according to the level of danger:

Danger
injury.
Warning
injury.

Caution

> [ [

Caution

Danger indicates an imminently hazardous situation which, if not avoided, will result in death or serious

Warning indicates a potentially hazardous situation which, if not avoided, could result in death or serious

Caution used with the safety alert symbol indicates a potentially hazardous situation which, if not
avoided, may result in minor or moderate injury.

Caution used without the safety alert symbol indicates a potentially hazardous situation which, if not

avoided, may result in property damage.

Notice

Notice indicates a potential situation which, if not avoided, may result in an undesirable result or state.

Qualified Personnel

Only qualified personnel should be allowed to install and work on this equipment. Qualified persons are
defined as persons who are authorized to commission, to ground, and to tag circuits, equipment, and sys-
tems in accordance with established safety practices and standards.

Correct Usage

N

Note the following:

Warning

This device and its components may only be used for the applications described in the catalog or the
technical descriptions, and only in connection with devices or components from other manufacturers

which have been approved or recommended by Siemens.

This product can only function correctly and safely if it is transported, stored, set up, and installed
correctly, and operated and maintained as recommended.

Trademarks

SIMATIC®, SIMATIC HMI® and SIMATIC NET® are registered trademarks of SIEMENS AG.
Some of other designations used in these documents are also registered trademarks; the owner’s rights may be violated

if they are used by third parties for their own purposes.

Copyright Siemens AG 2002 All rights reserved

The reproduction, transmission or use of this document or its contents is not
permitted without express written authority. Offenders will be liable for damages.
All rights, including rights created by patent grant or registration of a utility model
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Preface

The S7-200 series is a line of micro-programmable logic controllers (Micro PLCs) that can control a variety
of automation applications. Compact design, low cost, and a powerful instruction set make the S7-200 a
perfect solution for controlling small applications. The wide variety of S7-200 models and the
Windows-based programming tool give you the flexibility you need to solve your automation problems.

Audience

This manual provides information about installing and programming the S7-200 Micro PLCs and is
designed for engineers, programmers, installers, and electricians who have a general knowledge of
programmable logic controllers.

Scope of the Manual
The information contained in this manual pertains in particular to the following products:
[ $S7-200 CPU models: CPU 221, CPU 222, CPU 224, CPU 226, and CPU 226XM
S7-200 EM 22x expansion modules
STEP 7-Micro/WIN, version 3.2, a 32-bit programming software package for the S7-200

STEP 7-Micro/WIN Instruction Libraries and TP-Designer for TP070, Version 1.0, a set of software
tools for customers who use an S7-200 with other components, such as the TP070 Touch Panel,
Modbus, or a MicroMaster drive

O 0o

Standards Compliance
The SIMATIC S7-200 series meets the following standards:

1 European Community (CE) Low Voltage Directive 73/23/EEC
EN 61131-2: Programmable Controllers - Equipment requirements

[ European Community (CE) EMC Directive 89/336/EEC

Electromagnetic emissions standard
EN 50081-1: residential, commercial, and light industry
EN 50081-2: industrial environment

Electromagnetic immunity standards
EN 61000-6-2: industrial environment

(1 Underwriters Laboratories, Inc.
UL 508 Listed (Industrial Control Equipment) Registration number E75310

1 Canadian Standards Association: CSA C22.2 Number 142 Certified (Process Control Equipment)

(O Factory Mutual Research: FM Class |, Division 2, Groups A, B, C, & D Hazardous Locations, T4A
and Class |, Zone 2, IIC, T4

Refer to Appendix A for compliance information.
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Maritime Approvals

At the time this manual was printed, the SIMATIC S7-200 series met the maritime agencies identifed
below. For the latest product approvals, contact your local Siemens distributor or sales office.

Agency Certificate Number
Lloyds Register of Shipping (LRS) 99 /20018(E1)
American Bureau of Shipping (ABS) 01-HG20020-PDA
Germanischer Lloyd (GL) 12 045 - 98 HH

Det Norske Veritas (DNV) A-8071

Bureau Veritas (BV) 09051 / A2 BV
Nippon Kaiji Kyokai (NK) A-534

How to Use This Manual

If you are a first-time (novice) user of S7-200 Micro PLCs, you should read the entire S7-200
Programmable Controller System Manual. If you are an experienced user, refer to the table of contents or
index to find specific information.

The S7-200 Programmable Controller System Manual is organized according to the following topics:

a

a

a

a

Chapter 1 (Product Overview) provides an overview of some of the features of the S7-200 family of
iViicro PLC products.

Chapter 2 (Getting Started) provides a tutorial for creating and downloading a sample control
program to an S7-200.

Chapter 3 (Installing the S7-200) provides the dimensions and basic guidelines for installing the
S7-200 CPU modules and expansion 1/O modules.

Chapter 4 (PLC Concepts) provides information about the operation of the S7-200.

Chapter 5 (Programming Concepts, Conventions, and Features) provides information about the
features of STEP 7-Micro/WIN, the program editors and types of instructions (IEC 1131-3 or
SIMATIC), S7-200 data types, and guidelines for creating programs.

Chapter 6/(S7-200 Instruction Set) provides descriptions and examples of programming instructions
supported by the S7-200.

Chapter 7 (Communicating over a Network) provides information for setting up the different network
configurations supported by the S7-200.

Chapter 8 (Hardware Troubleshooting Guide and Software Debugging Tools) provides information
for troubleshooting problems with the S7-200 hardware and about the STEP 7-Micro/WIN features
that help you debug your program.

Chapter 9 (Creating a Program for the Position Module) provides information about the instructions
and wizard used to create a program for the EM 253 Position module.

Chapter 10|(Creating a Program for the Modem Module) provides information about the instructions
and wizard used to create a program for the EM 241 Modem module.

Chapter 11 (Using the USS Protocol Library to Control a MicroMaster Drive) provides information
about the instructions used to create a control program for a MicroMaster drive. It also provides
information about how to configure the MicroMaster 3 and MicroMaster 4 drives.

Chapter 12 (Using the Modbus Protocol Library) provides information about the instructions used to
create a program that uses the Modbus protocol for communications.

Appendix A (Technical Specifications) provides the technical information and data sheets about the
S7-200 hardware.

The other appendices provide additional reference information, such as descriptions of the error codes,
descriptions of the Special Memory (SM) area, part numbers for ordering S7-200 equipment, and STL
instruction execution times.
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Additional Information and Assistance

Information about the S7-200 and STEP 7-Micro/WIN

In addition to this manual, STEP 7-Micro/WIN provides extensive online help for getting started with
programming the S7-200. Included with the purchase of the STEP 7-Micro/WIN software is a free
documentation CD. On this CD you can find application tips, an electronic version of this manual and other
information.

Online Help

Help is only a keystroke away! Pressing F1 accesses the extensive online help for STEP 7-Micro/WIN.
The online help includes useful information about getting started with programming the S7-200, as well as
many other topics.

Electronic Manual

An electronic version of this S7-200 System Manual is available on the documentation CD. You can install
the electronic manual onto your computer so that you can easily access the information in the manual
while you are working with the STEP 7-Micro/WIN software.

Tips and Tricks

The documentation CD includes Tips and Tricks, a set of application examples with sample programs.
Reviewing or modifying these examples can help you find efficient or innovative solutions for your own
application. You can also find the most current version of Tips and Tricks on the S7-200 Internet site.

Internet: www.siemens.com/S7-200

For additional information about Siemens products and services, technical support, frequently asked
questions (FAQs), product updates, or application tips, refer to the following Internet addresses:

| www.ad.siemens.de for general Siemens information

This Siemens Automation & Drives Internet site includes information about the SIMATIC product line
and other products available from Siemens.

1 | www.siemens.com/S7-200 | for S7-200 product information

The S7-200 Internet site includes frequently asked questions (FAQs), Tips and Tricks (application
examples and sample programs), information about newly released products, and product updates
or downloads.


www.siemens.com/S7-200
www.ad.siemens.de
www.siemens.com/S7-200
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Technical Assistance and Purchasing S$7-200 Products

Local Siemens Sales Office or Distributor

For assistance in answering any technical questions, for training on the S7-200 products, or for ordering
S7-200 products, contact your Siemens distributor or sales office. Because your sales representatives are
technically trained and have the most specific knowledge about your operations, process and industry, as
well as about the individual Siemens products that you are using, they can provide the fastest and most
efficient answers to any problems that you might encounter.

Technical Services
The highly trained staff of the S7-200 Technical Services center is also available to help you solve any
problems that you might encounter. You can call on them 24 hours a day, 7 days a week:

(4 For calls originating from within the United States of America
Local time:  Monday to Friday 0800 to 1900 Eastern time
Telephone:  +1 800 241-4453
Fax: +1 (0) 770 740-3699
E-Mail: drives.support@sea.siemens.com

(4 For calls originating from the Americas outside of the USA
Local time:  Monday to Friday 0800 to 1900 Eastern time
Telephone:  +1 (0) 770 740-3505
Fax: +1 (0) 770 740-3699
E-Mail: drives.support@sea.siemens.com

[ For calls originating from Europe and Africa
Local time (Nuremberg): Monday to Friday 0700 to 1700
Telephone:  +49 (0) 180 5050-222
Fax: +49 (0) 180 5050-223
E-Mail: techsupport@ad.siemens.de

[Q For calls originating from Asia and Australia
Local time (Singapore):  Monday to Friday 0830 to 1730
Telephone:  +65 (0) 740-7000
Fax: +65 (0) 740-7001
E-Mail: drives.support@sae.siemens.com.sg

Vi
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Product Overview

The S7-200 series of micro-programmable logic controllers (Micro PLCs) can control a wide variety of
devices to support your automation needs.

The S7-200 monitors inputs and changes outputs as controlled by the user program, which can include
Boolean logic, counting, timing, complex math operations, and communications with other intelligent
devices. The compact design, flexible configuration, and powerful instruction set combine to make the
S7-200 a perfect solution for controlling a wide variety of applications.

In This Chapter

ST7-200 CPU . .ottt
S7-200 Expansion ModUIesS . . ... ...
STEP 7-Micro/WIN Programming Package . . ... ... ... .
CommuNICatioNS OPLIONS . . .. oottt et e ettt e e e
Display Panels . .. ...

NN [WlWN
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S7-200 CPU

The S7-200 CPU combines a microprocessor, an integrated power supply, input circuits, and output
circuits in a compact housing to create a powerful Micro PLC. See Figure 1-1. After you have downloaded
your program, the S7-200 contains the logic required to monitor and control the input and output devices
in your application.

Access door:

/ Mode selector switch (RUN/STOP)

Analog adjustment potentiometer(s)
Expansion port (for most CPUSs)

I/0 LEDs

Status LEDs:
System Fault
RUN
STOP

Optional cartridg% ¥
EEPROM \
Real-time Clock
Battery

Terminal connector
(removable on CPU 224, CPU 226
and CPU 226XM)

Communications port Clip for installation on a standard (DIN) rail

Figure 1-1 S7-200 Micro PLC

Siemens provides different S7-200 CPU models with a diversity of features and capabilities that help you
create effective solutions for your varied applications. Table 1-1 briefly compares some of the features of
the CPU. For detailed information about a specific CPU, see Appendix A.

Table 1-1 Comparison of the S7-200 CPU Models
Feature CPU 221 CPU 222 CPU 224 CPU 226 CPU 226XM
Physical size (mm) 90 x 80 x 62 90 x 80 x 62 120.5x 80 x 62 190 x 80 x 62 190 x 80 x 62
Program memory 2048 words 2048 words 4096 words 4096 words 8192 words
Data memory 1024 words 1024 words 2560 words 2560 words 5120 words

Memory backup

50 hours typical

50 hours typical

190 hours typical

190 hours typical

190 hours typical

Local on-board 1/0 6 In/4 Out 8 In/6 Out 14 In/10 Out 24 In/16 Out 24 In/16 Out
Expansion modules | 0 2 7 7 7
High-speed counters
Single phase 4 at 30 kHz 4 at 30 kHz 6 at 30 kHz 6 at 30 kHz 6 at 30 kHz
Two phase 2 at 20 kHz 2 at 20 kHz 4 at 20 kHz 4 at 20 kHz 4 at 20 kHz
Pulse outputs (DC) 2 at 20 kHz 2 at 20 kHz 2 at 20 kHz 2 at 20 kHz 2 at 20 kHz
Analog adjustments | 1 1 2 2 2
Real-time clock Cartridge Cartridge Built-in Built-in Built-in
Communications 1 RS-485 1 RS-485 1 RS-485 2 RS-485 2 RS-485
ports
Floating-point math Yes

Digital I/O image size

Boolean execution
speed

256 (128 in, 128 out)

0.37 microseconds/instruction
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S7-200 Expansion Modules

To better solve your application requirements, the S7-200 family includes a wide variety of expansion
modules. You can use these expansion modules to add additional functionality to the S7-200 CPU.
Table 1-2 provides a list of the expansion modules that are currently available. For detailed information

about a specific module, see Appendix A.

Table 1-2 S7-200 Expansion Modules
Expansion Modules Types
Discrete modules Input 8xDC In 8xAC In
Output 8 x DC Out 8 X AC Out 8 x Relay
Combination 4 x DC In/4 x DC Out 8xDCIn/8xDC Out 16 x DC In/ 16 x DC Out

4x DC In/ 4 x Relay

8 x DC In/ 8 x Relay

16 x DC In/ 16 x Relay

Analog modules Input 4 x Analog In 4 x Thermocouple In 2XRTD In
Output 2 x Analog Out
Combination 4 x Analog In/ 1 Analog Out
Intelligent modules Position Modem PROFIBUS-DP

Other modules AS—Interface

STEP 7-Micro/WIN Programming Package

The STEP 7-Micro/WIN programming package provides a user-friendly environment to develop, edit, and
monitor the logic needed to control your application. STEP 7—Micro/WIN provides three program editors
for convenience and efficiency in developing the control program for your application. To help you find the
information you need, STEP 7-Micro/WIN provides an extensive online help system and a documentation
CD that contains an electronic version of this manual, application tips, and other useful information.

Computer Requirements

STEP 7-Micro/WIN runs on either a personal computer or a Siemens programming device, such as a
PG 760. Your computer or programming device should meet the following minimum requirements:

a

52 STEP 7-Micro/WIN 32 - Project1

Operating system:
Windows 95, Windows 98, Windows 2000,
Windows Me (Millennium Edition), or

He. £t Vew PLC Debug Tools Wndows Heb
[ozaan|soels|BE|s=]w B> =@ERws|ss6s |
ARAR B |3

o

. . Bz PU 221 REL 01.10) ¥ SIMATIC LAD [_[o[x]
Windows NT 4.0 (or later version) e R AR AR R RN
4 5BR, U[§$§ym I Symbol |‘T$wape |‘ Data Type |‘ Comment t ﬂ
1 Atleast 50M bytes of free hard disk space i i 1 | =
[POU Car =
(1 Mouse (recommended) ‘””? o 1
Network Comment it
—

etwark 1 Raw, Col 1

s

Figure 1-2  STEP 7-Micro/WIN
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Installing STEP 7—Micro/WIN

Insert the STEP 7—Micro/WIN CD into the CD-ROM drive of your computer. The installation wizard starts

automatically and prompts you through the installation process. Refer to the Readme file for more
information about installing STEP 7—Micro/WIN.

Tip

To install STEP 7—Micro/WIN on a Windows NT or Windows 2000 operating system, you must log in
with Administrator privileges.

Communications Options

Siemens provides two programming options for connecting your computer to your S7-200: a direct
connection with a PC/PPI cable, or a Communications Processor (CP) card with an MPI cable for MPI and
PROFIBUS-DP networks.

The PC/PPI programming cable is the most common and economical method of connecting your
computer to the S7-200. This cable connects the communications port of the S7-200 to the serial

communications of your computer. The PC/PPI programming cable can also be used to connect other
communications devices to the S7-200.

To use the MPI cable, you must also install a CP card in your computer. The CP card provides the extra
hardware required to connect at higher baud rates and to handle high-speed network communications.

Display Panels

TD 200 Text Display Unit

The TD 200 is a 2-line, 20-character, text display device that can be connected to the S7-200. Using the

TD 200 wizard, you can easily program your S7-200 to display text messages and other data pertaining to
your application.

The TD 200 provides a low cost interface to your
application by allowing you to view, monitor, and
change the process variables pertaining to your

application.

A separate manual describes the detailed
functionality and specifications of the TD 200.

Figure 1-3  TD 200 Text Display Unit

TPO70 Touch Panel Display

The TPO070 is a touch panel display device that
can be connected to the S7-200. This touch
panel provides you with a means to customize
your operator interface.

The TPO070 can display custom graphics, slider
bars, application variables, custom user buttons,
and so forth, by means of a user-friendly touch
panel.

The optional TP—Designer for TP070, Version 1.0
CD provides the TP Designer software, which is
required for programming your TPQ70.

Figure 1-4  TP070 Touch Panel Unit



Getting Started

STEP 7—Micro/WIN makes it easy for you to program your S7-200. In just a few short steps using a simple
example, you can learn how to connect, program, and run your S7-200.

All you need for this example is a PC/PPI cable, an S7-200 CPU, and a programming device running the
STEP 7-Micro/WIN programming software.

In This Chapter

Connecting the S7-200 CPU
Creating a Sample Program . ... ... 8
Downloading the Sample Program
Placing the S7-200 in RUN Mode



S7-200 Programmable Controller System Manual

Connecting the S7-200 CPU

Connecting your S7-200 is easy. For this example, you only need to connect power to your S7-200 CPU
and then connect the communications cable between your programming device and the S7-200 CPU.

Connecting Power to the S7-200 CPU

The first step is to connect the S7-200 to a power source. Figure 2-1 shows the wiring connections for
either a DC or an AC model of the S7-200 CPU.

Before you install or remove any electrical device, ensure that the power to that equipment has been
turned off. Always follow appropriate safety precautions and ensure that power to the S7-200 is disabled
before attempting to install or remove the S7-200.

Warning

' E Attempts to install or wire the S7-200 or related equipment with power applied could cause electric

* shock or faulty operation of equipment. Failure to disable all power to the S7-200 and related equipment
during installation or removal procedures could result in death or serious injury to personnel, and/or
damage to equipment.

Always follow appropriate safety precautions and ensure that power to the S7-200 is disabled before
attempting to install or remove the S7-200 or related equipment.

«
DC Installation D AC Installation
QOO

i
<

DC 85 to 265 VAC

+

.

Figure 2-1 Connecting Power to the S7-200 CPU

Connecting the PC/PPI Cable

Figure 2-2 shows a PC/PPI cable connecting the
S7-200 to the programming device. To connect
the PC/PPI cable:

Programming
Device

1. Connect the RS-232 connector (marked
“PC") of the PC/PPI cable to the
communications port of the programming
device. (For this example, connect to
COM 1)

2. Connect the RS-485 connector (marked
“PPI") of the PC/PPI cable to Port O or
Port 1 of the S7-200.

3. Ensure that the dipswitches of the PC/PPI UHU
3

cable are set as shown in Figure 2-2.

o
5 6

Figure 2-2  Connecting the PC/PPI Cable
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Starting STEP 7—Micro/WIN

Click on the STEP 7—Micro/WIN icon to open a
new project. Figure 2-3 shows a new project.

3 dons._ e
NS@ (80| ee|o [FE|ax|u:s
.

Navigation bar

Notice the navigation bar. You can use the icons
on the navigation bar to open elements of the
STEP 7—Micro/WIN project. REN
Click on the Communications icon in the 5 e —
navigation bar to display the Communications
dialog box. You use this dialog box to set up the
communications for STEP 7—Micro/WIN. = Communications icon
| =]
o
[T\ e ASBRG A7 lel | ﬁ
—
Ready INetwork 1 [Row 1, Col 1 s~

Figure 2-3 New STEP 7-Micro/WIN Project

Verifying the Communications Parameters for STEP 7-Micro/WIN

The example project uses the default settings for
STEP 7-Micro/WIN and the PC/PPI cable. To e ) e
: - . ot Address: 0
verify these settings: - = St 1.
PLC Type: to Refresh

1. Verify that the address of the PC/PPI cable
in the Communications dialog box is set

W Save settings with project

i~ Netwaork Parameter:

t0 0. Interface: PC/PPI cableiCOM 1) <t 2.
2. Verify that the interface for the network ! i
parameter is set for PC/PPI cable(COML1). Hohest Sslon 54y 51
. . . . [~ Interface supparts mutiple masters
3. Verify that the transmission rate is set to | e
9.6 kbps Beu Fate ks g 3
I Search all baud rates cancel ’
If you need to change your communications
parameter settings, see Chapter 7. Figure 2-4  Verifying the Communications Parameters

Establishing Communications with the S7-200

Use the Communications dialog box to connect with your S7-200 CPU:

1. Double-click the refresh icon in the
Communications dialog box. e . ﬁjpm eabelPP
sl Address: 0
STEP 7—-Micro/WIN searches for the fmip : 4 B ——
S7-200 station and displays a CPU icon
for the connected S7-200 station. [l S s
2. Select the S7-200 and click OK. [ Mewerk Parameter
Interface: PC/PPI cabl=(COM 1)
Protocal PPl
If STEP 7—Micro/WIN does not find your S7-200 o e
CPU, check the settings for the communications If orecm ot sl s
parameters and repeat these steps. S
Baud Rate: 9B kbps
After you have established communications with ™ Search slbsuaratss G
the S7-200, you are ready to create and
download the example program. Figure 2-5  Establishing Communications to the S7-200
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Creating a Sample Program

Entering this example of a control program will help you understand how easy it is to use
STEP 7-Micro/WIN. This program uses six instructions in three networks to create a very simple,
self-starting timer that resets itself.

For this example, you use the Ladder (LAD) editor to enter the instructions for the program. The following
example shows the complete program in both LAD and Statement List (STL). The network comments in
the STL program explain the logic for each network. The timing diagram shows the operation of the
program.

Example: Sample Program for getting started with STEP 7—Micro/WIN

Network 1 Network 1 /110 ms timer T33 times out after (100 x 10 ms =1s)
M0.0 T33 /IMO0.0 pulse is too fast to monitor with Status view.
— " o LDN MO.0
+1004PT TON T33, +100
Network 2 /IComparison becomes true at a rate that is visible with

/[Status view. Turn on Q0.0 after (40 x 10 ms = 0.4 s),
[ffor a 40% OFF/60% ON waveform.
Network 2
T33 Q0o LDW>= T33, +40
— == — ) = Q0.0
o Network 3 /IT33 (bit) pulse too fast to monitor with Status view.
//IReset the timer through MO.0 after the
I //(100 x 10 ms =1 s) period.

Ta3 ()
— — LD T33

Network 3

= MO0.0

Timing Diagram
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Opening the Program Editor

Click on the Program Block icon to open the § B
program editor. See Figure 2-6. [osaens=e|s|a|s=|u B> = [Bam (s
5 s AR B | [3 2e o aro0

€ Progiam Block

2 MAIN (0B1) |

Notice the instruction tree and the program

7 3 R 5

T Vartwe [ Daatwe | Comment_=]
TP |

23 5BR_D(5BRO) Symbal

editor. You use the instruction tree to insert the rnie: | RO, ' i 7
LAD instructions into the networks of the program = ! o . — o2
editor by dragging and dropping the instructions ”fg Lowe— 5
from the instruction tree to the networks. i ﬁ\

=]
The toolbar icons provide shortcuts to the menu L Program editor

commands. et

L]

After you enter and save the program, you can
download the program to the S7-200.

Network 3

Instruction tree

T I\wall (SO AINTD

Ready etwork 1 Row 1, ol 1 s

Figure2-6  STEP 7-Micro/WIN Window

Entering Network 1: Starting the Timer

When MO0.0 is off (0), this contact turns on and provides power flow to start the timer. To enter the contact
for M0.0:

1. Either double-click the Bit Logic icon or +0/WN 52 - Proiect1[SIMATIC LAD]

File Edit View PLC Debug Tools Windows Help -|® x|

. . N . =
click on the plus sign (+) to display the bit D=0 S04 e8| [BE| 2= ]s s B [BeR walss6s |

logic instructions. hoto |[E R[4 % A [Bomen |5 2 o [1r 01 |
Program Block IS | R 7 T T —— T
2. Select the Normally Closed contact. Qe — 3
Ak INT_OMNTOL MO0 IR
Symbol Table

Hold down the left mouse button and drag
the contact onto the first network.

— T TN
+1004PT

Network 2

4. Click on the “???” above the contact and
enter the following address: M0.0

5. Press the Return key to enter the address —
for the contact. .
= [ET N e RO AMTS7—al | wl

4
Network 4 it s

To enter the timer instruction for T33: Figure 2-7  Network 1

Double-click the Timers icon to display the timer instructions.
Select the TON (On-Delay Timer).
Hold down the left mouse button and drag the timer onto the first network.

Click on the “???” above the timer box and enter the following timer number: T33

o w D PE

Press the Return key to enter the timer number and to move the focus to the preset time (PT)
parameter.

Enter the following value for the preset time: 100

7. Press the Return key to enter the value.



S7-200 Programmable Controller System Manual

10

Entering Network 2: Turning the Output On

When the timer value for T33 is greater than or equal to 40 (40 times 10 milliseconds, or 0.4 seconds), the
contact provides power flow to turn on output Q0.0 of the S7-200. To enter the Compare instruction:

1.

Double-click the Compare icon to display the compare instructions. Select the >=I instruction

(Greater-Than-Or-Equal-To-Integer ).

G STEP 7-Micr

Hold down the left mouse button and drag

0,/WIN 32 - Project1 - [SIMATIC LAD]
B File Edit Visw PLC Dsbug Tools ‘indows Help

—lelx|

the compare instruction onto the second

’ﬁﬁﬂ\éﬁ.\%%é\nlgw\

A ODEEE R

network.

e A T [EER s i

Click on the “???" above the contact and
enter the address for the timer value: T33

Press the Return key to enter the timer
number and to move the focus to the other
value to be compared with the timer value.

Enter the following value to be compared
with the timer value: 40

Press the Return key to enter the value.

8
g Network 1 ﬂ
D " =
g — " B
-
1 NOTE 1001ET
Sy
AN
< ]
-0 )
0 5] Network 2
© 5 T3 0o
0 (R
< > D
1 sR +40
{71 RS
{1 nop &
& Clock =l [FTo\mam ASER O AMT D/ 4l | —’_I
Netwark 3 Tikle: s 7
Figure2-8  Network 2

To enter the instruction for turning on output QO0.0:

1
2
3.
4

Double-click the Bit Logic icon to display the bit logic instructions and select the output coil.

Hold down the left mouse button and drag the coil onto the second network.

Click on the “???” above the coil and enter the following address: Q0.0

Press the Return key to enter the address for the coil.

Entering Network 3: Resetting the Timer

When the timer reaches the preset value (100) and turns the timer bit on, the contact for T33 turns on.
Power flow from this contact turns on the M0.0 memory location. Because the timer is enabled by a
Normally Closed contact for M0.0, changing the state of M0.0 from off (0) to on (1) resets the timer.

To enter the contact for the timer bit of T33:

1.

1.

bit logic instructions. ;@Da\gm% R EEE R E R
Hold down the left mouse button and drag i el s34 M?Mﬁﬁffil:f o0 |‘ B _ _
the contact onto the third network. =
. [
Click on the “???” above the contact and
enter the address of the timer bit: T33 N
— )
Press the Return key to enter the address o
for the contact. Notmork 3
. . _| T33 )
To enter the coil for turning on M0.0:
| [T\ man £ 5870 AINT 0/ [N} ’_;ll/,l
Select the output coil from the bit logic = “
instructions. Figure2-9  Network 3

Select the Normally Open contact from the

Hold down the left mouse button and drag the output coil onto the third network.

Double-click the “???” above the coil and enter the following address: M0.0

Press the Return key to enter the address for the coil.
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Saving the Sample Project

After entering the three networks of instructions, you have finished entering the program. When you save
the program, you create a project that includes the S7-200 CPU type and other parameters. To save the
project:

1. Selectthe File > Save As menu command Save As EHE
from the menu bar. Save e [ '3 Projects = & @ ok E-

2. Enter a name for the project in the Save As
dialog box.

3. Click OK to save the project.

After saving the project, you can download the

program to the S7-200 oo | EEEAE [ see ]
Save as ype: IPm|Ecl File [* rmwp] d Cancel L
%)

Figure 2-10 Saving the Example Program

Downloading the Sample Program

%

Tip

Each STEP 7-Micro/WIN project is associated with a CPU type (CPU 221, CPU 222, CPU 224, CPU
226, or CPU 226XM). If the project type does not match the CPU to which you are connected,

STEP 7-Micro/WIN indicates a mismatch and prompts you to take an action. If this occurs, choose
“Continue Download” for this example.

1. Click the Download icon on the toolbar or — pownload x|
select the File > Download menu — Rlernote Address 9 :
command to download the program. See Remote PLE Type CPL 226%M REL 01.20
Flgure 2-11. Blocks to Download

2. Click OK to download the elements of the ¥ Program Block
program to the S7-200. ¥ Data Block

v Syster Block

If your S7-200 is in RUN mode, a dialog box
prompts you to place the S7-200 in STOP mode. T P
Click Yes to place the S7-200 into STOP mode.

Figure 2-11 Downloading the Program

Placing the S7-200 in RUN Mode

For STEP 7—Micro/WIN to place the S7-200 CPU in RUN mode, the mode switch of the S7-200 must be
set to TERM or RUN. When you place the S7-200 in RUN mode, the S7-200 executes the program:

1. Click the RUN icon on the toolbar or select N run x|

the PLC > RUN menu command.

2. Click OK to change the operating mode of @ Place the PLC in RUN mode?
the S7-200.

Tes Mo |

When the S7-200 goes to RUN mode, the output

LED for Q0.0 turns on and off as the S7-200
executes the program. Figure 2-12 Placing the S7-200 in RUN Mode

Congratulations! You have just completed your first S7-200 program.

You can monitor the program by selecting the Debug > Program Status menu command.
STEP 7-Micro/WIN displays the values for the instructions. To stop the program, place the S7-200 in
STOP mode by clicking the STOP icon or by selecting the PLC > STOP menu command.

11
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Installing the S7-200

The S7-200 equipment is designed to be easy to install. You can use the mounting holes-to attach the
modules to a panel, or you can use the built-in clips to mount the modules onto a standard (DIN) rail. The
small size of the S7-200 allows you to make efficient use of space.

This chapter provides guidelines for installing and wiring your S7-200 system.

In This Chapter

Guidelines for Installing S7-200 DEVICES . . . ...ttt e e 14
Installing and Removing the S7-200 Modules . .. ... ... .. 15
Guidelines for Grounding and WiriNg . ... ... o e 18

13
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Guidelines for Installing S7-200 Devices

You can install an S7-200 either on a panel or on a standard rail, and you can orient the S7-200 either
horizontally or vertically.

Separate the S7-200 Devices from Heat, High Voltage, and Electrical Noise

As a general rule for laying out the devices of your system, always separate the devices that generate
high voltage and high electrical noise from the low-voltage, logic-type devices such as the S7-200.

When configuring the layout of the S7-200 inside your panel, consider the heat-generating devices and
locate the electronic-type devices in the cooler areas of your cabinet. Operating any electronic device in a
high-temperature environment will reduce the time to failure.

Consider also the routing of the wiring for the devices in the panel. Avoid placing low voltage signal wires
and communications cables in the same tray with AC power wiring and high-energy, rapidly-switched DC
wiring.

Provide Adequate Clearance for Cooling and Wiring

%

14

S7-200 devices are designed for natural convection cooling. For proper cooling, you must provide a
clearance of at least 25 mm above and below the devices. Also, allow at least 75 mm of depth.

Tip
For vertical mounting, the maximum allowable ambient temperature is reduced by 10° C. Mount the
S7-200 CPU below any expansion modules.

When planning your layout for the S7-200 system, allow enough clearance for the wiring and
communications cable connections. For additional flexibility in configuring the layout of the S7-200 system,
use the 1/0 expansion cable.

Clearance 35 mm
T S

fffffff v
H_H 7.5 mm j r T Lmm
3 |l r 1] 4
Eﬁ ,,,,,,,,,,,,,,, =N [ I ! DIN Rail
25*mm wgr 55 ‘ © ‘
S - ST \
‘ ‘ 75 mm
Al
N .
‘ = Lleos) Front of the Mounting
P T PP PP PP P j enclosure surface
“““““““ IE = IE IEE Vertical Panel Mounting
A AT AR s Side View

Horizontal DIN Rail Mounting with Optional
Expansion Cable (limit one per system)

Figure 3-1 Mounting Methods, Orientation, and Clearance
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Power Budget

N

All S7-200 CPUs have an internal power supply that provides power for the CPU, the expansion modules,
and other 24 VDC user power requirements.

The S7-200 CPU provides the 5 VDC logic power needed for any expansion in your system. Pay careful
attention to your system configuration to ensure that your CPU can supply the 5V power required by your
selected expansion modules. If your configuration requires more power than the CPU can supply, you
must remove a module or select a CPU with more power capability. Refer to Appendix A for information
about the 5 VDC logic budget supplied by your S7-200 CPU and the 5 VDC power requirements of the
expansion modules. Use Appendix B as a guide for determining how much power (or current) the CPU
can provide for your configuration.

All S7-200 CPUs also provide a 24 VDC sensor supply that can supply 24 VDC for input points, for relay
coil power on the expansion modules, or for other requirements. If your power requirements exceed the
budget of the sensor supply, then you must add an external 24 VDC power supply to your system. Refer
to Appendix A for the 24 VDC sensor supply power budget for your particular S7-200 CPU.

If you require an external 24 VDC power supply, ensure that the power supply is not connected in parallel
with the sensor supply of the S7-200 CPU. For improved electrical noise protection, it is recommended
that the commons (M) of the different power supplies be connected.

Warning

Connecting an external 24 VDC power supply in parallel with the S7-200 24 VDC sensor supply can
result in a conflict between the two supplies as each seeks to establish its own preferred output voltage
level.

The result of this conflict can be shortened lifetime or immediate failure of one or both power supplies,
with consequent unpredictable operation of the PLC system. Unpredictable operation could result in
death or serious injury to personnel, and/or damage to equipment.

The S7-200 DC sensor supply and any external power supply should provide power to different points.

Installing and Removing the S7-200 Modules

The S7-200 can be easily installed on a standard DIN rail or on a panel.

Prerequisites

N

N

Before you install or remove any electrical device, ensure that the power to that equipment has been
turned off. Also, ensure that the power to any related equipment has been turned off.

Warning

Attempts to install or remove S7-200 or related equipment with the power applied could cause electric
shock or faulty operation of equipment.

Failure to disable all power to the S7-200 and related equipment during installation or removal
procedures could result in death or serious injury to personnel, and/or damage to equipment.

Always follow appropriate safety precautions and ensure that power to the S7-200 is disabled before
attempting to install or remove S7-200 CPUs or related equipment.

Always ensure that whenever you replace or install an S7-200 device you use the correct module or
equivalent device.

Warning
If you install an incorrect module, the program in the S7-200 could function unpredictably.

Failure to replace an S7-200 device with the same model, orientation, or order could result in death or
serious injury to personnel, and/or damage to equipment.

Replace an S7-200 device with the same model, and be sure to orient and position it correctly.

15
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Mounting Dimensions

The S7-200 CPUs and expansion modules include mounting holes to facilitate installation on panels.
Refer to Table 3-1 for the mounting dimensions.

Table 3-1 Mounting Dimensions

_.‘ -— 9.5 mm* * Minimum spacing

between modules when

4mm T‘ A ;T hard-mounted
_L B B V|
A ﬁ & & Mounting holes
1 ] 0 ] (M4 or No. 8)

E | oopooooo oooooooo K | oooooooo 4

96 mm 88 mm 80 mm s >

1 cooooooo oooooooo 7 1 oooooooo fi

4 ] U

Y !
S — T © U B
J 4 mm —>| |<— B
4 mm —— A ——>
S7-200 Module Width A Width B
CPU 221 and CPU 222 90 mm 82 mm
CPU 224 120.5 mm 112.5 mm
CPU 226 and CPU 226XM 196 mm 188 mm
Expansion modules: 8-point DC and Relay 1/0 (8I, 8Q, 41/4Q, 2 AQ) 46 mm 38 mm
Expansion modules: 16-point digital 1/O (81/8Q), Analog I/O (4Al, 4Al/1AQ), 71.2 mm 63.2 mm
RTD, Thermocouple, PROFIBUS, AS-Interface,
8-point AC (8l and 8Q), Position, and Modem

Expansion modules: 32-point digital I/0 (161/16Q) 137.3 mm 129.3 mm

Installing a CPU or Expansion Module
Installing the S7-200 is easy! Just follow these steps.

Panel Mounting

1. Locate, drill, and tap the mounting holes (M4 or American Standard number 8), using the
dimensions in Table 3-1.

2. Secure the module(s) to the panel, using the appropriate screws.
3. If you are using an expansion module, connect the expansion module ribbon cable into the
expansion port connector under the access door.

DIN Rail Mounting
1. Secure the rail to the mounting panel every 75 mm.

2. Snap open the DIN clip (located on the bottom of the module) and hook the back of the module onto
the DIN rail.

3. If you are using an expansion module, connect the expansion module ribbon cable into the
expansion port connector under the access door.

4. Rotate the module down to the DIN rail and snap the clip closed. Carefully check that the clip has
fastened the module securely onto the rail. To avoid damage to the module, press on the tab of the
mounting hole instead of pressing directly on the front of the module.

16
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Tip
@ Using DIN rail stops could be helpful if your S7-200 is in an environment with high vibration potential or if
the S7-200 has been installed vertically.

If your system is in a high-vibration environment, then panel-mounting the S7-200 will provide a greater
level of vibration protection.

Removing a CPU or Expansion Module
To remove an S7-200 CPU or expansion module, follow these steps:
1. Remove power from the S7-200.

2. Disconnect all the wiring and cabling that is attached to the module. Most S7-200 CPU and
expansion modules have removable connectors to make this job easier.

3. If you have expansion modules connected to the unit that you are removing, open the access cover
door and disconnect the expansion module ribbon cable from the adjacent modules.

4. Unscrew the mounting screws or snap open the DIN clip.

Remove the module.

Removing and Reinstalling the Terminal Block Connector

Most S7-200 modules have removable connectors to make installing and replacing the module easy.
Refer to Appendix A to determine whether your S7-200 module has removable connectors. You can order
an optional fan-out connector for modules that do not have removable connectors. See Appendix E for
order numbers.

To Remove the Connector
1. Open the connector door to gain access to the connector.

2. Insert a small screwdriver in the notch in the middle of the connector.

3.  Remove the terminal connector by prying the screwdriver away from the S7-200 housing. See
Figure 3-2.

Figure 3-2 Removing the Connector

To Reinstall the Connector
1. Open the connector door.

2. Align the connector with the pins on the unit and align the wiring edge of the connector inside the
rim of the connector base.

3. Press down firmly to rotate the connector until it snaps into place. Check carefully to ensure that the
connector is properly aligned and fully engaged.

17
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Guidelines for Grounding and Wiring

Proper grounding and wiring of all electrical equipment is important to help ensure the optimum operation
of your system and to provide additional electrical noise protection for your application and the S7-200.

Prerequisites

N

N

Before you ground or install wiring to any electrical device, ensure that the power to that equipment has
been turned off. Also, ensure that the power to any related equipment has been turned off.

Ensure that you follow all applicable electrical codes when wiring the S7-200 and related equipment.
Install and operate all equipment according to all applicable national and local standards. Contact your
local authorities to determine which codes and standards apply to your specific case.

Warning

Attempts to install or wire the S7-200 or related equipment with power applied could cause electric
shock or faulty operation of equipment. Failure to disable all power to the S7-200 and related equipment
during installation or removal procedures could result in death or serious injury to personnel, and/or
damage to equipment.

Always follow appropriate safety precautions and ensure that power to the S7-200 is disabled before
attempting to install or remove the S7-200 or related equipment.

Always take safety into consideration as you design the grounding and wiring of your S7-200 system.
Electronic control devices, such as the S7-200, can fail and can cause unexpected operation of the
equipment that is being controlled or monitored. For this reason, you should implement safeguards that
are independent of the S7-200 to protect against possible personal injury or equipment damage.

Warning

Control devices can fail in an unsafe condition, resulting in unexpected operation of controlled
equipment. Such unexpected operations could result in death or serious injury to personnel, and/or
damage to equipment.

Use an emergency stop function, electromechanical overrides, or other redundant safeguards that are
independent of the S7-200.

Guidelines for Isolation

N

18

S7-200 AC power supply boundaries and 1/0O boundaries to AC circuits are rated 1500 VAC. These
isolation boundaries have been examined and approved as providing safe separation between AC line
and low voltage circuits.

All low voltage circuits connected to an S7-200, such as 24V power, must be supplied from an approved
source that provides safe isolation from AC line and other high voltages. Such sources include double
insulation as defined in international electrical safety standards and have outputs that are rated as SELV,
PELV, Class 2, or Limited Voltage according to various standards.

Warning

Use of non-isolated or single insulation supplies to supply low voltage circuits from an AC line can result
in hazardous voltages appearing on circuits that are expected to be touch safe, such as
communications circuits and low voltage sensor wiring.

Such unexpected high voltages could result in death or serious injury to personnel, and/or damage to
equipment.

Only use high voltage to low voltage power converters that are approved as sources of touch safe,
limited voltage circuits.
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Guidelines for Grounding the S7-200

The best way to ground your application is to ensure that all the common connections of your S7-200 and
related equipment are grounded to a single point. This single point should be connected directly to the
earth ground for your system.

For improved electrical noise protection, it is recommended that all DC common returns be connected to
the same single-point earth ground. Connect the 24 VDC sensor supply common (M) to earth ground.

All ground wires should be as short as possible and should use a large wire size, such as 2 mm?2
(14 AWG).

When locating grounds, remember to consider safety grounding requirements and the proper operation of
protective interrupting devices.

Guidelines for Wiring the S7-200

When designing the wiring for your S7-200, provide a single disconnect switch that simultaneously
removes power from the S7-200 CPU power supply, from all input circuits, and from all output circuits.
Provide overcurrent protection, such as a fuse or circuit breaker, to limit fault currents on supply wiring.
You might want to provide additional protection by placing a fuse or other current limit in each output
circuit.

Install appropriate surge suppression devices for any wiring that could be subject to lightning surges.

Avoid placing low-voltage signal wires and communications cables in the same wire tray with AC wires
and high-energy, rapidly switched DC wires. Always route wires in pairs, with the neutral or common wire
paired with the hot or signal-carrying wire.

Use the shortest wire possible and ensure that the wire is sized properly to carry the required current. The
connector accepts wire sizes from 2 mm?2 to 0.3 mm2 (14 AWG to 22 AWG). Use shielded wires for
optimum protection against electrical noise. Typically, grounding the shield at the S7-200 gives the best
results.

When wiring input circuits that are powered by an external power supply, include an overcurrent protection
device in that circuit. External protection is not necessary for circuits that are powered by the 24 VDC
sensor supply from the S7-200 because the sensor supply is already current-limited.

Most S7-200 modules have removable connectors for user wiring. (Refer to Appendix A to determine if
your module has removable connectors.) To prevent loose connections, ensure that the connector is
seated securely and that the wire is installed securely into the connector. To avoid damaging the
connector, be careful to not over-tighten the screws. The maximum torque for the connector screw is
0.56 N-m (5 inch-pounds).

To help prevent unwanted current flows in your installation, the S7-200 provides isolation boundaries at
certain points. When you plan the wiring for your system, you should consider these isolation boundaries.
Refer to Appendix A for the amount of isolation provided and the location of the isolation boundaries.
Isolation boundaries rated less than 1500VAC must not be depended on as safety boundaries.

Tip
@ For a communications network, the maximum length of the communications cable is 50 m without using
a repeater. The communications port on the S7-200 is non-isolated. Refer to Chapter 7 for more
information.
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Guidelines for Suppression Circuits

You should equip inductive loads with suppression circuits to limit voltage rise when the control output
turns off. Suppression circuits protect your outputs from premature failure due to high inductive switching
currents. In addition, suppression circuits limit the electrical noise generated when switching inductive
loads.

Tip
The effectiveness of a given suppression circuit depends on the application, and you must verify it for

your particular use. Always ensure that all components used in your suppression circuit are rated for
use in the application.

DC Outputs and Relays That Control DC Loads

The DC outputs have internal protection that is adequate for most applications. Since the relays can be
used for either a DC or an AC load, internal protection is not provided.

Figure 3-3 shows a sample suppression circuit A B (optional)
for a DC load. In most applications, the addition

K . . . A — 11N4001 diode or equivalent
of a diode (A) across the inductive load is a

suitable, but if your application requires faster output B- 82 Zzee:;’fgﬁrgecla‘;‘gzt‘;ils
turn-off times, then the addition of a Zener diode Point

(B) is recommended. Be sure to size your Zener DC Inductive Load

diode properly for the amount of current in your

output circuit. Figure 3-3  Suppression Circuit for a DC Load

AC Outputs and Relays That Control AC Loads

The AC outputs have internal protection that is adequate for most applications. Since the relays can be
used for either a DC or an AC load, internal protection is not provided.

Figure 3-4 shows a sample suppression circuit MOV
for an AC load. In most applications, the addition {i}
of a metal oxide varistor (MOV) will limit the peak

voltage and provide protection for the internal
S7-200 circuits. Ensure that the working voltage Dbt Lo
of the MOV is at least 20% greater than the AC Inductive Load
nominal line voltage.

Figure 3-4  Suppression Circuit for a AC Load
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The basic function of the S7-200 is to monitor field inputs and, based on your control logic, turn on or off

field output devices. This chapter explains the concepts used to execute your program, the various types
of memory used, and how that memory is retained.
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Understanding How the S7-200 Executes Your Control Logic

The S7-200 continuously cycles through the control logic in your program, reading and writing data.

The S7-200 Relates Your Program to the Physical Inputs and Outputs

The basic operation of the S7-200 is very simple:

Start_PB E_Stop M_Starter
O The S7-200 reads the status of the inputs. ’I { s : ()
[ The program that is stored in the S7-200 uses these - M_Starter /// Motor
inputs to evaluate the control logic. As the program | -
runs, the S7-200 updates the data. : H S .
-
1 The S7-200 writes the data to the outputs. | Ve Output |

Motor Starter

Figure 4-1 shows a simple diagram of how an electrical
relay diagram relates to the S7-200. In this example, the
state of the switch for starting the motor is combined with the
states of other inputs. The calculations of these states then
determine the state for the output that goes to the actuator

e ~/1
Input S
.ml Start / Stop Switch

which starts the motor. Figure 4-1  Controlling Inputs and Outputs

The S7-200 Executes Its Tasks in a Scan Cycle

The S7-200 executes a series of tasks repetitively. This cyclical execution of tasks is called the scan
cycle. As shown in Figure 4-2, the S7-200 performs most or all of the following tasks during a scan cycle:

1 Reading the inputs: The S7-200 copies the state of
the physical inputs to the process-image input register. Writes to the outputs

(1 Executing the control logic in the program: The
S7-200 executes the instructions of the program and

stores the values in the various memory areas. / \
[ Processing any communications requests: The
S7-200 performs any tasks required for Communications Requests ’

communications.

(1 Executing the CPU self-test diagnostics: The S7-200

ensures that the firmware, the program memory, and
any expansion modules are working properly.

51
O Writing to the outputs: The values stored in the | Reads the inputs | ajl

Scan Cycle

process-image output register are written to the
physical outputs. Figure 4-2  S7-200 Scan Cycle

The execution of the scan cycle is dependent upon whether the S7-200 is in STOP mode or in RUN
mode. In RUN mode, your program is executed; in STOP mode, your program is not executed.
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Reading the Inputs

Digital inputs: Each scan cycle begins by reading the current value of the digital inputs and then writing
these values to the process-image input register.

Analog inputs: The S7-200 does not update analog inputs as part of the normal scan cycle unless filtering
of analog inputs is enabled. An analog filter is provided to allow you to have a more stable signal. You can
enable the analog filter for each analog input point.

When analog input filtering is enabled for an analog input, the S7-200 updates that analog input once per
scan cycle, performs the filtering function, and stores the filtered value internally. The filtered value is then
supplied each time your program accesses the analog input.

When analog filtering is not enabled, the S7-200 reads the value of the analog input from the physical
module each time your program accesses the analog input.

Tip

Analog input filtering is provided to allow you to have a more stable analog value. Use the analog input
filter for applications where the input signal varies slowly with time. If the signal is a high-speed signal,
then you should not enable the analog filter.

Do not use the analog filter with modules that pass digital information or alarm indications in the analog
words. Always disable analog filtering for RTD, Thermocouple, and AS-Interface Master modules.

Executing the Program

During the execution phase of the scan cycle, the S7-200 executes your program, starting with the first
instruction and proceeding to the end instruction. The immediate 1/O instructions give you immediate
access to inputs and outputs during the execution of either the program or an interrupt routine.

If you use interrupts in your program, the interrupt routines that are associated with the interrupt events are
stored as part of the program. The interrupt routines are not executed as part of the normal scan cycle, but
are executed when the interrupt event occurs (which could be at any point in the scan cycle).

Processing Any Communications Requests

During the message-processing phase of the scan cycle, the S7-200 processes any messages that were
received from the communications port or intelligent /O modules.

Executing the CPU Self-test Diagnostics

During this phase of the scan cycle, the S7-200 checks for proper operation of the CPU, for memory
areas, and for the status of any expansion modules.

Writing to the Digital Outputs

At the end of every scan cycle, the S7-200 writes the values stored in the process-image output register to
the digital outputs. (Analog outputs are updated immediately, independently from the scan cycle.)
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Accessing the Data of the S7-200
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The S7-200 stores information in different memory locations that have unique addresses. You can
explicitly identify the memory address that you want to access. This allows your program to have direct
access to the information. Table 4-1 shows the range of integer values that can be represented by the
different sizes of data.

Table 4-1 Decimal and Hexadecimal Ranges for the Different Sizes of Data

Representation Byte (B) Word (W) Double Word (D)
Unsigned Integer 0to 255 0to 65,535 0to 4,294,967,295
Oto FF 0to FFFF 0 to FFFF FFFF
Signed Integer —-128 to +127 —-32,768 to +32,767 —2,147,483,648 to +2,147,483,647
80to 7F 8000 to 7FFF 8000 0000 to 7FFF FFFF
Real Not applicable Not applicable +1.175495E-38 to +3.402823E+38 (positive)
IEEE 32-bit Floating Point —1.175495E-38 to —3.402823E+38 (negative)

To access a bit in a memory area, you specify the address, which includes the memory area identifier, the
byte address, and the bit number. Figure 4-3 shows an example of accessing a bit (which is also called
“byte.bit” addressing). In this example, the memory area and byte address (I = input, and 3 = byte 3) are
followed by a period (“.”) to separate the bit address (bit 4).

I 3 . 4 .
Process-image Input (I) Memory Area
L Bitof byte, or bit number: ge Input (1) y

bit 4 of 8 (0 to 7) 76543210
Period separates the Byte O
byte address from the bit Byte 1
number Byte 2

Byte address: byte 3 (the Byte 3 .

fourth byte) Byte 4
Byte 5

Memory area identifier

Figure 4-3 Byte.Bit Addressing

You can access data in most memory areas (V, |, Q, M, S, L, and SM) as bytes, words, or double words by
using the byte-address format. To access a byte, word, or double word of data in the memory, you must
specify the address in a way similar to specifying the address for a bit. This includes an area identifier,
data size designation, and the starting byte address of the byte, word, or double-word value, as shown in
Figure 4-4.

Data in other memory areas (such as T, C, HC, and the accumulators) are accessed by using an address
format that includes an area identifier and a device number.
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V B 100 V W 100 V D 100
L Byte address L Byte address L Byte address
Access to a byte size Access to a word size Access to a double word size
Area identifier Area identifier Area identifier
MSB LSB

vB100 |7 vB100  °|

MSB = most significant bit
LSB = least significant bit
Most significant byte Least significant byte
MSB LSB
VW100 |15 vB100 8|7 vB101 9]
Most significant byte Least significant byte
MSB LSB

VD100 (3 vB100 24|28 vB101 6|15 vB102 8|7  vB103 O]

Figure 4-4 Comparing Byte, Word, and Double-Word Access to the Same Address

Accessing Data in the Memory Areas

Process-Image Input Register: |

The S7-200 samples the physical input points at the beginning of each scan cycle and writes these values
to the process-image input register. You can access the process-image input register in bits, bytes, words,
or double words:

Bit: I[byte address].[bit address] 10.1
Byte, Word, or Double Word: I[size][starting byte address] 1B4

Process-Image Output Register: Q

At the end of the scan cycle, the S7-200 copies the values stored in the process-image output register to
the physical output points. You can access the process-image output register in bits, bytes, words, or
double words:

Bit: Q[byte address].[bit address] Q1.1
Byte, Word, or Double Word: QI[size][starting byte address] QB5

Variable Memory Area: V

You can use V memory to store intermediate results of operations being performed by the control logic in
your program. You can also use V memory to store other data pertaining to your process or task. You can
access the V memory area in bits, bytes, words, or double words:

Bit: V[byte address].[bit address] V10.2
Byte, Word, or Double Word: V[size][starting byte address] VW100

Bit Memory Area: M

You can use the bit memory area (M memory) as control relays to store the intermediate status of an
operation or other control information. You can access the bit memory area in bits, bytes, words, or double

words:
Bit: M[byte address].[bit address] M26.7
Byte, Word, or Double Word: M[size][starting byte address] MD20
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Timer Memory Area: T

The S7-200 provides timers that count increments of time in resolutions (time-base increments) of 1 ms,
10 ms, or 100 ms. Two variables are associated with a timer:

1 Current value: this 16-bit signed integer stores the amount of time counted by the timer.

[ Timer bit: this bit is set or cleared as a result of comparing the current and the preset value. The
preset value is entered as part of the timer instruction.

You access both of these variables by using the timer address (T + timer number). Access to either the
timer bit or the current value is dependent on the instruction used: instructions with bit operands access
the timer bit, while instructions with word operands access the current value. As shown in Figure 4-5, the
Normally Open Contact instruction accesses the timer bit, while the Move Word instruction accesses the
current value of the timer.

Format: T[timer number] T24

12.1 MOV W . . T3

N - Current Value Timer Bits | |

T0 T0 ‘ b
T3 — IN OUT |— VW200 T T
T2 T2
15 (MSB) T3 0 (LSB) T3

Accesses the current value Accesses the timer bit

Figure 4-5 Accessing the Timer Bit or the Current Value of a Timer

Counter Memory Area: C

The S7-200 provides three types of counters that count each low-to-high transition event on the counter
input(s): one type counts up only, one type counts down only, and one type counts both up and down. Two
variables are associated with a counter:

1 Current value: this 16-bit signed integer stores the accumulated count.

1 Counter bit: this bit is set or cleared as a result of comparing the current and the preset value. The
preset value is entered as part of the counter instruction.

You access both of these variables by using the counter address (C + counter number). Access to either
the counter bit or the current value is dependent on the instruction used: instructions with bit operands
access the counter bit, while instructions with word operands access the current value. As shown in
Figure 4-6, the Normally Open Contact instruction accesses the counter bit, while the Move Word
instruction accesses the current value of the counter.

Format: C[counter number] C24
> E’:"OV—W Current Value Counter Bits | ICSI
co co ‘
c3—{IN OUT [— VW200 c1 c1
| Cc2 Cc2
15 (MSB) C3 0 (LSB) C3
Accesses the current value Accesses the counter bit

Figure 4-6 Accessing the Counter Bit or the Current Value of a Counter
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High-Speed Counters: HC

The high-speed counters count high-speed events independent of the CPU scan. High-speed counters
have a signed, 32-bit integer counting value (or current value). To access the count value for the
high-speed counter, you specify the address of the high-speed counter, using the memory type (HC) and
the counter number (such as HCO). The current value of the high-speed counter is a read-only value and
can be addressed only as a double word (32 bits).

Format: HC[high—speed counter number] HC1

Accumulators: AC

The accumulators are read/write devices that can be used like memory. For example, you can use
accumulators to pass parameters to and from subroutines and to store intermediate values used in a
calculation. The S7-200 provides four 32-bit accumulators (ACO, AC1, AC2, and AC3). You can access
the data in the accumulators as bytes, words, or double words.

The size of the data being accessed is determined by the instruction that is used to access the
accumulator. As shown in Figure 4-7, you use the least significant 8 or 16 bits of the value that is stored in
the accumulator to access the accumulator as bytes or words. To access the accumulator as a double
word, you use all 32 bits.

For information about how to use the accumulators within interrupt subroutines, refer to the Interrupt
Instructions in Chapter 6.

Format: AC[accumulator number] ACO
Hetwork 1
MO0 Y] AC2 (accessed as a byte) msB LsB

— ENo%l | ! g

AC24IM OUTkwB200

Network 2

AC1 (accessed as a word
101 DEC_W ( ) '\EB . LiB
_| | EN ENO }l | | Most significant | Least significant |
actdn_ outhwwion Byte 1 Byte 0
Network 3 AC3 (accessed as a double word)
MSB LSB
M0.2 INY_DW 31 24 23 16 15 8 7 0
_| | EM - END >| | Most significant | Least significant
ac3dn outhvoesn Byte 3 Byte 2 Byte 1 Byte O

Figure 4-7 Accessing the Accumulators
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Special Memory: SM

The SM bits provide a means for communicating information between the CPU and your program. You
can use these bits to select and control some of the special functions of the S7-200 CPU, such as: a bit
that turns on for the first scan cycle, a bit that toggles at a fixed rate, or a bit that shows the status of math
or operational instructions. (For more information about the SM bits, see Appendix D.)|You can access the
SM bits as bits, bytes, words, or double words:

Bit: SM[byte address].[bit address] SMO0.1
Byte, Word, or Double Word: SM[size][starting byte address] SMB86

Local Memory Area: L

The S7-200 provides 64 bytes of local memory of which 60 can be used as scratchpad memory or for
passing formal parameters to subroutines.

Tip
If you are programming in either LAD or FBD, STEP 7—Micro/WIN reserves the last four bytes of local

memory for its own use. If you program in STL, all 64 bytes of L memory are accessible, but it is
recommended that you do not use the last four bytes of L memory.

Local memory is similar to V memory with one major exception. V. memory has a global scope while L
memory has a local scope. The term global scope means that the same memory location can be
accessed from any program entity (main program, subroutines, or interrupt routines). The term local scope
means that the memory allocation is associated with a particular program entity. The S7-200 allocates

64 bytes of L memory for the main program, 64 bytes for each subroutine nesting level, and 64 bytes for
interrupt routines.

The allocation of L memory for the main program cannot be accessed from subroutines or from interrupt
routines. A subroutine cannot access the L memory allocation of the main program, an interrupt routine, or
another subroutine. Likewise, an interrupt routine cannot access the L memory allocation of the main
program or of a subroutine.

The allocation of L memory is made by the S7-200 on an as-needed basis. This means that while the
main portion of the program is being executed, the L memory allocations for subroutines and interrupt
routines do not exist. At the time that an interrupt occurs or a subroutine is called, local memory is
allocated as required. The new allocation of L memory might reuse the same L memory locations of a
different subroutine or interrupt routine.

The L memory is not initialized by the S7-200 at the time of allocation and might contain any value. When
you pass formal parameters in a subroutine call, the values of the parameters being passed are placed by
the S7-200 in the appropriate L memory locations of the called subroutine. L memory locations, which do
not receive a value as a result of the formal parameter passing step, will not be initialized and might
contain any value at the time of allocation.

Bit: L[byte address].[bit address] LO.0
Byte, Word, or Double Word: L[size] [starting byte address] LB33
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Analog Inputs: Al

The S7-200 converts an analog value (such as temperature or voltage) into a word-length (16-bit) digital
value. You access these values by the area identifier (Al), size of the data (W), and the starting byte
address. Since analog inputs are words and always start on even-number bytes (such as 0, 2, or 4), you
access them with even-number byte addresses (such as AIWO0, AIW2, or AIW4). Analog input values are
read-only values.

Format: AlW(starting byte address] AlwW4

Analog Outputs: AQ

The S7-200 converts a word-length (16-bit) digital value into a current or voltage, proportional to the digital
value (such as for a current or voltage). You write these values by the area identifier (AQ), size of the data
(W), and the starting byte address. Since analog outputs are words and always start on even-number
bytes (such as 0, 2, or 4), you write them with even-number byte addresses (such as AQWO0, AQW?2, or
AQWS4). Analog output values are write-only values.

Format: AQW(starting byte address] AQWA4

Sequence Control Relay (SCR) Memory Area: S

SCRs or S bits are used to organize machine operations or steps into equivalent program segments.
SCRs allow logical segmentation of the control program. You can access the S bits as bits, bytes, words,
or double words.

Bit: S[byte address].[bit address] S3.1
Byte, Word, or Double Word: S[size][starting byte address] SB4

Format for Real Numbers

Real (or floating-point) numbers are represented as 32-bit, single-precision numbers, whose format is
described in the ANSI/IEEE 754-1985 standard. See Figure 4-8. Real numbers are accessed in
double-word lengths.

For the S7-200, floating point numbers are MsB LSB
accurate up to 6 decimal places. Therefore, you 330 2 2 : 0
can specify a maximum of 6 decimal places | S | Exponent Mantissa

when entering a floating-point constant. Sign

Figure 4-8  Format of a Real Number

Accuracy when Calculating Real Numbers

Calculations that involve a long series of values including very large and very small numbers can produce
inaccurate results. This can occur if the numbers differ by 10 to the power of x, where x > 6.

For example: 100 000 000 + 1 = 100 000 000
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Format for Strings

A string is a sequence of characters, with each character being stored as a byte. The first byte of the string
defines the length of the string, which is the number of characters. Figure 4-9 shows the format for a
string. A string can have a length of 0 to 254 characters, plus the length byte, so the maximum length for a
string is 255 bytes.

| Length | Character 1 Character 2 | Character 3 | Character 4 | . Character 254

Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 254

Figure 4-9 Format for Strings

Specifying a Constant Value for S7-200 Instructions

You can use a constant value in many of the S7-200 instructions. Constants can be bytes, words, or
double words. The S7-200 stores all constants as binary humbers, which can then be represented in
decimal, hexadecimal, ASCII, or real number (floating point) formats. See Table 4-2.

Table 4-2 Representation of Constant Values

Representation Format Sample

Decimal [decimal value] 20047

Hexadecimal 16#[hexadecimal value] 16#4E4F

Binary 2#[binary number] 2#1010_0101_1010_0101

ASCII 'TASCII text]’ "Text goes between single quotes.’

Real ANSI/IEEE 754-1985 +1.175495E—-38 (positive) -1.175495E-38 (negative)
Tip

The S7-200 CPU does not support “data typing” or data checking (such as specifying that the constant
is stored as an integer, a signed integer, or a double integer). For example, an Add instruction can use
the value in VW100 as a signed integer value, while an Exclusive Or instruction can use the same value
in VW100 as an unsigned binary value.
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Addressing the Local and Expansion 1/O

The local I/O provided by the CPU provides a fixed set of I/O addresses. You can add I/O points to the
S7-200 CPU by connecting expansion 1/0 modules to the right side of the CPU, forming an I/O chain. The
addresses of the points of the module are determined by the type of I/O and the position of the module in
the chain, with respect to the preceding input or output module of the same type. For example, an output
module does not affect the addresses of the points on an input module, and vice versa. Likewise, analog
modules do not affect the addressing of digital modules, and vice versa.

Tip

Digital expansion modules always reserve process-image register space in increments of eight bits (one
byte). If a module does not provide a physical point for each bit of each reserved byte, these unused bits
cannot be assigned to subsequent modules in the I/O chain. For input modules, the unused bits in
reserved bytes are set to zero with each input update cycle.

Analog expansion modules are always allocated in increments of two points. If a module does not
provide physical I/O for each of these points, these I/O points are lost and are not available for
assignment to subsequent modules in the I/O chain.

Figure 4-10 provides an example of the 1/0 numbering for a particular hardware configuration. The gaps in
the addressing (shown as gray italic text) cannot be used by your program.

4 Analog In 4 Analog In
CPU 224 ‘ 41n/4o0ut ‘ 81In 1 Analog Out 8 Out 1 Analog Out
10.0 Q0.0 Module 0 Module 1 Module 2 Module 3 Module 4
10.1 Q0.1 20 Q20 13.0 AIWO AQWO Q3.0 AIWS AQW4
10.2 Q0.2 21 Q21 13.1 AlW2 AQW2 Q3.1 AIWI0  AQWE
10.3 Q0.3 22 Q22 13.2 AlW4 Q3.2 AIW12
10.4 Q0.4 123 Q23 13.3 AIWG Q3.3 Alw14
10.5 Q0.5 24 Q24 13.4 Q3.4
10.6 Q0.6 25 Q25 13.5 Q35
10.7 Q0.7 26 Q26 13.6 Q3.6
11.0 Q1.0 2.7 Q27 13.7 Q3.7
1.1 QL1
1.2 QL2 ;
15 o5 Expansion 1/O
1.4 QL4
115 QL5
1.6 QL6
1.7 QL7
Local I/O

Figure 4-10 Sample I/O Addresses for Local and Expansion 1/O (CPU 224)
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Using Pointers for Indirect Addressing of the S7-200 Memory Areas

%

Indirect addressing uses a pointer to access the data in memory. Pointers are double word memory
locations that contain the address of another memory location. You can only use V memory locations,

L memory locations, or accumulator registers (AC1, AC2, AC3) as pointers. To create a pointer, you must
use the Move Double Word instruction to move the address of the indirectly addressed memory location to
the pointer location. Pointers can also be passed to a subroutine as a parameter.

The S7-200 allows pointers to access the following memory areas: |, Q, V, M, S, T (current value only),
and C (current value only). You cannot use indirect addressing to access an individual bit or to access Al,
AQ, HC, SM, or L memory areas.

To indirectly access the data in a memory address, you create a pointer to that location by entering an
ampersand (&) and the memory location to be addressed. The input operand of the instruction must be
preceded with an ampersand (&) to signify that the address of a memory location, instead of its contents,
is to be moved into the location identified in the output operand of the instruction (the pointer).

Entering an asterisk (*) in front of an operand for an instruction specifies that the operand is a pointer. As
shown in Figure 4-11, entering *AC1 specifies that AC1 is a pointer to the word-length value being
referenced by the Move Word (MOVW) instruction. In this example, the values stored in both VB200 and
VB201 are moved to accumulator ACO.

AC1
V198 | address of VW200 |<—— MOVD &VW200, AC1
V200 12 Bl Creates the pointer by moving the address of VB200 (address of the initial
M byte for VW200) to AC1.
V201 34 l
V202 56 ACO
V203 78 | | 1234 |<—— mMovw *ACL, ACO

Moves the word value pointed to by AC1 to ACO.

Figure 4-11  Creating and Using a Pointer

As shown in Figure 4-12, you can change the value of a pointer. Since pointers are 32-bit values, use
double-word instructions to modify pointer values. Simple mathematical operations, such as adding or
incrementing, can be used to modify pointer values.

AC1

V199

| address of VW200 |<— MOVD &VW200, AC1
V200 12 ul Creates the pointer by moving the address of VB200 (address of
Vo201 34 | aco l VW200's initial byte) to AC1.
V202 56 | | 1234 | MOVW *AC1, ACO
V203 78 Moves the word value pointed to by AC1 (VW200) to ACO.
V199 ACL

| address of VW202 |<— +D +2,AC1
V200 12 ACO Adds 2 to the accumulator to point to the next word location.
V2o 34 | [ 5678 | MOVW *AC1, ACO
V202 56 ml T Moves the word value pointed to by AC1 (VW202) to ACO.
V203 78 ]

Figure 4-12  Modifying a Pointer

Tip
Remember to adjust for the size of the data that you are accessing: to access a byte, increment the

pointer value by 1; to access a word or a current value for a timer or counter, add or increment the
pointer value by 2; and to access a double word, add or increment the pointer value by 4.
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Sample Program for Using an Offset to Access Data in V Memory

This example uses LD10 as a pointer to the address VBO. You then increment the pointer by an offset stored in VD1004. LD10

then points to another address in V memory (VBO + offset). The value stored in the V memory address pointed to by LD10 is then
copied to VB1900. By changing the value in VD1004, you can access any V memory location.

Network 1
SMO.0 MOy _Dvy
|

—| | EN ENO

&BO4IN ouT

ADD_DI
EM  EMNO

YD100441M1 OUT
LO104IMZ

ﬁ

FLD10

FLD10

MW _B
EM  EMNO

ﬁ

“LD104IM ouT

B 1900

Network 1 //How to use an offset to read the value of any VB location:

LD

1

/1.
112.

Load the starting address of the V memory to a pointer.
Add the offset value to the pointer.

//3. Copy the value from the V memory location (offset) to VB1900.

SMO0.0

MOVD &VBO, LD10
VD1004, LD10
MOVB *LD10, VB1900

+D

Sample Program for Using a Pointer to Access Data in a Table

This example uses LD14 as a pointer to a recipe stored in a table of recipes that begins at VB100. In this example, VW1008
stores the index to a specific recipe in the table. If each recipe in the table is 50 bytes long, you multiply the index by 50 to obtain
the offset for the starting address of a specific recipe. By adding the offset to the pointer, you can access the individual recipe
from the table. In this example, the recipe is copied to the 50 bytes that start at VB1500.

H

FLO14

Metwork 1
SM0.0 MOV_DW
— | EN  ENO
avB100dN__ ouT
DI
EN  ENO

WA 008 1M ouT

FLO13

FLD13

FLD14

MUL_DI
EM ENO
+50 1M1 ouT
LD134IM2
ADD_DI
EM ENO
LD184IM1 ouT
LD144IM2
BLEMOY_B
EM ENO
*LO144IN ouT
S04

—

FvB1500

Network 1 //How to transfer a recipe from a table of recipes:
/I — Each recipe is 50 bytes long.
Il — The index parameter (VW1008) identifies the recipe

LD
MOVD
ITD

*D

+D
BMB

1
1

/1.
112.
113.
/4.
115.

SMO0.0

to be loaded.

Create a pointer to the starting address of the recipe table.
Convert the index of the recipe to a double-word value.

Multiply the offset to accommodate the size of each recipe.

Add the adjusted offset to the pointer.
Transfer the selected recipe to VB1500 through VB1549.

&VB100, LD14
VW1008, LD18
+50, LD18

LD18, LD14
*LD14, VB1500, 50
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Understanding How the S7-200 Saves and Restores Data

The S7-200 provides a variety of safeguards to ensure that your program, the program data, and the
configuration data for your S7-200 are properly retained.

The S7-200 provides a super capacitor that
maintains the integrity of the RAM after power
has been removed. Depending on the model of
the S7-200, the super capacitor can maintain the
RAM for several days.

The S7-200 provides an EEPROM to store
permanently all of your program, user-selected
data areas, and the configuration data.

The S7-200 also supports an optional battery
cartridge that extends the amount of time that the
RAM can be maintained after power has been
removed from the S7-200. The battery cartridge
provides power only after the super capacitor has
been drained.

Your project consists of three elements: the
program block, the data block (optional), and the
system block (optional).

Figure 4-14 shows how a project is downloaded
to the S7-200.

When you download a project, the elements of a
downloaded project are stored in the the RAM
area. The S7-200 also automatically copies the
user program, data block, and the system block
to the EEPROM for permanent storage.

Figure 4-15 shows how a project is uploaded
from the S7-200.

When you upload a project to your computer, the
S7-200 uploads the system block from the RAM
and uploads the program block and the data
block from the EEPROM.

RAM:

Program block
System block

V memory

M memory

Timer and Counter
current values

Forced values

G

i

| Sy Ny N [ S ) S [

S7-200 CPU

maintained by the super capacitor
and the optional battery cartridge

EEPROM:
permanent storage

Program block
System block

Data block

M memory
(permanent area)

Forced values

Figure 4-13 Storage Areas of the S7-200 CPU

Downloading and Uploading the Elements of Your Project

Program block
System block
Data block:

up to the maximum
V memory range

Program block

System block

V memory

M memory

Timer and Counter
current values

Forced values

Wl

| S [y N [ N

i

Program block
System block
Data block

RAM

S7-200 CPU

Data block

M memory
(permanent area)

Forced values

EEPROM

Figure 4-14 Downloading a Project to the S7-200

System block

T

Program block
Data block

Program block
System block

V memory

M memory

Timer and Counter
current values

Forced values

Wl

| ES [ N [ N R S [ S [

RAM

Program block
System block

Data block

M memory
(permanent area)
Forced values

EEPROM

Figure 4-15 Uploading a Project from the S7-200
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Saving the Retentive M Memory Area on Power Loss

If you configured the first 14 bytes of bit memory
(MBO to MB13) to be retentive, these bytes are
permanently saved to the EEPROM in the event
that the S7-200 loses power.

S7-200 CPU

Program block

Program block
System block

System block

V memory

As shown in Figure 4-16, the S7-200 moves
these retentive areas of M memory to the
EEPROM.

Data block

MBO to MB13
:] (if configured as M memory
retentive) (permanent area)

M memory

The default setting for the first 14 bytes of

M memory is to be non-retentive. The default
disables the save that normally occurs when you
power off the S7-200.

Timer and Counter
current values

Forced values

W

RAM EEPROM

Figure 4-16 Saving the M Memory on Power Loss

Restoring Data After Power On

At power on, the S7-200 restores the program block and the system block from the EEPROM memory, as
shown in Figure 4-17. Also at power on, the S7-200 checks the RAM to verify that the super capacitor
successfully maintained the data stored in RAM memory. If the RAM was successfully maintained, the
retentive areas of RAM are left unchanged.

The retentive and non-retentive areas of V memory are restored from the corresponding data block in the
EEPROM. If the contents of the RAM were not maintained (such as after an extended power failure), the
S7-200 clears the RAM (including both the retentive and non-retentive ranges) and sets the Retentive
Data Lost memory bit (SMO0.2) for the first scan cycle following power on, and then copies the data stored
in the EEPROM to the RAM.

S7-200 CPU

Program block
System block
Program block
V memory System block
Data block
M memory
Forced values

| Program block If the program data was successfully

maintained, copies the data block to the
non-retentive areas of V memory in RAM.

System block
Data block

M memory
(permanent area)

Forced values

M memory If the program data was NOT maintained,

copies the data block and M memory
(MBO to MB13), if defined as retentive.

S N S N S -

Timer and Counter
current values

Sets all other
non-retentive areas
of memory to 0

i

Forced values

RAM EEPROM

Figure 4-17  Restoring Data after Power On
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Storing Your Program on a Memory Cartridge

36

The S7-200 supports an optional memory cartridge that provides a portable EEPROM storage for your
program. The S7-200 stores the following elements on the memory cartridge: the program block, the data
block, the system block, and the forced values.

You can copy your program to the memory cartridge from the RAM only when the S7-200 is powered on
and in STOP mode and the memory cartridge is installed. You can install or remove the memory cartridge
while the S7-200 is powered on.

Caution
Electrostatic discharge can damage the memory cartridge or the receptacle on the S7-200 CPU.

Make contact with a grounded conductive pad and/or wear a grounded wrist strap when you handle the
cartridge. Store the cartridge in a conductive container.

To install the memory cartridge, remove the plastic slot cover from the S7-200 CPU and insert the memory
cartridge in the slot. The memory cartridge is keyed for proper installation.

Copying Your Program to the Memory Cartridge

After installing the memory cartridge, use the
following procedure to copy the program:

Memory
Cartridge

Program block
Data block
Forced values

System block

1. Putthe S7-200 CPU in STOP mode.

If the program has not already been
downloaded to the S7-200, download the
program.

3. Select the PLC > Program Memory
Cartridge menu command to copy the
program to the memory cartridge.
Figure 4-18 shows the elements of the
CPU memory that are stored on the
memory cartridge.

4. Optional: Remove the memory cartridge
and replace the cover on the S7-200.

Program block
System block

V memory

Program block
System block
Data block

M memory
(permanent area)

Forced values

EEPROM

M memory

Timer and Counter
current values

| S [ N [ N N [ N ) N

LA

Forced values

Figure 4-18 Copying to a Memory Cartridge

Restoring the Program from a Memory Cartridge

To transfer the program from a memory cartridge to the S7-200, you must cycle the power to the S7-200
with the memory cartridge installed.

Notice

Powering on an S7-200 CPU with a blank memory cartridge or a memory cartridge that was
programmed by a different model of S7-200 CPU could cause an error. Memory cartridges that were
programmed by a lower model number CPU can be read by a higher model number CPU. However, the
opposite is not true. For example, memory cartridges that were programmed by a CPU 221 or CPU 222
can be read by a CPU 224, but memory cartridges that were programmed by a CPU 224 are rejected by
a CPU 221 or CPU 222.

Remove the memory cartridge and turn the power on for the S7-200. After power on, the memory
cartridge can then be inserted and reprogrammed, if required.



PLC Concepts

Chapter 4

As shown in Figure 4-19, the S7-200 performs

the following tasks after you cycle power with the

memory cartridge installed:

1. If the contents of the memory cartridge
differ from the contents of the EEPROM,
the S7-200 clears the RAM.

2. The S7-200 copies the contents of the
memory cartridge to the RAM.

Program block
System block
Data block

Forced values

s

Memory
Cartridge

The S7-200 copies the program block, the

Program block

System block
V memory

i

Program block
:] System block
Data block
:] Forced values

S7-200CPU /1 M/ —1 1 [

Program block

System block

Aata block

M memory

All other areas
of memory are
setto 0.

system block, and the data block to the
EEPROM.

] | M memory
(permanent area)
Forced values

Timer and Co
current value!

Forced values

EEPROM

Figure 4-19 Restoring from a Memory Cartridge

Selecting the Operating Mode for the S7-200 CPU

The S7-200 has two modes of operation: STOP mode and RUN mode. The status LED on the front of the
CPU indicates the current mode of operation. In STOP mode, the S7-200 is not executing the program,
and you can download a program or the CPU configuration. In RUN mode, the S7-200 is running the
program.

1 The S7-200 provides a mode switch for changing the mode of operation. You can use the mode
switch (located under the front access door of the S7-200) to manually select the operating mode:
setting the mode switch to STOP mode stops the execution of the program; setting the mode switch
to RUN mode starts the execution of the program; and setting the mode switch to TERM (terminal)
mode does not change the operating mode.

If a power cycle occurs when the mode switch is set to either STOP or TERM, the S7-200 goes
automatically to STOP mode when power is restored. If a power cycle occurs when the mode switch
is set to RUN, the S7-200 goes to RUN mode when power is restored.

1 STEP 7-Micro/WIN allows you to change the operating mode of the online S7-200. To enable the
software to change the operating mode, you must manually set the mode switch on the S7-200 to
either TERM or RUN. You can use the PLC > STOP or PLC > RUN menu commands or the
associated buttons on the toolbar to change the operating mode.

[ You can insert the STOP instruction in your program to change the S7-200 to STOP mode. This
allows you to halt the execution of your program based on the program logic. For more information
about the STOP instruction, see Chapter 6.
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Using Your Program to Save V Memory to the EEPROM

You can save a value (byte, word, or double word) stored in any location of the V memory area to the
EEPROM. A Save-to-EEPROM operation typically increases the scan time by a maximum of 5 ms. The
value written by the Save operation overwrites any previous value stored in the V. memory area of the
EEPROM.

The Save-to-EEPROM operation does not update the data in the memory cartridge.

Tip

Since the number of Save operations to the EEPROM is limited (100,000 minimum, and 1,000,000
typical), you should ensure that only necessary values are saved. Otherwise, the EEPROM can wear
out and the CPU can fail. Typically, you should perform Save operations at the occurrence of specific
events that occur rather infrequently.

For example, if the scan time of the S7-200 is 50 ms and a value was saved once per scan, the
EEPROM would last a minimum of 5,000 seconds, which is less than an hour and a half. On the other
hand, if a value were saved once an hour, the EEPROM would last a minimum of 11 years.

Copying V Memory to the EEPROM

Special Memory Byte 31 (SMB31) commands the S7-200 to copy a value in V memory to the V memory
area of the EEPROM. Special Memory Word 32 (SMW32) stores the address location of the value that is
to be copied. Figure 4-20 shows the format of SMB31 and SMW32.

Use the following steps to program the S7-200 to save or SMB31

. oo . Si f val b
write a specific value in V memory: ! 0 S o valuetobe
|sv | o|o| o| o| 0 |sl|sO| 00 - byte
1. Load the V memory address of the value to be saved | (1)(1,:%:;
in SMW32. Save to EEPROM: 11 — double word
0=No
2. Load the size of the data in SM31.0 and SM31.1, as 1=Yes \ The CPU resets
shown in Figure 4-20. SM31.7 after each
save operation.
3. SetSM31.7 to 1.
SMW32
At the end of every scan cycle, the S7-200 checks SM31.7; 15 V memory address o|
if SM31.7 equals 1, the specified value is saved to the _
EEPROM. The operation is complete when the S7-200 Specify the V memory address as an offset from V0.

resets SM31.7 10 0. Figure 420 SMB31 and SMW32

Do not change the value in V memory until the save operation is complete.

Sample Program: Copying V Memory to the EEPROM

This example transfers VB100 to the EEPROM. On a rising edge of 10.0, if another transfer is not in progress, it loads the address
of the V. memory location to be transferred to SMW32. It selects the amount of V memory to transfer (1=Byte; 2=Word; 3=Double
Word or Real). It then sets SM31.7 to have the S7-200 transfer the data at the end of the scan.

The S7-200 automatically resets SM31.7 when the transfer is complete.

Hetwork 1
10,0

Network 1 /[Transfer a V memory location (VB100)

38

| L El;mml? MO /lto the EEPROM
I | P I | ! I EM ENOH LD |00
+1004IM QUTFSMW32 EU
AN SM31.7
MOVW  +100, SMW32
MOV_B MOVB 1, SMB31
e omo—— g SM31.7, 1
1-In OUTFSMB31
SM31.T
—( =)




PLC Concepts Chapter 4

Features of the S7-200

The S7-200 provides several special features that allow you to customize how the S7-200 functions to
better fit your application.

The S7-200 Allows Your Program to Immediately Read or Write the 1/0O

The S7-200 instruction set provides instructions that immediately read from or write to the physical 1/O.
These immediate 1/O instructions allow direct access to the actual input or output point, even though the
image registers are normally used as either the source or the destination for I/0 accesses.

The corresponding process-image input register location is not modified when you use an immediate
instruction to access an input point. The corresponding process-image output register location is updated
simultaneously when you use an immediate instruction to access an output point.

Tip
@ The S7-200 handles reads of analog inputs as immediate data, unless you enable analog input filtering.
When you write a value to an analog output, the output is updated immediately.

It is usually advantageous to use the process-image register rather than to directly access inputs or
outputs during the execution of your program. There are three reasons for using the image registers:

1 The sampling of all inputs at the start of the scan synchronizes and freezes the values of the inputs
for the program execution phase of the scan cycle. The outputs are updated from the image register
after the execution of the program is complete. This provides a stabilizing effect on the system.

1 Your program can access the image register much more quickly than it can access 1/O points,
allowing faster execution of the program.

1 /O points are bit entities and must be accessed as bits or bytes, but you can access the image
register as bits, bytes, words, or double words. Thus, the image registers provide additional
flexibility.

The S7-200 Allows Your Program to Interrupt the Scan Cycle

If you use interrupts, the routines associated with each interrupt event are stored as part of the program.
The interrupt routines are not executed as part of the normal scan cycle, but are executed when the
interrupt event occurs (which could be at any point in the scan cycle).

Interrupts are serviced by the S7-200 on a first-come-first-served basis within their respective priority
assignments. See the Interrupt instructions in|Chapter 6 for more information.
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The S7-200 Allows You to Allocate Processing Time for Communications
Tasks

You can configure a percentage of the scan cycle to be dedicated for processing the communications
requests that are associated with a RUN mode edit compilation or execution status. (Run mode edit and
execution status are options provided by STEP 7—Micro/WIN to make debugging your program easier.) As
you increase the percentage of time that is dedicated to processing communications requests, you
increase the scan time, which makes your control process run more slowly.

The default percentage of the scan dedicated to
proceSSIng Communlcatlons requeStS IS Set to Part[s) I Retentive Ranges I Password | DutpulTahl\e I Input Filters I
10%. This setting was chosen to provide a Andlog Input Fiters | Pulse Catch Bits Background Time < prgmamns— 1.

reasonable compromise for processing the
compilation and status operations while
minimizing the impact to your control process.
You can adjust this value by 5% increments up to Detault=10%
a maximum of 50%. To set the scan cycle

time-slice for background communications:

Select Communications Background Time (5 - 50%)

E = = 2.

1. Select the View > Component >
System Block menu command and click
on the Background Time tab.

Configuration parameters must be downloaded befare they take effect. Mot &l PLC types
suppart every System Block option. Press F1 to see which options are supported by each
PLC.

2. Edit the properties for the communications
background time and click OK.

3. Download the modified system block to the Cancel
S7-200.

Figure 4-21 Communications Background Time

The S7-200 Allows You to Set the States of Digital Outputs for Stop Mode

The output table of the S7-200 allows you to determine whether to set the state of the digital output points
to known values upon a transition to the STOP mode, or to leave the outputs in the state they were in
before the transition to the STOP mode. The output table is part of the system block that is downloaded
and stored in the S7-200 and applies only to the digital outputs.

1. Select the View > Component >
SyStem BlOCk menu Command and CIICk Analog Input Filters I Pulse Catch Bits I Background Time | EM Carfigurations I
on the Output Table tab. Partfs] | Ratentive Ranges | Paseword Output Table i‘W— 1.
2. To freeze the outputs in their last state, I Freszs Outputs in s _Defate | 2.
select the Freeze Outputs check box. il Leid il
oo | CCCCCCTT nex (CCCCCCCT
3. To copy the table values to the outputs, s FFF::H:H: GER ppFFFppp < 3.
. - 02 G0
enter the output table values by clicking the Ol et et i e ol i
i pax | CCCCCCTT ez | CCCCCECT
checkbox for each output bit you want to e i mimim B i
set to On (1) after a run-to-stop transition. msx [CECCCCTT guax |[CCCCCCCC
e LT (e 1= o
(The default values of the table are all
Zeroes) Marked outputs will be OM when the PLC transitions from BUN to STOP mode.
4_ CIle OK to save your SeleCthnS Configuration parameters must be downloaded before they take sffect. Mot all PLC types
support every System Block option. Press F1 to see which options are supported by each
5. Download the modified system block to the =~ ™
S7-200.

Figure 4-22 Configuring the Output Table
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The S7-200 Allows You to Define Memory to Be Retained on Loss of Power

You can define up to six retentive ranges to select the areas of memory you want to retain through power
cycles. You can define ranges of addresses in the following memory areas to be retentive: V, M, C, and T.
For timers, only the retentive timers (TONR) can be retained. The default setting for the first 14 bytes of

M Memory is to be non-retentive.

Only the current values for timers and counters can be retained: the timer and counter bits are not
retentive.

Tip
@ Changing the range MBO to MB13 to be retentive enables a special feature that automatically saves
these locations to the EEPROM on power down.

To define the retentive memory:
Analog [nput Filters | Pulse Catch Bits I Background Time I EM Configurations I
1. Select the View > Component > Potfs)  Retentive Ranges € rammmon | ooparane | TERTREE 1.
System Block menu command and click Defaults
on the Retentive Ranges tab. Daiskes Ot 't
. Range 0 |m -| Jo = e = Cleat |
2. Select_ the ranges of memory to be retained het [& =] o =T S cew | 2.
following loss of power and click OK. Rarge2 |7 =] = N e |
3. Download the modified system block to the Rorged [T Sl [ = 2 3 cea |
S7-200 Ranged O =] o = [z = Clear |
: Range5 [MB =] e = fe = Clear |

Configuration parameters must be downloaded before they take effect. Mot all PLC types
support every System Block option. Press F1 to see which options are supported by each
PLC.

[=

Cancel

Figure 4-23 Retentive Memory

The S7-200 Allows You to Filter the Digital Inputs

The S7-200 allows you to select an input filter that defines a delay time (selectable from 0.2 ms to
12.8 ms) for some or all of the local digital input points. This delay helps to filter noise on the input wiring
that could cause inadvertent changes to the states of the inputs.

The input filter is part of the system block that is
downloaded and Stored |n the S7'200 The Analog Input Filters | Pulse Catch Bits | Background Time | EM Configurations |
default filter time is 6.4 ms. As shown in Potls) | RetentiveRlanges | Passwod | OulputTable  Input Fiters 1.
Figure 4-24, each delay specification applies to Defauls
groups of input points. D08 . 2
To configure the delay times for the input filter: o |—_||§i§ ;I -

na-ns fean v ms

1. Select the View > Component >
System Block menu command and click
on the Input Filters tab.

2. Enter the amount of delay for each group
of inputs and click OK. Canfiguration parameters must be dowrloaded before they Lake effect. Not al PLC lypes

support every System Block option. Press F1 to see which options are supported by each

3. Download the modified system block to the FLE.
S7-200.

Cancel

Figure 4-24 Configuring the Input Filters

Tip
@ The digital input filter affects the input value as seen by instruction reads, input interrupts, and pulse
catches. Depending on your filter selection, your program could miss an interrupt event or pulse catch.
The high speed counters count the events on the unfiltered inputs.
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The S7-200 Allows You to Filter the Analog Inputs

%

The S7-200 allows you to select software filtering on individual analog inputs. The filtered value is the
average value of a preselected number of samples of the analog input. The filter specification (number of
samples and deadband) is the same for all analog inputs for which filtering is enabled.

The filter has a fast response feature to allow large changes to be quickly reflected in the filter value. The
filter makes a step function change to the latest analog input value when the input exceeds a specified
change from the current value. This change, called the deadband, is specified in counts of the digital value
of the analog input.

The default configuration is to enable filtering for
a” ana'Og |npUtS Potfs] | Retentive Ranges I Password I Output Table I InpLit Filters I
Analog Input Fiters e camer | cammmae T | CeToomT . 1
1. Select the View > Component > T
System Block menu command and click St ot At s e e
on the Ana|og |nput Filters tab. w8 16 24 2 W 40V 48V 5V
. Aw2l 10l 18K %W 34 W 42 BV BNV 2.
2. Select the analog inputs that you want to awe 2R AR BF BRF #4F 2F 0F
filter, the number of samples, and the e vE el o s d e wd e
deadband X Mumber of samples Dieadband (16 - 4080)
. B4 > 2 =
3. Click OK. 0 = Deadbard Disabled
Download the modified system block to the
S7'200 Configuration parameters must be downloaded before they take effect. Mot all PLC types
gﬂ:orl every System Block option. Press F1 to see which options are supported by each

Figure 4-25 Analog Input Filter

Tip
Do not use the analog filter with modules that pass digital information or alarm indications in the analog
words. Always disable analog filtering for RTD, Thermocouple, and AS-Interface Master modules.

The S7-200 Allows You to Catch Pulses of Short Duration

The S7-200 provides a pulse catch feature which can be used for some or all of the local digital input
points. The pulse catch feature allows you to capture high-going pulses or low-going pulses that are of
such a short duration that they would not always be seen when the S7-200 reads the digital inputs at the
beginning of the scan cycle. When pulse catch is enabled for an input, a change in state of the input is
latched and held until the next input cycle update. This ensures that a pulse which lasts for a short period
of time is caught and held until the S7-200 reads the inputs.

You can individually enable the pulse catch
Operatlon for eaCh Of the Iocal dlgltal InpUtS Part[s) I Retentive Ranges | Passlwnrd I Output Table I Input Filters I
) . Analog Input Filters Fulse Catch Bits ﬁaunguuunu TiE | T 1.
To access the pulse catch configuration screen:
Select desired inputs Defaults

1. Select the View > Component > . s - )
System Block menu command and click P inininininininis
on the Pulse Catch Bits tab.

2. Click the corresponding check box and
click OK.

3. Download the modified system block to the
S7-200.

Configuration parameters must be downloaded before they take effect. Mot all PLC types
support every System Block option. Press F1 to see which options are supported by each
PLC.

Cancel

Figure 4-26 Pulse Catch
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Figure 4-27 shows the basic operation of the S7-200 with and without pulse catch enabled.

Scan cycle ‘ Next scan cycle

Physical Input

The S7-200 misses this pulse because the input turned
on and off before the S7-200 updated the process-image
input register

Output from pulse catch

Disabled

T Input update T Input update
\ \

\ \

\ \

\ \

\ \

1 1

[ [

\

\

Enabled The S7-200 catches the pulse on the physical input

Figure 4-27  Operation of the S7-200 with the Pulse Catch Feature Enabled and Disabled

Because the pulse catch function operates on the input after it passes through the input filter, you must
adjust the input filter time so that the pulse is not removed by the filter. Figure 4-28 shows a block diagram
of the digital input circuit.

- — T a
Optical Digital Input Pulse
® Isolation Filter Catch L Input to 87-200_!
External #
Digital Input Pulse Catch Enable

Figure 4-28  Digital Input Circuit

Figure 4-29 shows the response of an enabled pulse catch function to various input conditions. If you
have more than one pulse in a given scan, only the first pulse is read. If you have multiple pulses in a
given scan, you should use the rising/falling edge interrupt events. (For a listing of interrupt events, see
Table 6-44.)

Scan cycle Next scan cycle
Input update Input update
Input to pulse catch J I I S
Output from pulse catch | l
—'_' \
| |
Input to pulse catch i LT i
Output from pulsecatch —————— L
| \
Input to pulse catch \ L
Output from pulse catch ‘ ‘

Figure 4-29  Responses of the Pulse Catch Function to Various Input Conditions
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The S7-200 Provides Password Protection

All models of the S7-200 provide password Table4-3  Restricting Access to the S7-200
rotection for restricting access to specific
Functions 9 P CPU Function Level1 Level2 Level3
Read and write user data Access Access Access

A password authorizes access to the functions O L L e

o Start, stop, and restart the
and memory: without a password, the S7-200

. . o CPU
provides unrestricted access. When it is
password protected, the S7-200 limits all Read and write the
restricted operations according to the time-of-day clock
configuration provided when the password was Upload the user program, Access  Access Password
installed. data. and the CPU Allowed  Allowed required
. . configuration
The password is not case sensitive.
Download to the CPU ﬁﬁcessa F’aSS_W%fd
. . owe require:

As shown in Table 4-3, the_S7_-200 provides Get the execution status
three levels of access restriction. Each level
allows certain functions to be accessible Delete the program block,
without a password. For all three levels of data block, or system block
access, entering the correct password provides  Force data or execute the
access to all of the functions. The default single/multiple scan

condition for the S7-200 is level 1 (no

restriction). Copy to the memory

cartridge

Entering the password over a network does not  Write outputs in STOP mode
compromise the password protection for the
S7-200.

Having one user authorized to access restricted functions does not authorize other users to access those
functions. Only one user is allowed unrestricted access to the S7-200 at a time.

Tip

@ After you enter the password, the authorization level for that password remains effective for up to one
minute after the programming device has been disconnected from the S7-200. Always exit
STEP 7-Micro/WIN before disconnecting the cable to prevent another user from accessing the privileges
of the programming device.

Configuring a Password for the S7-200

The System Block dialog box (Figure 4-30)
a||OWS yOU to Conﬂgure a password for the Analog Input Filters | Pulse Catch Bils | Background Time | EM Configurations I
S7-200: Partfs] I Retentive Ranges Password <€ —Soma— oo ; T 1.
. @ Full Privileges [Level 1]
1. Select the View > Component >
System Block menu command to display ® FoFitEslodd 2.
. . £ Minimum Privileges (Level 3)
the System Block dialog box and click on
the Password tab. Passtis — 3.
. Venlyl—
2. Select the appropriate level of access for
the S7-200.
3. Enter and verify the password.
4. CI|Ck OK Configuration parameters must be downloaded before they take effect. Not all PLC types
. support every System Block option. Press F1 to see which options are supported by each
5. Download the modified system block to the PLL
S7-200.

Cancel

Figure 4-30 Creating a Password
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Recovering from a Lost Password

If you forget the password, you must clear the memory of the S7-200 and reload your program. Clearing
the memory puts the S7-200 in STOP mode and resets the S7-200 to the factory-set defaults, except for
the network address, baud rate, and the time-of-day clock. To clear your program in the S7-200:

1. Select the PLC > Clear menu command to display the Clear dialog box.
2. Select all three blocks and confirm your action by clicking OK.

3. If apassword had been configured, STEP 7—Micro/WIN displays a password-authorization dialog
box. To clear the password, enter CLEARPLC in the password-authorization dialog box to continue
the Clear All operation. (The CLEARPLC password is not case sensitive.)

The Clear All operation does not remove the program from a memory cartridge. Since the memory
cartridge stores the password along with the program, you must also reprogram the memory cartridge to
remove the lost password.

Warning

Clearing the S7-200 memory causes the outputs to turn off (or in the case of an analog output, to be
frozen at a specific value).

If the S7-200 is connected to equipment when you clear the memory, changes in the state of the outputs
can be transmitted to the equipment. If you had configured the “safe state” for the outputs to be different
from the factory settings, changes in the outputs could cause unpredictable operation of your

equipment, which in turn could cause death or serious injury to personnel, and/or damage to equipment.

Always follow appropriate safety precautions and ensure that your process is in a safe state before
clearing the S7-200 memory.

The S7-200 Provides Analog Adjustment Potentiometers

The analog adjustment potentiometers are located under the front access cover of the module. You can
adjust these potentiometers to increase or decrease values that are stored in bytes of Special Memory
(SMB). These read-only values can be used by the program for a variety of functions, such as updating
the current value for a timer or a counter, entering or changing the preset values, or setting limits. Use a
small screwdriver to make the adjustments: turn the potentiometer clockwise (to the right) to increase the
value, and counterclockwise (to the left) to decrease the value.

SMB28 holds the digital value that represents the position of analog adjustment 0. SMB29 holds the digital
value that represents the position of analog adjustment 1. The analog adjustment has a nominal range of
0 to 255 and a repeatability of £2 counts.

Sample Program for Referencing the Value Entered with the Analog Adjustment Potentiometers

Hetwork 1 Network 1 /IRead analog adjustment 0 (SMB28).
0.0 B_ /ISave the value as an integer in VW100.

— A Enop—y LD 10,0

BTI SMB28, VW100

SMB284IN__ OUTEFWWY100

Network 2 //Use the integer value (VW100) as a preset for a timer.

LDN Q0.0
Metwork 2 TON  T33,VW100
@0.0 T33
—| i i I TON Network 3 /ITurn on Q0.0 when T33 reaches the preset value.
LD T33
W1 004PT _ Q0.0

Network 3

_|TS

Qo.o

—)
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The S7-200 Provides High-speed 1/0O

High-Speed Counters

The S7-200 provides integrated high-speed counter functions that count high speed external events
without degrading the performance of the S7-200. See Appendix A for the rates supported by your CPU
model. Each counter has dedicated inputs for clocks, direction control, reset, and start, where these
functions are supported. You can select different quadrature modes for varying the counting rate. For more
information on high-speed counters, see Chapter 6.

High-Speed Pulse Output

The S7-200 supports high-speed pulse outputs, with outputs Q0.0 and Q0.1 generating either a
high-speed pulse train output (PTO) or pulse width modulation (PWM).

The PTO function provides a square wave (50% duty cycle) output for a specified number of pulses (from
1to 4,294,967,295 pulses) and a specified cycle time (in either microsecond or millisecond increments
either from 50 ps to 65,535 us or from 2 ms to 65,535 ms). You can program the PTO function to produce
either one train of pulses or a pulse profile consisting of multiple trains of pulses. For example, you can
use a pulse profile to control a stepper motor through a simple ramp up, run, and ramp down sequence or
more complicated sequences. The pulse profile can consist of up to 255 segments with a segment
corresponding to the ramp up or run or ramp down operation.

The PWM function provides a fixed cycle time with a variable duty cycle output, with the cycle time and the
pulse width specified in either microsecond or millisecond increments. The cycle time has a range either
from 50 us to 65,535 ps or from 2 ms to 65,535 ms. The pulse width time has a range either from 0 us to
65,535 us or from 0 ms to 65,535 ms. When the pulse width is equal to the cycle time, the duty cycle is
100 percent and the output is turned on continuously. When the pulse width is zero, the duty cycle is 0
percent and the output is turned off.

For more information on the high-speed pulse output instruction, see|Chapter 6.



Programming Concepts, Conventions,
and Features

The S7-200 continuously executes your program to control a task or process. You use STEP 7=Micro/WIN
to create this program and download it to the S7-200. STEP 7—Micro/WIN provides a variety of tools and
features for designing, implementing, and debugging your program.

In This Chapter

Guidelines for Designing a Micro PLC SyStem . ... ... .. it 48
Basic Elements of a Program . . ... .. ... 49
Using STEP 7—Micro/WIN to Create Your Programs .. ........ ..., 51
Choosing Between the SIMATIC and IEC 1131-3 Instruction Sets ........... .. ... oo, 53
Understanding the Conventions Used by the Program Editors . ......... ... ... .. ... ... .. ... 54
Using Wizards To Help You Create Your Control Program . . ... i 56
Handling Errors in the S7-200 . .. ... ... e e e 56
Assigning Addresses and Initial Values in the Data Block Editor .............................. 58
Using the Symbol Table for Symbolic Addressing of Variables ............ ... .. ... ... ... ... 58
Using Local Variables . ... .. ... 59
Using the Status Chart to Monitor Your Program . .. ... ... ..o e e e 59
Creating an Instruction Library . . ... ... ... e 60
Features for Debugging Your Program . . ... ...t e 60
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Guidelines for Designing a Micro PLC System

There are many methods for designing a Micro PLC system. The following general guidelines can apply to
many design projects. Of course, you must follow the directives of your own company’s procedures and
the accepted practices of your own training and location.

Partition Your Process or Machine

Divide your process or machine into sections that have a level of independence from each other. These
partitions determine the boundaries between controllers and influence the functional description
specifications and the assignment of resources.

Create the Functional Specifications

Write the descriptions of operation for each section of the process or machine. Include the following topics:
1/0 points, functional description of the operation, states that must be achieved before allowing action for
each actuator (such as solenoids, motors, and drives), description of the operator interface, and any
interfaces with other sections of the process or machine.

Design the Safety Circuits

Identify equipment requiring hard-wired logic for safety. Control devices can fail in an unsafe manner,
producing unexpected startup or change in the operation of machinery. Where unexpected or incorrect
operation of the machinery could result in physical injury to people or significant property damage,
consideration should be given to the use of electro-mechanical overrides which operate independently of
the S7-200 to prevent unsafe operations. The following tasks should be included in the design of safety
circuits:

1 Identify improper or unexpected operation of actuators that could be hazardous.

1 Identify the conditions that would assure the operation is not hazardous, and determine how to
detect these conditions independently of the S7-200.

1 !dentify how the S7-200 CPU and I/O affect the process when power is applied and removed, and
when errors are detected. This information should only be used for designing for the normal and
expected abnormal operation, and should not be relied on for safety purposes.

1 Design manual or electro-mechanical safety overrides that block the hazardous operation
independent of the S7-200.

(1 Provide appropriate status information from the independent circuits to the S7-200 so that the
program and any operator interfaces have necessary information.

1 Identify any other safety-related requirements for safe operation of the process.

Specify the Operator Stations

Based on the requirements of the functional specifications, create drawings of the operator stations.
Include the following items:

1 Overview showing the location of each operator station in relation to the process or machine
1 Mechanical layout of the devices, such as display, switches, and lights, for the operator station

(1 Electrical drawings with the associated 1/O of the S7-200 CPU or expansion module
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Create the Configuration Drawings

Based on the requirements of the functional specification, create configuration drawings of the control

equipment. Include the following items:

1 Overview showing the location of each S7-200 in relation to the process or machine

1 Mechanical layout of the S7-200 and expansion 1/0O modules (including cabinets and other

equipment)

(1 Electrical drawings for each S7-200 and expansion I/O module (including the device model
numbers, communications addresses, and I/O addresses)

Create a List of Symbolic Names (optional)

If you choose to use symbolic names for addressing, create a list of symbolic names for the absolute
addresses. Include not only the physical I/O signals, but also the other elements to be used in your

program.

Basic Elements of a Program

A program block is composed of executable code and comments. The executable code consists of a main
program and any subroutines or interrupt routines. The code is compiled and downloaded to the S7-200;
the program comments are not. You can use the organizational elements (main program, subroutines, and

interrupt routines) to structure your control program.

The following example shows a program that includes a subroutine and an interrupt routine. This sample
program uses a timed interrupt for reading the value of an analog input every 100 ms.

Example:Basic Elements of a Program

M | etwork 1
A SMD.1 SBRO
|y —
N
S Network 1
B SMO.0 MOY_B
R H | EN ENOH
0
10041n OUT} ShB34
ATCH
EN ENO%
INT_04INT
104EVhT
—{(eni)
| Network 1
N SMO.0 WMo
T _| |7EN ENOH
0
Al 1M QUT YW 00

Network 1 //On first scan, call subroutine 0.

LD SMO0.1
CALL SBR_0

Network 1 //Set the interval to 100 ms
[ffor the timed interrupt.
/[Enable interrupt 0.

LD SMO0.0
MOVB 100, SMB34
ATCH INT_O, 10
ENI

Network 1 /ISample the Analog Input 4.

LD SMO0.0
MOVW  AlW4,VW100
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Main Program

The main body of the program contains the instructions that control your application. The S7-200 executes
these instructions sequentially, once per scan cycle. The main program is also referred to as OB1.

Subroutines

These optional elements of your program are executed only when called: by the main program, by an
interrupt routine, or by another subroutine. Subroutines are useful in cases where you want to execute a
function repeatedly. Rather than rewriting the logic for each place in the main program where you want the
function to occur, you can write the logic once in a subroutine and call the subroutine as many times as
needed during the main program. Subroutines provide several benefits:

1 Using subroutines reduces the overall size of your program.

1 Using subroutines decreases your scan time because you have moved the code out of the main
program. The S7-200 evaluates the code in the main program every scan cycle, whether the code
is executed or not, but the S7-200 evaluates the code in the subroutine only when you call the
subroutine, and does not evaluate the code during the scans in which the subroutine is not called.

(1 Using subroutines creates code that is portable. You can isolate the code for a function in a
subroutine, and then copy that subroutine into other programs with little or no rework.

Tip

Using V memory addresses can limit the portability of your subroutine, because it is possible for V
memory address assignment from one program to conflict with an assignment in another program.
Subroutines that use the local variable table (L memory) for all address assignments, by contrast, are
highly portable because there is no concern about address conflicts between the subroutine and
another part of the program when using local variables.

Interrupt Routines

These optional elements of your program react to specific interrupt events. You design an interrupt routine
to handle a pre-defined interrupt event. Whenever the specified event occurs, the S7-200 executes the
interrupt routine.

The interrupt routines are not called by your main program. You associate an interrupt routine with an
interrupt event, and the S7-200 executes the instructions in the interrupt routine only on each occurrence
of the interrupt event.

Tip

Because it is not possible to predict when the S7-200 might generate an interrupt, it is desirable to limit
the number of variables that are used both by the interrupt routine and elsewhere in the program.

Use the local variable table of the interrupt routine to ensure that your interrupt routine uses only the
temporary memory and does not overwrite data used somewhere else in your program.

There are a number of programming techniques you can use to ensure that data is correctly shared
between your main program and the interrupt routines. These techniques are described in Chapter 6
with the Interrupt instructions.

Other Elements of the Program

=

System
Block

.
e
Data
Block
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Other blocks contain information for the S7-200. You can choose to download these blocks when you
download your program.

System Block
The system block allows you to configure different hardware options for the S7-200.

Data Block

The data block stores the values for different variables (V memory) used by your program. You can use
the data block to enter initial values for the data.
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Using STEP 7-Micro/WIN to Create Your Programs

@
Program
Editor

To open STEP 7-Micro/WIN, double-click on the STEP 7—Micro/WIN icon, or select the Start > SIMATIC >
STEP 7 MicroWIN 3.2 menu command. As shown in Figure 5-1, the STEP 7—Micro/WIN project window
provides a convenient working space for creating your control program.

The toolbars provide buttons for shortcuts to frequently used menu commands. You can view or hide any
of the toolbars.

The navigation bar presents groups of icons for  EEEETTE——
accessing different programming features of
STEP 7—Micro/WIN.

[n=@en|sme|s|pps =R =|Fre|sale s

3 B

The instruction tree displays all of the project “ S o [t
objects and the instructions for creating your

control program. You can drag and drop
individual instructions from the tree into your
program, or you can double-click an instruction to
insert it at the current location of the cursor in the
program editor.

| TEMP [
[ [TEMP [

1
I
[
[
[

POU Comment

Netwok 1 Newok Tile
[Retwok &

\“ li' Program Editor I

The program editor contains the program logic A

and a local variable table where you can assign Instruction tree

symbolic names for temporary local variables.

Subroutines and interrupt routines appear as Navigation bar o o
tabs at the bottom of the program editor window.

Click on the tabs to move between the Rout et v e w5
subroutines, interrupts, and the main program. Figure 5-1  STEP 7—Micro/WIN

STEP 7-Micro/WIN provides three editors for creating your program: Ladder Logic (LAD), Statement List
(STL), and Function Block Diagram (FBD). With some restrictions, programs written in any of these
program editors can be viewed and edited with the other program editors.

Features of the STL Editor

The STL editor displays the program as a text-based language. The STL editor allows you to create
control programs by entering the instruction mnemonics. The STL editor also allows you to create
programs that you could not otherwise create with the LAD or FBD editors. This is because you are
programming in the native language of the S7-200, rather than in a graphical editor where some
restrictions must be applied in order to draw the diagrams correctly. As shown in Figure 5-2, this
text-based concept is very similar to assembly language programming.

The S7-200 executes each instruction in the
order dictated by the program, from top to

LD 10.0 //IRead one input
bottom, and then restarts at the top. A 0.1 JAND with an%ther input
STL uses a logic stack to resolve the control = Q1.0 /I\Write value to output 1
logic. You insert the STL instructions for handling
the stack operations. Figure 5-2  Sample STL Program

Consider these main points when you select the STL editor:

(1 STL is most appropriate for experienced programmers.

1 STL sometimes allows you to solve problems that you cannot solve very easily with the LAD or FBD
editor.

[ You can only use the STL editor with the SIMATIC instruction set.

1 While you can always use the STL editor to view or edit a program that was created with the LAD or
FBD editors, the reverse is not always true. You cannot always use the LAD or FBD editors to
display a program that was written with the STL editor.
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Features of the LAD Editor

The LAD editor displays the program as a graphical representation similar to electrical wiring diagrams.
Ladder programs allow the program to emulate the flow of electric current from a power source through a
series of logical input conditions that in turn enable logical output conditions. A LAD program includes a
left power rail that is energized. Contacts that are closed allow energy to flow through them to the next
element, and contacts that are open block that energy flow.

The logic is separated into networks. The
program is executed one network at a time, from
left to right and then top to bottom as dictated by
the program. Figure 5-3 shows an example of a
LAD program. The various instructions are
represented by graphic symbols and include
three basic forms.

Contacts represent logic input conditions such as
switches, buttons, or internal conditions.

Coils usually represent logic output results such
as lamps, motor starters, interposing relays, or
internal output conditions.

Boxes represent additional instructions, such as
timers, counters, or math instructions.

Network 1
0.0 0.1 Q5.0
| | |
I 1 | N\ )
12.0 121
Hetwork 2
121 MOY_B SWIAP
— v eno EN  ENO—]
WBA0 41N QOUTFACD ACOAIN
Figure 5-3  Sample LAD Program

Consider these main points when you select the LAD editor:

(1 Ladder logic is easy for beginning programmers to use.

(1 Graphical representation is easy to understand and is popular around the world.

0 The LAD editor can be used with both the SIMATIC and IEC 1131-3 instruction sets.

1 You can always use the STL editor to display a program created with the SIMATIC LAD editor.

Features of the FBD Editor

The FBD editor displays the program as a graphical representation that resembles common logic gate
diagrams. There are no contacts and coils as found in the LAD editor, but there are equivalent instructions

that appear as box instructions.

Figure 5-4 shows an example of an FBD
program.

FBD does not use the concept of left and right
power rails; therefore, the term “power flow” is
used to express the analogous concept of control
flow through the FBD logic blocks.

Wa0.0—

121 AND

ACO—HPT

Figure 5-4

Sample FBD Program

The logic “1” path through FBD elements is called power flow. The origin of a power flow input and the
destination of a power flow output can be assigned directly to an operand.

The program logic is derived from the connections between these box instructions. That is, the output from
one instruction (such as an AND box) can be used to enable another instruction (such as a timer) to
create the necessary control logic. This connection concept allows you to solve a wide variety of logic

problems.

Consider these main points when you select the FBD editor:

1 The graphical logic gate style of representation is good for following program flow.

J The FBD editor can be used with both the SIMATIC and IEC 1131-3 instruction sets.

1 You can always use the STL editor to display a program created with the SIMATIC FBD editor.
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Choosing Between the SIMATIC and IEC 1131-3 Instruction Sets

Most PLCs offer similar basic instructions, but there are usually small differences from vendor to vendor in
appearance, operation, and so forth. Over the last several years, the International Electrotechnical
Commission (IEC) has developed an emerging global standard that specifically relates to many aspects of
PLC programming. This standard encourages different PLC manufacturers to offer instructions that are the
same in both appearance and operation.

Your S7-200 offers two instruction sets that allow you to solve a wide variety of automation tasks. The IEC
instruction set complies with the IEC 1131-3 standard for PLC programming, and the SIMATIC instruction
set is designed specifically for the S7-200.

Tip
@ When STEP 7-Micro/WIN is set to the IEC mode, it displays a red diamond (+¢) in the Instruction Tree
beside the instructions that are not defined by the IEC 1131-3 standard.

There are a few key differences between the SIMATIC instruction set and the IEC instruction set:

[ The IEC instruction set is restricted to those instructions that are standard among PLC vendors.
Some instructions that are normally included in the SIMATIC set are not standard instructions in the
IEC 1131-3 specification. These are still available for use as non-standard instructions, but if you
use them, the program is no longer strictly IEC 1131-3 compatible.

1 Some IEC box instructions accept multiple data formats. This practice is often referred to as
overloading. For example, rather than have separate ADD_| (Add Integer) and ADD_R (Add Real),
math boxes, the IEC ADD instruction examines the format of the data being added and
automatically chooses the correct instruction in the S7-200. This can save valuable program design
time.

1 When you use the IEC instructions, the instruction parameters are automatically checked for the
proper data format, such as a signed integer versus an unsigned integer. For example, an error
results if you try to enter an integer value for an instruction that expected a bit value (on/off). This
feature helps to minimize programming syntax errors.

Consider these points when you select either the SIMATIC or the IEC instruction set:

1 SIMATIC instructions usually have the shortest execution times. Some |IEC instructions might have
longer execution times.

1 Some IEC instructions, such as timers, counters, multiply, and divide, operate differently than their
SIMATIC counterparts.

[ You can use all three program editors (LAD, STL, FBD) with the SIMATIC instruction set. You can
use only the LAD and FBD program editors for IEC instructions.

1 The operation of the IEC instructions is standard for different brands of PLCs, and the knowledge
about creating an IEC-compliant program can be leveraged across PLC platforms.

1 While the IEC standard defines fewer instructions than are available in the SIMATIC instruction set,
you can always include SIMATIC instructions in your IEC program.

1 |EC 1131-3 specifies that variables must be declared with a type, and supports system checking of
data type.
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Understanding the Conventions Used by the Program Editors

STEP 7-Micro/WIN uses the following conventions in all of the program editors:

O A#infront of a symbol name (#varl) indicates that the symbol is of local scope.
(1 For IEC instructions, the % symbol indicates a direct address.
[ The operand symbol “?.?” or “????” indicates that an operand configuration is required.

LAD programs are divided into segments called networks. A network is an ordered arrangement of
contacts, coils, and boxes that are all connected to form a complete circuit: no short circuits, no open
circuits, and no reverse power flow conditions exist. STEP 7—Micro/WIN allows you to create comments
for your LAD program on a network-by-network basis. FBD programming uses the network concept for
segmenting and commenting your program.

STL programs do not use networks; however, you can use the NETWORK keyword to segment your
program.

Conventions Specific to the LAD Editor

In the LAD editor, you can use the F4, F6, and F9 keys on your keyboard to access contact, box, and coll
instructions. The LAD editor uses the following conventions:

1 The symbol “—>>" is an open circuit or a required power flow connection.

[ The symbol “—" indicates that the output is an optional power flow for an instruction that can be
cascaded or connected in series.

1 The symbol “>>" indicates that you can use power flow.

Conventions Specific to the FBD Editor

In the FBD editor, you can use the F4, F6, and F9 keys on your keyboard to access AND, OR, and box
instructions. The FBD editor uses the following conventions:

1 The symbol “—>>" on an EN operand is a power flow or operand indicator. It can also depict an
open circuit or a required power flow connection.

[ The symbol “—}" indicates that the output is an optional power flow for an instruction that can be
cascaded or connected in series.

1 The symbols “<<” and “>>" indicate that you can use

either a value or power flow. Logical NOT 1o AND Q00

Condition 10.0—
1 Negation bubbles: The logical NOT condition or

inverted condition of the operand or power flow is Immediate moH AND . a0

shown by the small circle on the input. In Figure 5-5, Condition 101 —

Q0.0 is equal to the NOT of 10.0 AND 10.1. Negation '

bubbles are only valid for Boolean signals, which can i ]

be specified as parameters or power flow. Figure 5-5  FBD Conventions

1 Immediate indicators: As shown in Figure 5-5, the FBD editor displays an immediate condition of a
Boolean operand with a vertical line on the input to an FBD instruction. The immediate indicator
causes an immediate read from the specified physical input. Immediate operators are only valid for
physical inputs.

1 Box with no input or output: A box with no input indicates an instruction that is independent of power
flow.

Tip
The number of operands can be expanded up to 32 inputs for AND and OR instructions. To add or
subtract operand tics, use the “+" and “~" keys on your keyboard.
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General Conventions of Programming for an S7-200

EN/ENO Definition

EN (Enable IN) is a Boolean input for boxes in LAD and FBD. Power flow must be present at this input for
the box instruction to be executed. In STL, the instructions do not have an EN input, but the top of stack
value must be a logic “1” for the corresponding STL instruction to be executed.

ENO (Enable Out) is a Boolean output for boxes in LAD and FBD. If the box has power flow at the EN
input and the box executes its function without error, then the ENO output passes power flow to the next
element. If an error is detected in the execution of the box, then power flow is terminated at the box that
generated the error.

In STL, there is no ENO output, but the STL instructions that correspond to the LAD and FBD instructions
with ENO outputs do set a special ENO bit. This bit is accessible with the AND ENO (AENO) instruction
and can be used to generate the same effect as the ENO bit of a box.

Tip
@ The EN/ENO operands and data types are not shown in the valid operands table for each instruction
because the operands are the same for all LAD and FBD instructions. Table 5-1 lists these operands
and data types for LAD and FBD. These operands apply to all LAD and FBD instructions shown in this
manual.

Table 5-1 EN/ENO Operands and Data Types for LAD and FBD

Program Editor Inputs/Outputs Operands Data Types
LAD EN, ENO Power Flow BOOL
FBD EN, ENO LQ,V,M,SM, S, T,C, L BOOL

Conditional/Unconditional Inputs

In LAD and FBD, a box or a coil that is dependent upon power flow is shown with a connection to any
element on the left side. A coil or box that is independent of power flow is shown with a connection directly
to the left power rail. Table 5-2 shows an example of both a conditional and an unconditional input.

Table 5-2 Representation of Conditional and Unconditional Inputs

Power Flow LAD FBD
Instruction that is dependent on power flow (conditional) 1 T
—{ Jwr)
MERT

Instruction that is independent of power flow (unconditional) | :NEX‘I)

Instructions without Outputs

Boxes that cannot cascade are drawn with no Boolean outputs. These include the Subroutine Call, Jump,
and Conditional Return instructions. There are also ladder coils that can only be placed on the left power
rail. These include the Label, Next, Load SCR, Conditional SCR End, and SCR End instructions. These
are shown in FBD as boxes and are distinguished with unlabeled power inputs and no outputs.

Compare Instructions

The compare instruction is executed regardless of the state of power flow. If power flow is false, the output
is false. If power flow is true, the output is set depending upon the result of the compare. SIMATIC FBD,
IEC Ladder, and IEC FBD compare instructions are shown as boxes, although the operation is performed
as a contact.
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Using Wizards To Help You Create Your Control Program

STEP 7-Micro/WIN provides wizards to make aspects of your programming easier and more automatic. In
Chapter 6, instructions that have an associated wizard are identified by the following Instruction Wizard

icon: @

Instruction
Wizard

Handling Errors in the S7-200

The S7-200 classifies errors as either fatal errors or non-fatal errors. You can view the error codes that
were generated by an error by selecting the PLC > Information menu command.

Figure 5-6 shows the PLC Information dialog box e |
that displays the error code and the description T [etoR
Of the error. —Wersian: Scan Rates [mg]

PLE: [ CPUZEMPAELDLD |  Last o
The Last Fatal field shows the previous fatal error | | ¢ e T @@ | | v o
code generated by the S7-200. This value is A5IC: [ mm | | Meim o
retained over power cycles if the RAM is
retained. This location is cleared either whenever ':;‘I_ R T
all memory of the S7-200 is cleared or if the RAM NUH_'FGGI (5 Nomniaderos pﬁ;em_
is not retained after a prolonged power outage.
The Total Fatal field is the count of fatal errors LastFatal [0 ofard enors present.
generated by the S7-200 since the last time the Total Fetel [
S7-200 had all memory areas cleared. This value = qeu
is retained over power cycles if the RAM is Number of Errors: o
retained. This location is cleared whenever all Erors Reported JNo 17D ertors present. =
memory of the S7-200 is cleared, or when the
RAM is not retained after a prolonged power Module | Type In_|Stet | Out]Stat | Status
Outage. C 24 10.0 16 000 0 f

1 Mot present
Appendix C lists the S7-200 error codes, and : it
A_ppend_lx D describes the spemgl memory (SM) : het bl
bits, which can be used for monitoring errors. & Mot present

ERd ifarmation | Reset Scan Rates |

Figure5-6  PLC Information Dialog Box
Non-Fatal Errors

Non-fatal errors are those indicating problems with the construction of the user program, with the
execution of an instruction in the user program, and with expansion 1/0O modules. You can use

STEP 7-Micro/WIN to view the error codes that were generated by the non-fatal error. There are three
basic categories of non-fatal errors.

Program-compile errors

The S7-200 compiles the program as it downloads. If the S7-200 detects that the program violates a
compilation rule, the download is aborted and an error code is generated. (A program that was already
downloaded to the S7-200 would still exist in the EEPROM and would not be lost.) After you correct your
program, you can download it again. Refer to Appendix C for a list of compile rule violations.
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I/O errors

At startup, the S7-200 reads the 1/O configuration from each module. During normal operation, the S7-200
periodically checks the status of each module and compares it against the configuration obtained during
startup. If the S7-200 detects a difference, the S7-200 sets the configuration error bit in the module error
register. The S7-200 does not read input data from or write output data to that module until the module
configuration again matches the one obtained at startup.

The module status information is stored in special memory (SM) bits. Your program can monitor and
evaluate these bits. Refer to Appendix D for more information about the SM bits used for reporting I/O
errors. SM5.0 is the global I/O error bit and remains set while an error condition exists on an expansion
module.

Program execution errors

Your program can create error conditions while being executed. These errors can result from improper use
of an instruction or from the processing of invalid data by an instruction. For example, an indirect-address
pointer that was valid when the program compiled could be modified during the execution of the program
to point to an out-of-range address. This is an example of a run-time programming problem. SM4.3 is set
upon the occurrence of a run-time programming problem and remains set while the S7-200 is in RUN
mode. (Refer to Appendix C for the list of run-time programming problems). Program execution error
information is stored in special memory (SM) bits. Your program can monitor and evaluate these bits.
Refer to Appendix D for more information about the SM bits used for reporting program execution errors.

The S7-200 does not change to STOP mode when it detects a non-fatal error. It only logs the event in SM
memory and continues with the execution of your program. However, you can design your program to
force the S7-200 to STOP mode when a non-fatal error is detected. The following sample program shows
a network of a program that is monitoring two of the global non-fatal error bits and changes the S7-200 to
STOP whenever either of these bits turns on.

Sample Program: Logic for Detecting a Non-Fatal Error Condition

Metwork 1 Network 1 /IWhen an 1/O error or a run-time error occurs, go to STOP mode
Sh5.0 LD SM5.0
STOF) o] SM4.3
STOP
Shid.3

Fatal Errors

Fatal errors cause the S7-200 to stop the execution of your program. Depending upon the severity of the
fatal error, it can render the S7-200 incapable of performing any or all functions. The objective for handling
fatal errors is to bring the S7-200 to a safe state from which the S7-200 can respond to interrogations
about the existing error conditions. When a fatal error is detected, the S7-200 changes to STOP mode,
turns on the System Fault LED and the STOP LED, overrides the output table, and turns off the outputs.
The S7-200 remains in this condition until the fatal error condition is corrected.

Once you have made the changes to correct the fatal error condition, use one of the following methods to
restart the S7-200:

1 Turn the power off and then on.
1 Change the mode switch from RUN or TERM to STOP.

1 Selectthe PLC > Power-Up Reset menu command from STEP 7—Micro/WIN to restart the S7-200.
This forces the S7-200 to restart and clear any fatal errors.

Restarting the S7-200 clears the fatal error condition and performs power-up diagnostic testing to verify
that the fatal error has been corrected. If another fatal error condition is found, the S7-200 again sets the
fault LED, indicating that an error still exists. Otherwise, the S7-200 begins normal operation.

Some error conditions can render the S7-200 incapable of communication. In these cases, you cannot
view the error code from the S7-200. These types of errors indicate hardware failures that require the
S7-200 to be repaired; they cannot be fixed by changes to the program or clearing the memory of the
S7-200.
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Assigning Addresses and Initial Values in the Data Block Editor

Data
Block

The data block editor allows you to make initial data assignments to V memory (variable memory) only.
You can make assignments to bytes, words, or double words of V memory. Comments are optional.

The data block editor is a free-form text editor;
that is, no specific fields are defined for particular

types of information. After you finish typing a line ot
. m Lau ST s o kul s e Tellas o e oroom
and press the Enter key, the data block editor o Pk b Loy o ]l ey fy oy L e g 2
formats the line (aligns columns of addresses, S Fiom I RTINSO T W
data, comments; capitalizes V memory I o . il EE O — i
addresses) and redisplays it. The data block ,:._,__"'—“_' L T
editor assigns an appropriatc_e amount of V i o imformig el oy Ly B
memory based on your previous address e eSS R ORR ST ORI O . o
»IE

allocations and the size (byte, word, or double
word) of the data value(s).

:

Figure 5-7  Data Block Editor

The first line of the data block must have an explicit address assignment. Subsequent lines can have
explicit or implicit address assignments. An implicit address assignment is made by the editor when you
type multiple data values after a single address assignment, or type a line that contains only data values.

The data block editor accepts uppercase or lowercase letters and allows commas, tabs, or spaces to
serve as separators between addresses and data values.

Using the Symbol Table for Symbolic Addressing of Variables

.E

Symbol
Table

58

The symbol table allows you to define and edit the symbols that can be accessed by the symbolic name

anywhere in your program. You can create multiple symbol tables. There is also a tab in the symbol table
for system-defined symbols that you can use in your program. The symbol table is also referred to as the
global variable table.

You can identify the operands of the instructions in your program absolutely or symbolically. An absolute
reference uses the memory area and bit or byte location to identify the address. A symbolic reference
uses a combination of alphanumeric characters to identify the address.

For SIMATIC programs, you make global symbol —_— e =
assignments by using the symbol table. For IEC 7575 b T e
programs, you make global symbol assignments |3 ) [AhwapsOn SMO0  [Alwaps on contact
by using the global variable table. H bl Pump! 23 Purp 1 on/off
3 Q Pump1 Limit 1.1 Pump 1 preszure limit switch
H . 4 1 |PumplPressure VD100 Furmp 1 current pressure [real)
To assign a Symb0| to an address: 5 <1 |PumplFpm w200 Purnp1 PRMs [integer]
[
1. Click on the Symbol Table icon in the '
navigation bar to open the symbol table. Figure5-8  Symbol Table

2. Enter the symbol name (for example, Inputl) in the Symbol Name column. The maximum symbol
length is 23 characters.

Enter the address (for example, 10.0) in the Address column.

4. For an IEC global variable table, enter a value in the Data Type column or select one from the
listbox.

You can create multiple symbol tables; however, you cannot use the same string more than once as a
global symbol assignment, neither within a single table nor among several tables.
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Using Local Variables

You can use the local variable table of the
program editor to assign variables that are
unique to an individual subroutine or interrupt
routine. See Figure 5-9.

Local variables can be used as parameters that
are passe(_i_ln to a subroutine and t_hey increase 2 s ]~ S—
the portability or reuse of a subroutine. - TRl [Fornsm ]

Figure 5-9  Local Variable Table

Using the Status Chart to Monitor Your Program

Status
Chart

%

A status chart allows you to monitor or modify the values of the process variables as your S7-200 runs the
control program. You can track the status of program inputs, outputs, or variables by displaying the current
values. The status chart also allows you to force or change the values of the process variables.

You can create multiple status charts in order to view elements from different portions of your program.

To access the status chart, select the View > Component > Status Chart menu command or click the
Status Chart icon in the navigation bar.

When you create a status chart, you enter
addresses of process variables for monitoring.
You cannot view the status of constants,
accumulators, or local variables. You can display
a timer or counter value either as a bit or as a
word. Displaying the value as a bit shows the
status of the timer or counter bit; displaying the
value as a word shows the timer or counter
value. Figure 5-10 Status Chart

To build a status chart and monitor the variables:
1. Enter the address for each desired value in the Address field.
2. Select the data type in the Format column.

3. To view the status of the process variables in your S7-200, select the Debug > Chart Status menu
command.

4. To continuously sample the values, or to perform a single read of the status, click the button on the
toolbar. The Status Chart also allows you to modify or force values for the different process
variables.

You can insert additional rows in your Status Chart by selecting the Edit > Insert > Row menu command.
Tip

You can create multiple status charts to divide the variables into logical groups so that each group can
be viewed in a shorter and separate status chart.

59



S7-200 Programmable Controller System Manual

Creating an Instruction Library

STEP 7-Micro/WIN allows you either to create a custom library of instructions, or to use a library created
by someone else. See Figure 5-11.

To create a library of instructions, you create standard STEP 7—Micro/WIN subroutine and interrupt
routines and group them together. You can hide the code in these routines to prevent accidental changes
or to protect the technology (know-how) of the author.

To create an instruction library, perform the following tasks: E.me'm
£l BitLoge
1. Write the program as a standard STEP 7—Micro/WIN - i Choh
project and put the function to be included in the B T
library into subroutines or interrupt routines. #-#@ Comed|  |nstruction Library
2. Ensure that all V memory locations in the subroutines il

or interrupt routines have been assigned a symbolic
name. To minimize the amount of V memory that the
library requires, use sequential V memory locations.

3. Rename the subroutines or interrupt routines to the
names that you want to appear in the instruction

library.
4. Select the File > Create Library menu command to
compile the new instruction library.
I i scslrg 1)
For more information about creating libraries, refer to the ! g Scwle | 1o A
online help for STEP 7—Micro/WIN. I !—CI:I' E.:ﬁ__H_J:LII '

Use the following procedure to access an instruction in an

instruction library: Figure 5-11 Instruction Tree with Libraries

1. Add the Libraries directory to the instruction tree by selecting the File > Add Libraries menu
command.

2. Select the specific instruction and insert it into your program (as you would any standard
instruction).

If the library routine requires any V memory, STEP 7—Micro/WIN prompts you when the project is
compiled to assign a block of memory. Use the Library Memory Allocation dialog box to assign
blocks of memory.

Features for Debugging Your Program

STEP 7-Micro/WIN provides the following features to help you debug your program:

(1 Bookmarks in your program to make it easy to move back and forth between lines of a long
program.

(1 Cross Reference table allow you to check the references used in your program.

1 RUN-mode editing allows you to make small changes to your program with minimal disturbance to
the process controlled by the program. You can also download the program block when you are
editing in RUN mode.

For more information about debugging your program, refer to|Chapter 8.
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This chapter describes the SIMATIC and IEC 1131 instruction set for the S7-200 Micro PLCs.
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Chapter 6

Conventions Used to Describe the Instructions

Figure 6-1 shows a typical description for an instruction and points to the different areas used to describe
the instruction and its operation. The illustration of the instruction shows the format in LAD, FBD, and STL.
The operand table lists the operands for the instruction and shows the valid data types, memory areas

and sizes for each operand.

EN/ENO operands and data types are not shown in the instruction operand table because the operands
are the same for all LAD and FBD instructions.

(1 For LAD: EN and ENO are power flow and are BOOL data types.

(1 ForFBD:ENand ENO arel, Q, V, M, SM, S, T, C, L, or power flow and are BOOL data types.

Description of the instruction
and operands

I STL instruction LAD and FBD instructions
|

Trans mit and Receive Instructions

The Transinit instuction (XMT) is used in Freeport mode \r transmit

AWHIE ¢ k1T )

List of the error conditions
that affect ENO and any SM
bits affected

data by means of the commurication poH]s).

the Receive hox to operste. Messages received through the
specified port (PORT) are stored in the dats buffer (TEL). The fir\
aritry it the dats buffer specifies the number of bytes received.

instruction

setENO =10
uOEMERE or FMIFEG ermor kit et (RCY parameter etror)

u 0005 (indirect address)

m Q00d (simuitaneons XMTIRCY an part 0]
= O00E (siMUitaneous HMTRCY on port 1) 5L T T G
m E7-Ei CPU Nt in Fresport mode kX TEL.FUE™

Table 611 “alid Operands for the Transmit and Feceive Instructions

InpuisAtputs Daka Type opemnis
TEL BYTE %E, I, OB, MEB, 36, SME, *vD, “AC, *LD
/PDHT ZvTE Congnt v GOGAS GOVE, GO 2N [
Ffor CRUAN and SRGANEXM: o oord
Operands for the [

Using Pzeeport Mode to Control/he Serial Communication Port
\"01 Zan select the Freeport mode to/zorrol the serial cormmunication port of the ST-200 by means of the

When you select Fri/zport mode, your prograr controls the operamon of the cormmunication
the use ofthe receive riterrupts, the transtnit intzrupts, the Transmit instuction, and the

Valid data types pruction. The cotmrmy/iceation protocaol is entirely cortrolled by the ladder program while in

de. SME20 (for por/ ) and SMEB 120 (for port 1||f your 87-200 has two ports) are used 1o

i e-gatablished (for example, programming
Valid memory areas and sizes for L using only the Transenit GCVIT)

the operands ¥, o weighing scale, and a welder. In
is usad by the device with which the

Freepatt cormimunication is possible ably when the S7-200 is in the RUN raode. Enable the Freeport made
by setting & value of 01 ik the protocol select field of SMES0 (Port 0) or SME 130 (Port 1. While in Freeport
rode, cotrrmunication with the pro ity device is not possible.

Tip

@ Erteting Freeport mode can be controlled wsing special memory bit SM0.7, which reflects the current
position of the operating mode switch, When SMO.T is equal to 0, the switch is in TERM position; when
SMO.7 = 1, the opersting mode switch is in BUN position. i you ehable Freeport mode ohly whenh the
switch is in RUN position, you can use the programmming device to monitor o control the 57-200
aperation by changing the switch to any other position .

Figure 6-1 Instruction Descriptions
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S7-200 Memory Ranges and Features

Table 6-1 Memory Ranges and Features for the S7-200 CPUs
Description CPU 221 CPU 222 CPU 224 CPU 226 CPU 226XM
User program size 2 Kwords 2 Kwords 4 Kwords 4 Kwords 8 Kwords
User data size 1 Kwords 1 Kwords 2.5 Kwords 2.5 Kwords 5 Kwords
Process-image input register 10.0to 115.7 10.0to 115.7 10.0to 115.7 10.0to 115.7 10.0to 115.7
Process-image output register Q0.0 to Q15.7 Q0.0to Q15.7 Q0.0to Q15.7 Q0.0to Q15.7 Q0.0to Q15.7
Analog inputs (read only) — AIWO0 to AIW30 AIWO0 to AIW62 AIWO0 to AIW62 AIWO0 to AIW62
Analog outputs (write only) — AQWO to AQW30 AQWO to AQW62 AQWO to AQW62 AQWO to AQW62
Variable memory (V) VBO to VB2047 VBO to VB2047 VBO to VB5119 VBO to VB5119 VBO to VB10239
Local memory (L)1 LBO to LB63 LBO to LB63 LBO to LB63 LBO to LB63 LBO to LB63
Bit memory (M) MO0.0 to M31.7 MO0.0 to M31.7 MO0.0 to M31.7 MO0.0 to M31.7 MO0.0 to M31.7
Special Memory (SM) SMO0.0 to SM179.7 SMO0.0 to SM299.7 SMO0.0 to SM549.7 SMO0.0 to SM549.7 SMO0.0 to SM549.7
Read only SMO0.0 to SM29.7 SMO0.0 to SM29.7 SMO0.0 to SM29.7 SMO0.0 to SM29.7 SMO0.0 to SM29.7
Timers 256 (TO to T255) 256 (TO to T255) 256 (TO to T255) 256 (TO to T255) 256 (TO to T255)
Retentive on-delay 1ms TO, T64 TO, T64 TO, T64 TO, T64 TO, T64
10 ms T1to T4, and T1to T4, and T1to T4, and T1to T4, and T1to T4, and
T65 to T68 T65 to T68 T65 to T68 T65 to T68 T65 to T68
100 ms T5to T31, and T5to T31, and T5to T31, and T5to T31, and T5to T31, and
T69 to T95 T69 to T95 T69 to T95 T69 to T95 T69 to T95
On/Off delay 1ms T32, T96 T32, T96 T32, T96 T32, T96 T32, T96
10 ms T33to T36, and T33to T36, and T33to T36, and T33to T36, and T33to T36, and
T97 to T100 T97 to T100 T97 to T100 T97 to T100 T97 to T100
100 ms T37to T63, and T37to T63, and T37to T63, and T37to T63, and T37to T63, and
T101 to T255 T101 to T255 T101 to T255 T101 to T255 T101 to T255
Counters CO0 to C255 CO0 to C255 CO0 to C255 CO0 to C255 CO0 to C255
High-speed counters HCO, HC3, HC4, HCO, HC3, HC4, HCO to HC5 HCO to HC5 HCO to HC5
and HC5 and HC5
Sequential control relays (S) S0.0 to S31.7 S0.0 to S31.7 S0.0 to S31.7 S0.0 to S31.7 S0.0to S31.7
Accumulator registers ACO to AC3 ACO to AC3 ACO to AC3 ACO to AC3 ACO to AC3
Jumps/Labels 0to 255 0to 255 0to 255 0to 255 0to 255
Call/Subroutine 0to 63 0to 63 0to 63 0to 63 0to 127
Interrupt routines Oto 127 Oto 127 Oto 127 Oto 127 Oto 127
Positive/negative transitions 256 256 256 256 256
PID loops Oto7 Oto7 Oto7 Oto7 Oto7
Ports Port 0 Port 0 Port 0 Port 0, Port 1 Port 0, Port 1

1 LB60 to LB63 are reserved by STEP 7—-Micro/WIN, version 3.0 or later.
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Table 6-2 Operand Ranges for the S7-200 CPUs
Access Method CPU 221 CPU 222 CPU 224, CPU 226 CPU 226XM
Bit access (byte.bit) | 0.0to 15.7 0.0to 15.7 0.0to 15.7 0.0to 15.7
Q 0.0to 15.7 0.0to 15.7 0.0to 15.7 0.0to 15.7
\Y 0.0 to 2047.7 0.0 to 2047.7 0.0 to 5119.7 0.0 to 10239.7
M 0.0to 31.7 0.0to 31.7 0.0to 31.7 0.0to 31.7
SM 0.0to 179.7 0.0 to 299.7 0.0 to 549.7 0.0 to 549.7
S 0.0to 31.7 0.0to 31.7 0.0to 31.7 0.0to 31.7
T 0 to 255 0to 255 0 to 255 0to 255
C 0to 255 0to 255 0to 255 0to 255
L 0.0to 59.7 0.0to 59.7 0.0to 59.7 0.0to 59.7
Byte access 1B 0to 15 0to 15 0to 15 0to 15
QB Oto 15 Oto 15 O0to 15 Oto 15
VB 0 to 2047 0 to 2047 0to 5119 0 to 10239
MB Oto 31 Oto 31 Oto 31 Oto 31
SMB Oto 179 0 to 299 0 to 549 0 to 549
SB Oto 31 Oto 31 Oto 31 Oto 31
L 0to 63 0to 63 0to 63 0to 255
AC Oto3 Oto3 Oto3 0to 255
Word access \W Oto 14 Oto 14 Oto 14 Oto 14
Qw Oto 14 Oto 14 Oto 14 Oto 14
VW 0 to 2046 0 to 2046 0to 5118 0 to 10238
MW 0to 30 0to 30 0to 30 0to 30
SMW Oto 178 0to 298 0 to 548 0 to 548
Sw 0to 30 0to 30 0to 30 0to 30
T 0 to 255 0to 255 0to 255 0to 255
C 0to 255 0to 255 0to 255 0 to 255
LW 0to 58 0to 58 0to 58 0to 58
AC Oto3 Oto3 Oto3 Oto3
AW None 0to 30 0to 62 0to 62
AQW None 0to 30 0to 62 0to 62
Double word access ID Oto 12 Oto 12 Oto 12 Oto 12
QD Oto 12 Oto 12 Oto 12 Oto 12
VD 0 to 2044 0 to 2044 0to 5116 0 to 10236
MD 0to 28 Oto 28 Oto 28 0to 28
SMD Oto 176 0 to 296 0 to 546 0 to 546
SD 0to 28 0to 28 0to 28 0to 28
LD 0to 56 0to 56 0to 56 0to 56
AC Oto3 Oto3 Oto3 Oto3
HC 0,3,4,5 0,3,4,5 Oto5 Oto5
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Bit Logic Instructions

Contacts
Standard Contacts p— |Ec1131]
The Normally Open contact instructions (LD, A, and O) and
Normally Closed contact instructions (LDN, AN, ON) obtain the Ll b

referenced value from the memory or from the process-image
register. The standard contact instructions obtain the referenced
value from the memory (or process-image register if the data type is

lor Q).

=
=

1000000,

=
=

The Normally Open contact is closed (on) when the bit is equal to 1,
and the Normally Closed contact is closed (on) when the bit is equal
to 0. In FBD, inputs to both the And and Or boxes can be expanded
to a maximum of 32 inputs. In STL, the Normally Open instructions

4+
47+
{1t
Load, AND, or OR the bit value of the address bit to the top of the ail=
fort
s
4w

=
=

stack, and the Normally Closed instructions Load, AND, or OR the
logical NOT of the bit value to the top of the stack.

Immediate Contacts

An immediate contact does not rely on the S7-200 scan cycle to
update; it updates immediately. The Normally Open Immediate
contact instructions (LDI, Al, and Ol) and Normally Closed
Immediate contact instructions (LDNI, ANI, and ONI) obtain the
physical input value when the instruction is executed, but the

process-image register is not updated.

The Normally Open Immediate contact is closed (on) when the SIMATIE l
physical input point (bit) is 1, and the Normally Closed Immediate oTL
contact is close(_j (on) V\_/hen _the physical input point (bit) is 0. The LD Eit Lol Eit
Normally Open instructions immediately Load, AND, or OR the A Bit Al Eit
physical input value to the top of the stack, and the Normally Closed @ Er ol Bt
instructions immediately Load, AND, or OR the logical NOT of the 'ﬁﬁ” g:: 'ﬁﬁi‘" g::
value of the physical input point to the top of the stack. oM Eit oMl Eit

. HoT
NOT Instruction EL

28]

The Not instruction (NOT) changes the state of power flow input

(that is, it changes the value on the top of the stack from 0 to 1 or
from 1 to 0).

Positive and Negative Transition Instructions

The Positive Transition contact instruction (EU) allows power to flow for one scan for each off-to-on
transition. The Negative Transition contact instruction (ED) allows power to flow for one scan for each
on-to-off transition. For the Positive Transition instruction, detection of a 0-to-1 transition in the value on
the top of the stack sets the top of the stack value to 1; otherwise, it is set to 0. For a Negative Transition
instruction, detection of a 1-to-0 transition in the value on the top of the stack sets the top of the stack
value to 1; otherwise, it is set to 0.

For run-time editing (when you edit your program in RUN mode), you must enter a parameter for the
Positive Transition and Negative Transition instructions. Refer to Chapter 5 for more information about
editing in RUN mode.

Table 6-3 Valid Operands for the Bit Logic Input Instructions

Inputs/Outputs Data Type Operands
Bit BOOL ,Q,V,M, SM, S, T, C, L, Power Flow
Bit (immediate) BOOL |
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¥

Tip
Because the Positive Transition and Negative Transition instructions require an on-to-off or an off-to-on

transition, you cannot detect an edge-up or edge-down transition on the first scan. During the first scan,

the S7-200 sets the state of the bit specified by these instructions. On subsequent scans, these
instructions can then detect transitions for the specified bit.

Example: Contact Instructions
Network 1 Network 1 //N.O. contacts 10.0 AND 10.1 must be on (closed) to activate
00 01 ano //Q0.0. The NOT instruction acts as an inverter.
_| ' | | ' ' ) /lIn RUN mode, Q0.0 and Q0.1 have opposite logic states.
LD 10.0
Qi é I((Q)blo
T ) nor
= Q0.1
Network 2 Network 2 //N.O. contact 10.2 must be on or N.C. contact 10.3 must be off
wor /Ito activate Q0.2. One or more parallel LAD branches
0.2 Qn.2 JI(OR logic inputs) must be true to make the output active.
_| ) LD 10.2
ON 10.3
I0.3 = Q0.2
_| ! Network 3 //A positive Edge Up input on a P contact or a hegative Edge
/[Down input on a N contact outputs a pulse with a 1 scan cycle
/lduration. In RUN mode, the pulsed state changes of Q0.4 and
Network 3 //Q0.5 are too fast to be visible in program status view.
04 oo s /IThe Set and Reset outputs latch the pulse in Q0.3 and
: : = l__( 5 ) /Imake the state change visible in program status view.
1 LD 10.4
Qo4 LPS
~ ) EU
S Q0.3,1
Qn.3 iPP Q0.4
— v R) ED
1 R Q03,1
Q0.5 = Q0.5
Timing Diagram Network 1
oo I ]
o [ I -
aon —I—
oo —I—
Network 2
ez [ — .
o3 [ ] —
oz | L] L
Network 3

uu:—j—i

n.q .On o Orm =can

(=] 3

i =:On ol Om xmn
[=: L] IT'r
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Coils
Output SIMATIC / |Ec1131]
The Output instruction (=) writes the new value for the output bit to
the process-image register. When the Output instruction is LAD Gi Gi FED
executed, the S7-200 turns the output bit in the process-image it L
register on or off. For LAD and FBD, the specified bit is set equal to _( :I —|I|
power flow. For STL, the value on the top of the stack is copied to it it
the Specified b|t _( ::: :l —|III|
Output Immediate it it
1
The Output Immediate instruction (=I) writes the new value to both _( g ] ] g
the physical output and the corresponding process-image register M g L :
location when the instruction is executed. it Eit
. 51

When the Output Immediate instruction is executed, the physical _( sl :l -
output point (Bit) is immediately set equal to power flow. For STL, N Bit
the instruction immediately copies the value on the top of the stack el | R
to the specified physical output bit (STL). The “I” indicates an _( R :| dn
immediate reference; the new value is written to both the physical i Bit
output and the corresponding process-image register location when Bit ] ™
the instruction is executed. This differs from the non-immediate —|I RI :I dn
references, which write the new value to the process-image register M
only.
Set and Reset SIMATIC ]
The Set (S) and Reset (R) instructions set (turn on) or reset (turn off) e
the specified number of points (N), starting at the specified address = Eit =1 Eit
(Bit). You can set or reset from 1 to 255 points. g EI: m g% gu: m

L L%
If the Reset instruction specifies either a timer bit (T) or counter bit

(C), the instruction resets the timer or counter bit and clears the
current value of the timer or counter.

Error conditions that set ENO =0
m 0006 (indirect address)
= 0091 (operand out of range)

Set Immediate and Reset Immediate

The Set Immediate and Reset Immediate instructions immediately set (turn on) or immediately reset (turn
off) the number of points (N), starting at specified address (Bit). You can set or reset from 1 to 128 points
immediately.

The “I” indicates an immediate reference; when the instruction is executed, the new value is written to
both the physical output point and the corresponding process-image register location. This differs from
the non-immediate references, which write the new value to the process-image register only.

Error conditions that set ENO =0
m 0006 (indirect address)

= 0091 (operand out of range)

Table 6-4 Valid Operands for the Bit Logic Output Instructions

Inputs/Outputs Data Type Operands

Bit BOOL ,Q,V,M,SM, S, T,C, L

Bit (immediate) BOOL Q

N BYTE 1B, QB, VB, MB, SMB, SB, LB, AC, *VD, *LD, *AC, Constant
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Example: Coil Instructions

Network 1 Network 1 //Output instructions assign bit values to external /0 (I, Q)
00 Qoo /land internal memory (M, SM, T, C, V, S, L).
_| ) LD 10.0
= Q0.0
Qo1 = Q0.1
) = V0.0
Network 2 //Set a sequential group of 6 bits to a value of 1.
Voo //Specify a starting bit address and how many bits to set.
' ) /[The program status indicator for Set is ON when the value
[lof the first bit (Q0.2) is 1.
LD 10.1
S Q0.2,6
Network 2
101 Q0 2 Network 3  //Reset a sequential group of 6 bits to a value of 0.
‘ S. //Specify a starting bit address and how many bits to reset.
_| | ( ) /[The program status indicator for Reset is ON when the value
6 //of the first bit (Q0.2) is 0.
LD 10.2
Network 3 R Q0.2, 6
0.2 02'2 Network 4  //Sets and resets 8 output bits (Q1.0 to Q1.7) as a group.
— = . ) LD 103
LPS
A 10.4
Hetwork 4 S Q1.0,8
0.3 0.4 Q1.0 LPP
_| |_( 5) A 10.5
g R Q1.0,8
0.5 Q1o Network 5  //The Set and Reset instructions perform the function of a latched relay.
|_( = ) /[To isolate the Set/Reset bits, make sure they are not overwritten by
g /lanother assignment instruction. In this example, Network 4 sets and
IIresets eight output bits (Q1.0 to Q1.7) as a group.
Network 5 /lIn RUN mode, Network 5 can overwrite the Q1.0 bit value and
06 010 /Icontrol the Set/Reset program status indicators in Network 4.
— — ) LD 106
= QL0
Timing Diagram Mubarrk ©
oo I I
aog ao.) Yoo 1
Mubscrz Zund 3
o e 1 1
0z |Fmsl) : 1 ™
: :
Faml lo0ovw'+iima 5l |o !, mcywow hepiogiam . -
=n waciss e Me+oik I Fmos dis Ilm Mabt-ok 2 :
Tl
Mubscriza 4 wnd 3
o | L
o e 1 1
LT TN 1 |
os I 1 ]
I R o N
T Ty L

Mul+ok 3 Juipul Bd =) imlivdon ovesi e The bal B3 o)

TullFassl n Mabeok i,

Mel+ok 3 axmpnmen| bl
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Logic Stack Instructions

AND Load SIMATIC
The AND Load instruction (ALD) combines the values in the first and
second levels of the stack using a logical AND operation. The result 5TL .
is loaded in the top of stack. After the ALD is executed, the stack oLD
depth is decreased by one. LFS

LRD
OR Load LPF
The OR Load instruction (OLD) combines the values in the first and EEEO M
second levels of the stack, using a logical OR operation. The result

is loaded in the top of the stack. After the OLD is executed, the stack
depth is decreased by one.

Logic Push

The Logic Push instruction (LPS) duplicates the top value on the stack and pushes this value onto the
stack. The bottom of the stack is pushed off and lost.

Logic Read

The Logic Read instruction (LRD) copies the second stack value to the top of stack. The stack is not
pushed or popped, but the old top-of-stack value is destroyed by the copy.

Logic Pop
The Logic Pop instruction (LPP) pops one value off of the stack. The second stack value becomes the
new top of stack value.

AND ENO

The AND ENO instruction (AENO) performs a logical AND of the ENO bit with the top of the stack to
generate the same effect as the ENO bit of a box in LAD or FBD. The result of the AND operation is the
new top of stack.

ENO is a Boolean output for boxes in LAD and FBD. If a box has power flow at the EN input and is
executed without error, the ENO output passes power flow to the next element. You can use the ENO as
an enable bit that indicates the successful completion of an instruction. The ENO bit is used with the top of
stack to affect power flow for execution of subsequent instructions. STL instructions do not have an EN
input. The top of the stack must be a logic 1 for conditional instructions to be executed. In STL there is
also no ENO output. However, the STL instructions that correspond to LAD and FBD instructions with
ENO outputs set a special ENO bit. This bit is accessible with the AENO instruction.

Load Stack

The Load Stack instruction (LDS) duplicates the stack bit (N) on the stack and places this value on top of
the stack. The bottom of the stack is pushed off and lost.

Table 6-5 Valid Operands for the Load Stack Instruction
Inputs/Outputs Data Type Operands

N BYTE Constant (0 to 8)
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As shown in Figure 6-2, the S7-200 uses a logic stack to resolve the control logic. In these examples, “iv0”

to “iv7” identify the initial values of the logic stack, “nv” identifies a new value provided by the instruction,
and “S0” identifies the calculated value that is stored in the logic stack.

ALD Before After OoLD Before After LDS Before After
AND the top Vo S0 ORthetoptwo | 0 S0 Load Stack | o iv3
two stack vl v2 stack values vl v2 vl \ Vo
values v2 / v3 v2 / v3 v2 \ vl
v3 / iv4 v3 / iv4 v3 \ v2
iv4 / V5 iv4 / V5 iv4 \ v3
V5 / V6 V5 / V6 V5 \ v
V6 / V7 V6 / V7 V6 \ V5
v7 / v8 v7 / v8 v7 \ iv6
SO=VOAND vl | iv8 / x1 S0 =iv0 OR ivl iv8 / x1 iv82 \ V7
LPS Before After LRD Before After LPP Before After
Logic Push VO vo | |Logic Read VO Vi Logic Pop [ ivo Vi
vl \ VO vl / vl vl / v2
v2 \ vl v2 v2 v2 / v3
v3 \ v2 V3 V3 V3 / iva
iva \ iv3 iv4 iv4 iv4 / V5
iv5 \ iva V5 V5 V5 / V6
V6 \ V5 V6 V6 V6 / V7
V7 \ iv6 V7 V7 V7 / v8
ivg2 \ V7 v8 iv8 v8 / x1

1 The value is unknown (it could be either a 0 or a 1).

2 After the execution of a Logic Push or a Load Stack instruction, value iv8 is lost.

Figure 6-2

Example: Logic Stack Instructions

Operations of the Logic Stack Instructions

Network 1
0.0 10.1
| | | |
I 1 |
2.0 12.1
| | | |
1 | 1 I
Metwork 2
10.0 0.5 Q7.0
| | | | { )
I 1 | A
0.6
] |
1 |
12.1 Q5.0
| | {
1 | Y )
11.3

Network 1
LD 10.0
LD 10.1
LD 12.0
A 12.1
OoLD

ALD

= Q5.0
Network 2
LD 10.0
LPS

LD 10.5
(0] 10.6
ALD

= Q7.0
LRD

LD 12.1
(0] 11.3
ALD

= Q6.0
LPP

A 11.0
= Q3.0
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Set and Reset Dominant Bistable Instructions

The Set Dominant Bistable is a latch where the set dominates. If the
set (S1) and reset (R) signals are both true, the output (OUT) is true.

The Reset Dominant Bistable is a latch where the reset dominates.
If the set (S) and reset (R1) signals are both true, the output (OUT)
is false.

The Bit parameter specifies the Boolean parameter that is set or
reset. The optional output reflects the signal state of the Bit
parameter.

Table 6-7 shows the truth tables for the sample program.

SIMATIC £ IEC 1131

LAD FED
Eit Eit

=51 OUTE | 51 CUT -
SR o L SR

o L
Eit Eit

=5 OUTE | A% CUT -
RS k1 RS

k1

Table 6-6 Valid Operands for the Set Dominant Bistable and Reset Dominant Bistable Instructions
Inputs/Outputs Data Types Operands

S1,R BOOL 1,Q,V, M, SM, S, T, C, Power Flow

S, R1, OUT BOOL ,Q,V,M, SM, S, T, C, L, Power Flow

Bit BOOL ,Q,V,M, S

Example: Set and Reset Dominant Bistable Instructions

Metwark 1 Timing Diagram
0.0 Qoo
— ——yg5 ou—j Set  10.0
SR
_|'U-1 y Reset 10.1 _|
SR Q0.0
Metwork 2
0o Qo1 RS Q0.1 4
— 7T o
RS
0.1
—

Table 6-7 Truth Table for the Set and Reset Dominant Bistable Instructions
Instruction S1 R Out (Bit)
Set Dominant Bistable instruction (SR) 0 0 Previous state
0 1 0
1 0 1
1 1 1
Instruction S R1 Out (Bit)
Reset Dominant Bistable instruction (RS) 0 0 Previous state
0 1 0
1 0 1
1 1 0
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Clock Instructions

Read ReaI'Tlme CIOCk and Set ReaI'Tlme CIOCk SIMATIC & IEC1131

%

The Read Real-Time Clock (TODR) instruction reads the current
time and date from the hardware clock and loads it in an 8-byte LAD FED
Time buffer starting at address T. The Set Real-Time Clock (TODW) RERD_RTC READ_RTC
instruction writes the current time and date to the hardware clock, - EM EMG = EM EMC =

beginning at the 8-byte Time buffer address specified by T. At alll

You must code all date and time values in BCD format (for example,
16#97 for the year 1997). Figure 6-3 shows the format of the Time READ_RTE SET_RTEC
buffer (T).

The time-of-day (TOD) clock initializes the following date and time S
after extended power outages or when memory has been lost:

STL

Date: 01-Jan-90 Topn 1
Time: 00:00:00

Day of Week: Sunday

Error conditions that set ENO =0
m 0006 (indirect address)

m 0007 (TOD data error) Set Real-Time Clock only
= 000C (clock not present)

Table 6-8 Valid Operands for the Clock Instructions
Inputs/Outputs Data Types Operands

T BYTE 1B, QB, VB, MB, SMB, SB, LB, *VD, *LD, *AC

T T+1 T+2 T+3 T+4 T+5 T+6 T+7

Year: Month: Day: Hours: Minutes: Seconds: 0 Day of Week:
00 to 99 01to 12 01 to 31 00 to 23 00 to 59 00 to 59 0to 7*

*T+7  1=Sunday, 7=Saturday
0 disables the day of week.

Figure 6-3 Format of the 8-Byte Time Buffer (T)

Tip
The S7-200 CPU does not perform a check to verify that the day of week is correct based upon the

date. Invalid dates, such as February 30, could be accepted. You should ensure that the date you enter
is correct.

Do not use the TODR/TODW instruction in both the main program and in an interrupt routine. A
TODR/TODW instruction in an interrupt routine that attempts to execute while another TODR/TODW
instruction is in process cannot be executed. SM4.3 is set indicating that two simultaneous accesses to
the clock were attempted (non-fatal error 0007).

The time-of-day clock in the S7-200 uses only the least significant two digits for the year, so for the year
2000, the year is represented as 00. The S7-200 PLC does not use the year information in any way.
However, user programs that use arithmetic or compares with the year’s value must take into account
the two-digit representation and the change in century.

Leap year is correctly handled through year 2096.
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Communications Instructions

Network Read and Network Write Instructions

&

Instruction
Wizard

74

The Network Read instruction (NETR) initiates a communications

; - i SIMATIC £ 1EC 1131
operation to gather data from a remote device through the specified

port (PORT), as defined by the table (TBL). The Network Write LAD: FED:
instruction (NETW) initiates a communications operation to write TR TR
data to a remote device through the specified port (PORT), as
defined by the table (TBL). B B o L
Error conditions that set ENO = 0: : ;n:B}IET T PeRT
m 0006 (indirect address)
m [f the function returns an error and sets the E bit of table status byte (see HETF: MET!

Figure 6-4)

. . . . SIMATIC

The Network Read instruction can read up to 16 bytes of information
from a remote station, and the Network Write instruction can write up <TL
to 16 bytes of information to a remote station. HEE\' %IE Egﬂ
You can have any number of Network Read and Network Write

instructions in the program, but only a maximum of eight Network
Read and Network Write instructions can be activated at any one
time. For example, you can have 4 Network Read and 4 Network
Write instructions, or 2 Network Read and 6 Network Write
instructions, active at the same time in a given S7-200.

You can use the Network Read/Network Write Instruction Wizard to configure the counter. To start the
Network Read/Network Write Instruction Wizard, select the Tools > Instruction Wizard menu command
and then select Network Read/Network Write from the Instruction Wizard window.

Table 6-9 Valid Operands for the Network Read and Network Write Instructions

Inputs/Outputs Data Type Operands
TBL BYTE VB, MB, *VD, *LD, *AC
PORT BYTE Constant for CPU 221, CPU 222, CPU 224: 0

for CPU 226 and CPU 226XM: Oorl
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Figure 6-4 describes the table that is referenced by the TBL parameter, and Table 6-10 lists the error
codes.

Byte D Done (function has been completed): 0 =not done 1 =done
Offset 7 0 A Active (function has been queued): 0=notactive 1=active
0 D|A|E] 0] Erorcode| E  Error (function retumed an error): 0 = no error 1 =error
1 Remote station address Remote station address: the address of the PLC whose data is to be accessed.
2 Pointer to the data . ) . L .
- Pointer to the data area in the remote station: an indirect pointer to the data that
3 area in the is to be accessed.
4 remote station
5 (1,Q, M, or V) Data length: the number of bytes of data that are to be accessed in the remote
6 Data length station (1 to 16 bytes).
7 Data byte 0 Receive or transmit data area. 1 to 16 bytes reserved for the data.
8 Data byte 1 For a Network Read instruction, stores the values that were read from the
: remote station when the instruction was executed.
22 Data byte 15 For a Network Write instruction, stores the values to be sent to the remote

station when the instruction is executed.

Figure 6-4 TBL Parameter for the Network Read and Network Write Instructions

Table 6-10  Error Codes for the TBL Parameter

Code Definition

0 No error.

Time-out error: Remote station not responding.

Receive error: Parity, framing, or checksum error in the response.

Offline error: Collisions caused by duplicate station addresses or failed hardware.

Queue overflow error: More than 8 Network Read or Network Write instructions have been activated.

a b~ W N P

Protocol violation: Attempt to execute a Network Read or Network Write instruction without enabling the PPI
Master Mode in SMB30 or SMB130.

lllegal parameter: TBL parameter contains an illegal or invalid value.
No resource: Remote station is busy. (An upload or a download sequence is in process.)

Layer 7 error: Application protocol violation

© 00 N o

Message error: Wrong data address or incorrect data length
A

—
o

F  Not used. (Reserved)

Figure 6-5 shows an example to illustrate the utility of the Network Read and Network Write instructions.
For this example, consider a production line where tubs of butter are being filled and sent to one of four
boxing machines (case packers). The case packer packs eight tubs of butter into a single cardboard box.
A diverter machine controls the flow of butter tubs to each of the case packers. Four S7-200s control the
case packers, and an S7-200 with a TD 200 operator interface controls the diverter.
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Case Packer #1 Case Packer #2 Case Packer #3 Case Packer #4 Diverter
Station 2 Station 3 Station 4 Station 5 Station 6 TD 200 Station 1
[ [ B == [ Ege
I I A [ = a_ 0o
1 ] ] [ ]
VB100 Control VB100 Control VB100 Control VB100 | Control VB200 Rev VB300 | Xmt
VW101 | Status VWI01 | Status VW101 | Status VW101 | Status Buffers Buffers
VB100 | f | e | e | e | 0 | g | b | 1 | Control VB200 Receive buffer VB300 Transmit buffer
S s Station 2 Station 2
tatus MSB
VB101 Number of VB210 Receive buffer VB310 Transmit buffer
-------------- Station 3 Station
VB102 cases packed VB220 Receive buffer VB320 Transmit buffer
— Station 4 Station 4
VB230 Receive buffer VB330 Transmit buffer
t  Outof butter tubs to pack; t=1, out of butter tubs Station 5 Station

b Box supply is low; b=1, must add boxes in the
next 30 minutes

g  Glue supply is low; g=1, must add glue in the next 30 minutes

eee error code identifying the type of fault experienced
f Fault indicator; f=1, the case packer has detected an error

Figure 6-5

Example of the Network Read and Network Write Instructions

Figure 6-6 shows the receive buffer (VB200) and transmit buffer (VB300) for accessing the data in
station 2. The S7-200 uses a Network Read instruction to read the control and status information on a
continuous basis from each of the case packers. Each time a case packer has packed 100 cases, the
diverter notes this and sends a message to clear the status word using a Network Write instruction.

Receive Buffer for reading from Case Packer #1

Transmit Buffer for clearing the count of Case Packer #1

7 0 7 0
vezo0 | D [A [ E [0 [ ErorCode vesoo | D [A [E [0 | ErorCode
VB201 Remote station address = 2 VB301 Remote station address = 2
VB202 Pointer to the VB302 Pointer to the
VB203 data area VB303 data area
VB204 in the VB304 in the
VB205 Remote station = (&VB100) VB305 Remote station = (&VB101)
VB206 Data length = 3 bytes VB306 Data length = 2 bytes
VB207 Control VB307 0
VB208 Status (MSB) VB308 0
VB209 Status (LSB)

Figure 6-6 Sample TBL Data for the Network Read/Write Example
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Example: Network Read and Network Write Instructions

Network 1
SMO.1 MOv_B
l
— | BN Enaf—
2 outhsmesn
FILLN
e Eno—Y
sodin outhuwwizoo
Baqn
Metwork 2
V2007 Wy208 MOY_B
l [
— | 1=='1 en Eno—)
+100
2 outhvesm
WOW_DW
EN  Enol—)
svB1014IN___ ouTkvD302
MOV_B
N Eno—y
N outhveaoe
WOV
e Eno— Y
w04 outhvwaer
NET
N Enol—)
vBa00{TEL
o{roRT
Network 3
v200.7 MOV_B
—1n  Eevop—y
vez07dIN___ ouThvedon

Network 1 /IOn the first scan, enable the PPl master mode
/and clear all receive and transmit buffers.

LD SMO0.1

MOVB 2, SMB30

FILL +0, VW200, 68

Network 2 //When the NETR Done bit (V200.7) is set
/land 100 cases have been packed:
/[1. Load the station address of case packer #1.
/12. Load a pointer to the data in the remote station.
/13. Load the length of data to be transmitted.
/4. Load the data to transmit.
/5. Reset the number of cases packed
/I by case packer #1

LD V200.7

AW= VW208, +100

MOVB  2,VB301

MOVD  &VB101, VD302

MOVB  2,VB306

MOVW  +0, VW307

NETW  VB300, 0

Network 3 /IWhen the NETR Done bit is set, save the control
/ldata from case packer #1.

LD V200.7

MOVB  VB207, VB400
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Example: Network Read and Network Write Instructions , continued

Network 4
Shi0.1

W200 6

W200.5

MOV_8

=i

78

[
o

]
1/

EM EMNO

I ouT

—

FvB201

MOY_DWvY

EWBE100+

EN ENO

1§ ouT

%

FvD202

MOv_8

EM EMO

1§ OuT

-

| v/B206

WE2004

METR
EM EMNO

TBL

PORT

Network 4

LDN
AN

AN
MOVB
MOVD
MOVB
NETR

/I not the first scan and there are no errors:

/[1. Load the station address of case packer #1.
/[2. Load a pointer to the data in the remote station.
//3. Load the length of data to be received.

/l4. Read the control and status data

/I in case packer #1.

SMO0.1

V200.6

V200.5
2,VB201
&VB100, VD202
3, VB206
VB200, 0
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Transmit and Receive Instructions (Freeport)

The Transmit instruction (XMT) is used in Freeport mode to transmit

. SIMATIC ¢ IEC 1131
data by means of the communications port(s).
The Receive instruction (RCV) initiates or terminates the receive LAD FED
message function. You must specify a start and an end condition for HMT HMT
the Receive box to operate. Messages received through the —EM EMZ = | EM EMC =
specified port (PORT) are stored in the data buffer (TBL). The first | TEL

. . . —{ TEL JPORT
entry in the data buffer specifies the number of bytes received. dporT
Error conditions that set ENO =0
m 0006 (indirect address) AT REY
= 0009 (simultaneous Transmit/Receive on port 0)

SIMATIC
= 000B (simultaneous Transmit/Receive on port 1)
i STL

®m Receive parameter error sets SM86.6 or SM186.6 WMT  TEL, PORT
m S7-200 CPU is not in Freeport mode RCY  TEL, PORT

Table 6-11  Valid Operands for the Transmit and Receive Instructions

Inputs/Outputs Data Type Operands
TBL BYTE 1B, QB, VB, MB, SMB, SB, *VD, *LD, *AC
PORT BYTE Constant for CPU 221, CPU 222, CPU 224: 0

for CPU 226 and CPU 226XM: Oorl

For more information about using Freeport mode, see the section Creating User-Defined Protocols with
Freeport Mode on page 222 in Chapter 7.

Using Freeport Mode to Control the Serial Communications Port

You can select the Freeport mode to control the serial communications port of the S7-200 by means of the
user program. When you select Freeport mode, your program controls the operation of the
communications port through the use of the receive interrupts, the transmit interrupts, the Transmit
instruction, and the Receive instruction. The communications protocol is entirely controlled by the ladder
program while in Freeport mode. SMB30 (for port 0) and SMB130 (for port 1 if your S7-200 has two ports)
are used to select the baud rate and parity.

The Freeport mode is disabled and normal communications are re-established (for example, programming
device access) when the S7-200 is in STOP mode.

In the simplest case, you can send a message to a printer or a display using only the Transmit (XMT)
instruction. Other examples include a connection to a bar code reader, a weighing scale, and a welder. In
each case, you must write your program to support the protocol that is used by the device with which the
S7-200 communicates while in Freeport mode.

Freeport communications are possible only when the S7-200 is in RUN mode. Enable the Freeport mode
by setting a value of 01 in the protocol select field of SMB30 (Port 0) or SMB130 (Port 1). While in Freeport
mode, communications with the programming device are not possible.

Tip
@ Freeport mode can be controlled using special memory bit SMO0.7, which reflects the current position of
the operating mode switch. When SMO0.7 is equal to 0, the switch is in TERM position; when SM0.7 = 1,
the operating mode switch is in RUN position. If you enable Freeport mode only when the switch is in
RUN position, you can use the programming device to monitor or control the S7-200 operation by
changing the switch to any other position.
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Changing PPI Communications to Freeport Mode

SMB30 and SMB130 configure the communications ports, 0 and 1 respectively, for Freeport operation and
provide selection of baud rate, parity, and number of data bits. Figure 6-7 describes the Freeport control
byte. One stop bit is generated for all configurations.

MSB LSB
! 9 bbb: Freeport baud rate
|P|P|d|b|b|b|m|m| 000= 38,400 baud
SMB30 = Port 0 001 i 19,200 baud
SMB130 = Port 1 010 = 9,600 baud
- 011= 4,800 baud
100 = 2,400 baud
pp: Parity select 101 = 1,200 baud .
00 = no parity 110 = 115.2 kbaudl 1 S7-200 CPUs version 1.2 or later
01= even parity 111 = 57.6 kbaud? support the 57.6 kbaud and
10= no parity mm: Protocol selection 115.2 kbaud rates.
1= odd parity 00 = PPI/slave mode
d: Data bits per character 01= Freeport protocol
0= 8 bits per character 10= PPI/master mode
1= 7 bits per character 11 = Reserved (defaults to PPI/slave mode)

Figure 6-7 SM Control Byte for Freeport Mode (SMB30 or SMB130)

Transmitting Data
The Transmit instruction lets you send a buffer of one or more characters, up to a maximum of 255.

Figure 6-8 shows the format of the Transmit
buffer.

CountM|E|S|S|A|G|E
) o ) ’ [ Characters of the message \
If an interrupt routine is attached to the transmit e __ 4
complete event, the S7-200 generates an

interrupt (interrupt event 9 for port 0 and interrupt
event 26 for port 1) after the last character of the
buffer is sent. Figure 6-8  Format for the Transmit Buffer

Number of bytes to transmit (byte field)

You can make transmissions without using interrupts (for example, sending a message to a printer) by
monitoring SM4.5 or SM4.6 to signal when transmission is complete.

You can use the Transmit instruction to generate a BREAK condition by setting the number of characters
to zero and then executing the Transmit instruction. This generates a BREAK condition on the line for
16-bit times at the current baud rate. Transmitting a BREAK is handled in the same manner as transmitting
any other message, in that a Transmit interrupt is generated when the BREAK is complete and SM4.5 or
SM4.6 signals the current status of the Transmit operation.

Receiving Data
The Receive instruction lets you receive a buffer of one or more characters, up to a maximum of 255.

End
Char

Figure 6-9 shows the format of the Receive count | Start

buffer. Char

]
. L . Characters of the message |
If an interrupt routine is attached to the receive L __ _ “haracersotthemessage

message complete event, the S7-200 generates
an interrupt (interrupt event 23 for port 0 and
interrupt event 24 for port 1) after the last
character of the buffer is received. Figure 6-9  Format for the Receive Buffer

J R RN

Number of bytes received (byte field)

You can receive messages without using interrupts by monitoring SMB86 (port 0) or SMB186 (port 1). This
byte is non-zero when the Receive instruction is inactive or has been terminated. It is zero when a receive
is in progress.
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As shown in Table 6-12, the Receive instruction allows you to select the message start and message end
conditions, using SMB86 through SMB94 for port 0 and SMB186 through SMB194 for port 1.

Tip

The receive message function is automatically terminated in case of an overrun or a parity error. You
must define a start condition and an end condition (maximum character count) for the receive message
function to operate.

Table 6-12  Bytes of the Receive Buffer (SMB86 to SMB94, and SM1B86 to SMB194)
Port 0 Port 1 Description
SMB86 SMB186 Receive message status byte M$B LgB
[nfrlefofoftfefe]
n: 1= Receive message function terminated: user issued disable command.
r 1= Receive message function terminated: error in input parameters
or missing start or end condition.
e 1= End character received.
t 1= Receive message function terminated: timer expired.
c 1= Receive message function terminated: maximum character count achieved.
p 1= Receive message function terminated: a parity error.
SMB87 SMB187 Receive message control byte M$B LgB
|en |sc |ec | il |c/m|tmr| bk| 0 |
en: 0 =Receive message function is disabled.
1 =Receive message function is enabled.
The enable/disable receive message bit is checked each time
the RCV instruction is executed.
sc: 0 =Ignore SMB88 or SMB188.
1 =Use the value of SMB88 or SMB188 to detect start of message.
ec: 0=Ignore SMB89 or SMB189.
1 =Use the value of SMB89 or SMB189 to detect end of message.
il: ~ 0=lgnore SMW90 or SMW190.
1 =Use the value of SMW90 or SMW190 to detect an idle line condition.
c/m: 0 =Timer is an inter-character timer.
1 =Timer is a message timer.
tmr: 0 =lgnore SMW92 or SMW192.
1 =Terminate receive if the time period in SMW92 or SMW192 is exceeded.
bk: 0 =Ignore break conditions.
1 =Use break condition as start of message detection.
SMB88 SMB188 Start of message character.
SMB89 SMB189 End of message character.
SMW90 SMW190 Idle line time period given in milliseconds. The first character received after idle line time
has expired is the start of a new message.
SMW92 SMW192 Inter-character/message timer time-out value given in milliseconds. If the time period is
exceeded, the receive message function is terminated.
SMB94 SMB194 Maximum number of characters to be received (1 to 255 bytes). This range must be set to

the expected maximum buffer size, even if the character count message termination is not
used.
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Start and End Conditions for the Receive Instruction

The Receive instruction uses the bits of the receive message control byte (SMB87 or SMB187) to define
the message start and end conditions.

Tip

If there is traffic present on the communications port from other devices when the Receive instruction is
executed, the receive message function could begin receiving a character in the middle of that
character, resulting in a possible parity error and termination of the receive message function. If parity is
not enabled the received message could contain incorrect characters. This situation can occur when the
start condition is specified to be a specific start character or any character, as described in item 2. and
item 6. below.

The Receive instruction supports several message start conditions. Specifying a start condition
involving a break or an idle line detection avoids this problem by forcing the receive message function to
synchronize the start of the message with the start of a character before placing characters into the
message buffer.

The Receive instruction supports several start conditions:

1. Idle line detection: The idle line condition is defined as a quiet or idle time on the transmission line.
A receive is started when the communications line has been quiet or idle for the number of
milliseconds specified in SMW90 or SMW190. When the Receive instruction in your program is
executed, the receive message function initiates a search for an idle line condition. If any characters
are received before the idle line time expires, the receive message function ignores those
characters and restarts the idle line timer with the time from SMW90 or SMW190. See Figure 6-10.
After the idle line time expires, the receive message function stores all subsequent characters
received in the message buffer.

The idle line time should always be greater than the time to transmit one character (start bit, data
bits, parity and stop bits) at the specified baud rate. A typical value for the idle line time is three
character times at the specified baud rate.

You use idle line detection as a start condition for binary protocols, protocols where there is not a
particular start character, or when the protocol specifies a minimum time between messages.

Setup: il=1, sc =0, bk =0, SMW90/SMW190 = idle line timeout in milliseconds

Characters Characters

[ N S A R

A

Restarts the idle time First character placed in the

message buffer
Receive instruction is executed: Idle time is detected:
starts the idle time starts the Receive Message function

Figure 6-10  Using Idle Time Detection to Start the Receive Instruction

2. Start character detection: The start character is any character which is used as the first character of
a message. A message is started when the start character specified in SMB88 or SMB188 is
received. The receive message function stores the start character in the receive buffer as the first
character of the message. The receive message function ignores any characters that are received
before the start character. The start character and all characters received after the start character
are stored in the message buffer.

Typically, you use start character detection for ASCII protocols in which all messages start with the
same character.

Setup: il=0, sc =1, bk =0, SMW90/SMW190 = don’t care, SMB88/SMB188 = start
character
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Idle line and start character: The Receive instruction can start a message with the combination of an
idle line and a start character. When the Receive instruction is executed, the receive message
function searches for an idle line condition. After finding the idle line condition, the receive message
function looks for the specified start character. If any character but the start character is received,
the receive message function restarts the search for an idle line condition. All characters received
before the idle line condition has been satisfied and before the start character has been received
are ignored. The start character is placed in the message buffer along with all subsequent
characters.

The idle line time should always be greater than the time to transmit one character (start bit, data
bits, parity and stop bits) at the specified baud rate. A typical value for the idle line time is three
character times at the specified baud rate.

Typically, you use this type of start condition when there is a protocol that specifies a minimum time
between messages, and the first character of the message is an address or something which
specifies a particular device. This is most useful when implementing a protocol where there are
multiple devices on the communications link. In this case the Receive instruction triggers an
interrupt only when a message is received for the specific address or devices specified by the start
character.

Setup: il=1, sc =1, bk =0, SMW90/SMW190 > 0, SMB88/SMB188 = start character

Break detection: A break is indicated when the received data is held to a zero value for a time
greater than a full character transmission time. A full character transmission time is defined as the
total time of the start, data, parity and stop bits. If the Receive instruction is configured to start a
message on receiving a break condition, any characters received after the break condition are
placed in the message buffer. Any characters received before the break condition are ignored.

Typically, you use break detection as a start condition only when a protocol requires it.
Setup: =0, sc =0, bk =1, SMW90/SMW190 = don’t care, SMB88/SMB188 = don't care

Break and a start character: The Receive instruction can be configured to start receiving characters
after receiving a break condition, and then a specific start character, in that sequence. After the
break condition, the receive message function looks for the specified start character. If any
character but the start character is received, the receive message function restarts the search for an
break condition. All characters received before the break condition has been satisfied and before
the start character has been received are ignored. The start character is placed in the message
buffer along with all subsequent characters.

Setup: i1=0, sc=1, bk =1, SMW90/SMW190 = don't care,
SMB88/SMB188 = start character

Any character: The Receive instruction can be configured to immediately start receiving any and all
characters and placing them in the message buffer. This is a special case of the idle line detection.
In this case the idle line time (SMW90 or SMW190) is set to zero. This forces the Receive
instruction to begin receiving characters immediately upon execution.

Setup: il=1, sc =0, bk =0, SMW90/SMW190 = 0, SMB88/SMB188 = don't care

Starting a message on any character allows the message timer to be used to time out the receiving
of a message. This is useful in cases where Freeport is used to implement the master or host
portion of a protocol and there is a need to time out if no response is received from a slave device
within a specified amount of time. The message timer starts when the Receive instruction executes
because the idle line time was set to zero. The message timer times out and terminates the receive
message function if no other end condition is satisfied.

Setup: il=1, sc =0, bk =0, SMW90/SMW190 = 0, SMB88/SMB188 = don't care
c¢/m =1, tmr =1, SMW92 = message timeout in milliseconds
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The Receive instruction supports several ways to terminate a message. The message can be terminated
on one or a combination of the following:

1. End character detection: The end character is any character which is used to denote the end of the
message. After finding the start condition, the Receive instruction checks each character received
to see if it matches the end character. When the end character is received, it is placed in the
message buffer and the receive is terminated.

Typically, you use end character detection with ASCII protocols where every message ends with a
specific character. You can use end character detection in combination with the intercharacter timer,
the message timer or the maximum character count to terminate a message.

Setup: ec =1, SMB89/SMB189 = end character

2. Intercharacter timer: The intercharacter time is the time measured from the end of one character
(the stop bit) to the end of the next character (the stop bit). If the time between characters (including
the second character) exceeds the number of milliseconds specified in SMW92 or SMW192, the
receive message function is terminated. The intercharacter timer is restarted on each character
received. See Figure 6-11.

You can use the intercharacter timer to terminate a message for protocols which do not have a
specific end-of-message character. This timer must be set to a value greater than one character
time at the selected baud rate since this timer always includes the time to receive one entire
character (start bit, data bits, parity and stop bits).

You can use the intercharacter timer in combination with the end character detection and the
maximum character count to terminate a message.

Setup: c¢/m =0, tmr =1, SMW92/SMW192 = timeout in milliseconds

Characters Characters

B 1 R I
Restarts the intercharacter The intercharacter timer expires:

timer Terminates the message and generates the
Receive Message interrupt

Figure 6-11  Using the Intercharacter Timer to Terminate the Receive Instruction

3. Message timer: The message timer terminates a message at a specified time after the start of the
message. The message timer starts as soon as the start condition(s) for the receive message
function have been met. The message timer expires when the number of milliseconds specified in
SMW92 or SMW192 have passed. See Figure 6-12.

Typically, you use a message timer when the communications devices cannot guarantee that there
will not be time gaps between characters or when operating over modems. For modems, you can
use a message timer to specify a maximum time allowed to receive the message after the message
has started. A typical value for a message timer would be about 1.5 times the time required to
receive the longest possible message at the selected baud rate.

You can use the message timer in combination with the end character detection and the maximum
character count to terminate a message.

Setup: c¢/m =1, tmr =1, SMW92/SMW192 = timeout in milliseconds

84



S7-200 Instruction Set Chapter 6

Characters Characters

‘ 1

Start of the message: The message timer expires:

Starts the message timer Terminates the message and generates the
Receive Message interrupt

Figure 6-12  Using the Message Timer to Terminate the Receive Instruction

4. Maximum character count: The Receive instruction must be told the maximum number of
characters to receive (SMB94 or SMB194). When this value is met or exceeded, the receive
message function is terminated. The Receive instruction requires that the user specify a maximum
character count even if this is not specifically used as a terminating condition. This is because the
Receive instruction needs to know the maximum size of the receive message so that user data
placed after the message buffer is not overwritten.

The maximum character count can be used to terminate messages for protocols where the
message length is known and always the same. The maximum character count is always used in
combination with the end character detection, intercharacter timer, or message timer.

5. Parity errors: The Receive instruction is automatically terminated when the hardware signals a
parity error on a received character. Parity errors are only possible if parity is enabled in SMB30 or
SMB130. There is no way to disable this function.

6. User termination: The user program can terminate a receive message function by executing another
Receive instruction with the enable bit (EN) in SMB87 or SMB187 set to zero. This immediately
terminates the receive message function.

Using Character Interrupt Control to Receive Data

To allow complete flexibility in protocol support, you can also receive data using character interrupt control.
Each character received generates an interrupt. The received character is placed in SMB2, and the parity
status (if enabled) is placed in SM3.0 just prior to execution of the interrupt routine attached to the receive
character event. SMB2 is the Freeport receive character buffer. Each character received while in Freeport
mode is placed in this location for easy access from the user program. SMB3 is used for Freeport mode
and contains a parity error bit that is turned on when a parity error is detected on a received character. All
other bits of the byte are reserved. Use the parity bit either to discard the message or to generate a
negative acknowledgement to the message.

When the character interrupt is used at high baud rates (38.4 kbaud to 115.2 kbaud), the time between
interrupts is very short. For example, the character interrupt for 38.4 kbaud is 260 microseconds, for
57.6 kbaud is 173 microseconds, and for 115.2 kbaud is 86 microseconds. Ensure that you keep the
interrupt routines very short to avoid missing characters, or else use the Receive instruction.

Tip

SMB2 and SMB3 are shared between Port 0 and Port 1. When the reception of a character on Port 0
results in the execution of the interrupt routine attached to that event (interrupt event 8), SMB2 contains
the character received on Port 0, and SMB3 contains the parity status of that character. When the
reception of a character on Port 1 results in the execution of the interrupt routine attached to that event
(interrupt event 25), SMB2 contains the character received on Port 1 and SMB3 contains the parity
status of that character.
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Example: Transmit and Receive Instructions

M Network 1 Network 1 /[This program receives a string of characters until
A SMOA MoV B /laline feed character is received.
| ] = /[The message is then transmitted back to the sender.
N — | EN  ENOF—) g !
LD SMO0.1 //On the first scan:
16#084IN___ OUTFSMBID MOVB  16#09, SMB30 //1. Initialize Freeport:
/I — Select 9600 baud.
/I — Select 8 data bits.
MOV_B /I — Select no parity.
EM  EMNO %l MOVB  16#B0, SMB87 //2. Initialize RCV message control byte:
/I —RCV enabled.
16#B04IN___ OUTF5MBET /I — Detect end of message character.
/I — Detect idle line condition as the message
1 start condition.
Mov_B MOVB  16#0A, SMB89 //3. Set end of message character
EN  ENo—) /I tohex OA (line feed).
MOVW  +5, SMW90 //4.  Setidle line timeout
16#0AIN___ OUT}SMBSY /I to5ms.
MOVB 100, SMB94  //5. Set maximum number of characters
/I to 100.
MO_Y ATCH INT_O, 23 /I6. Attach interrupt O
EM  EMNO % /I tothe Receive Complete event.
ATCH INT_2,9 /[7. Attach interrupt 2
+5qIN__ OUTESMvwa0 /I to the Transmit Complete event.
ENI //8. Enable user interrupts.
RCV VB100, 0 //9. Enable receive box with buffer at VB100.
MOY_B
EM  EMND %
1004 OUTFSMB94
ATCH
EM  ENO %
INT_OHINT
234EUNT
ATCH
EN  ENO—)
INT_24INT
g{EVNT
—( Eni)
RCY
EN  ENO %
¥B1004TBL
04PORT
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Example: Transmit and Receive Instructions, continued

| Network 1 Network 1 //IReceive complete interrupt routine:
N SMERE Mov D /1. If receive status shows receive of end character,
T | EN ENO >| /I then attach a 10 ms timer to trigger a transmit and return.
0 16#2'0 /12. If the receive completed for any other reason,
10dm ouTkSmEsa /I then start a new receive.
LDB= SMB86, 16#20
MOVB 10, SMB34
ATCH ATCH INT_1, 10
en  eno—3|  CRETI
NOT
INT_1INT RCV VB100, 0
104{EVNT.
—(RET)
RCY
—{not—en  Eno ﬁ
wB1004TBL
D4PORT
I Network 1 Network 1 //10-ms Timer interrupt:
N SMO.0 oTon /[1. Detach timer interrupt.
| . i .
1’ _| | EN  ENO %l /[2. Transmit message back to user on port
LD SMO0.0
104EVNT. DTCH 10
XMT VB100, 0
HMT
EM  ENO %
wB1004TBL
04PORT
I Hetwork 1 Network 1 /[Transmit Complete interrupt:
N SMO 0 ET /[Enable another receive.
'+ b——n emo— b SM0.0
2 RCV  VB100,0
vB1004TBL
04PORT
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Get Port Address and Set Port Address Instructions

The Get Port Address instruction (GPA) reads the station address of
the S7-200 CPU port specified in PORT and places the value in the

SIMATIC £ IEC 1131

address specified in ADDR. LAD FED
The Set Port Address instruction (SPA) sets the port station address GET_ADDR GET_ADDR
(PORT) to the value specified in ADDR. The new address is not —EM EMG = | —EM EMG =
saved permanently. After a power cycle, the affected port returns to dioor ] ngﬂ’i
the last address (the one that was downloaded with the system JdpoRT
block).
Error conditions that set ENO = 0: EETLFIEIEL: SJE G
m 0006 (indirect address)
= 0004 (attempted to perform a Set Port Address instruction in an interrupt SALTITE
routine)
STL
GPA  ADDR, PORT
SPA  ADDR, PORT

Table 6-13  Valid Operands for the Get Port Address and Set Port Address Instructions

Inputs/Outputs Data Type Operands
ADDR BYTE 1B, QB, VB, MB, SMB, SB, LB, AC, *VD, *LD, *AC, Constant

(A constant value is valid only for the Set Port Address instruction.)
PORT BYTE Constant for CPU 221, CPU 222, CPU 224: 0

for CPU 226 and CPU 226XM:

Oorl
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Compare Instructions
Comparing Numerical Values mATIC | i 1121 |
The compare instructions are used to compare two values: LD —
1M1
IN1 =1IN2 INL>=1IN2 IN1<=IN2 _| - l_ H4 = -
IN1 > IN2 IN1 < IN2 IN1 <> IN2 e .
Compare Byte operations are unsigned. . _
Compare Integer operations are signed. = ] sl
Compare Double Word operations are signed. #=p ==| ==D ==R
Compare Real operations are signed. <=8 ==l ==D <=R
=k =l =0 =R
For LAD and FBD: When the comparison is true, the Compare € A <D <R
instruction turns on the contact (LAD) or output (FBD).
For STL: When the comparison is true, the Compare instruction SMATIC (B 1131
Loads, ANDs, or ORs a 1 with the value on the top of the stack LD FBD
(STL).
Ecy b EC B
When you use the IEC compare instructions, you can use various —EM ouUTE | T
data types for the inputs. However, both input values must be of the i
same data type. iz
EG ME GE LE GT LT
Notice
The following conditions are fatal errors and cause your S7-200 to SIMATIC
immediately stop the execution of your program:
vl i STL
= _IIIegaI |r_1d|rect address is encountered (any Compare LDE=  [M1, M2
instruction) AB= M1, IM2
. OB= N1, INZ
m |llegal real number (for example, NAN) is encountered
(Compare Real instruction) LDE=  LDW= LDD= LDR=
i . LLE<  LDW< LDD< LDR<
To prevent these conditions from occurring, ensure that you LDB=  LDW= LDD=  LDR=
properly initialize pointers and values that contain real numbers tgg:z tgmz 'Eggjz IEEE:Z
before executing compare instructions that use these values. LDB+= LDWs= LDD== LDR==
Compare instructions are executed regardless of the state of RE= A= A= AR=
power flow. AE-= A= AL AR
AE:= A= AD= AR
AB<= A<=  AD==  AR<=
AB<=  AW<= AD== AR<=
AB==  AW== AD== AR==
OB=  OW=  oD=  OR=
QB Lol Qb= QR
QB Lol QL= QR
OB D= QD= DR
OB<=  OWe= OD== OR==
OBr=  OWe=  ODe=  ORes
Table 6-14  Valid Operands for the Compare Instructions
Inputs/Outputs Type Operands
IN1, IN2 BYTE 1B, QB, VB, MB, SMB, SB, LB, AC, *VD, *LD, *AC, Constant
INT IW, QW, VW, MW, SMW, SW, T, C, LW, AC, AIW, *VD, *LD, *AC, Constant
DINT ID, QD, VD, MD, SMD, SD, LD, AC, HC, *VD, *LD, *AC, Constant
REAL ID, QD, VD, MD, SMD, SD, LD, AC, *VD, *LD, *AC, Constant
Output (or OUT) BOOL ,Q,V,M, SM, S, T, C, L, Power Flow
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Example: Compare Instructions

Network 1 Network 1 /[Turn analog adjustment potentiometer 0 to vary
00 SME7a Q0.0 /lthe SMB28 byte value.
' ' //Q0.0 is active when the SMB28 value is less than
=B |—(
_| qs 0 ) /lor equal to 50.
S a0 //Q0.1 is active when the SMB28 value is greater than
/lor equal to 150.
== | ( ) /[The status indicator is on when the comparison is true.
150
LD 10.0
LPS
Network 2 AB<=  SMB28, 50
101 MOW_WW = Q0.0
— | en enob—y  LPP
AB>= SMB28, 150
-300004IN__ ouThkwwio = Q0.1
Network 2 /[Load V memory addresses with low values
MCW_DHAY /ithat make the comparisons false and that turn
EM  END H /lthe status indicators off.
LD 10.1
-2000000004IN___ OUT}wD2 MOVW  —30000. VWO
MOVD  —200000000, VD2
MOVR  1.012E-006, VD6
MOy _R
ENEND H Network 3 /[Load V memory addresses with high values
/lthat make the comparisons true and that turn
1.012E-0064IM__OUTFVDE Ilthe status indicators on.
Network 3
LD 10.2
'”-2| MOY_W MOVW  +30000, VWO
— | en eno—3  MOVD  -100000000, VD2
MOVR  3.141593, VD6
+300004IN__ QUTFWAD
Network 4 /[The Integer Word comparison tests to find if
/IVWO0 > +10000 is true.
MOV_Dwy //Uses program constants to show the different
EM  EMND % //data types. You can also compare two values
/Istored in programmable memory like:
-10000000041N__ OUTRVDZ /IVWO > VW100
LD 10.3
LPS
MOY_R AW> VWO, +10000
EM  ENO H = Q0.2
LRD
31415934IN_ OUTHVDE AD< —150000000, VD2
= Q0.3
LPP
AR> VD6, 5.001E-006
Network 4 = Q0.4
10.3 YWD Q0.2
— ()
+10000
-150000000 Q0.3
o— )
W2
WDB Q0.4
=R )
5.001E-006
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Compare String

The Compare String instruction compares two strings of ASCII
characters:

IN1 = IN2 IN1 <> IN2

When the comparison is true, the Compare instruction turns the
contact (LAD) or output (FBD) on, or the compare instruction Loads,
ANDs or ORs a 1 with the value on the top of the stack (STL).

Notice

The following conditions are fatal errors and cause your S7-200 to
immediately stop the execution of your program:

m |llegal indirect address is encountered (any compare
instruction)

®m A string with a length greater than 254 characters is
encountered (Compare String instruction)

®m A string whose starting address and length are such that it will
not fit in the specified memory area (Compare String
instruction)

To prevent these conditions from occurring, ensure that you
properly initialize pointers and memory locations that are intended
to hold ASCII strings prior to executing compare instructions that
use these values. Ensure that the buffer reserved for an ASCII
string can reside completely within the specified memory area.

Compare instructions are executed regardless of the state of
power flow.

Table 6-15  Valid Operands for the Compare String Instructions

SIMATIC l IEC 1121 ]
LAL: M1 FEL
_| =g |_ 1 = B
M2
== =5
siAT.  [EC 113 ]
LAL: FEL
EQS 1 EQS »
— EM CUT a
= 1M1
M2
EC_5 ME_S
SIMATIC
5TL
LLE5= M1, IM2
AS=IM1,IM2
0= M1, IM2
LDS== M1, M2
AS=> M1, IM2
Q5= M1, M2

Inputs/Outputs Type Operands
IN1, IN2 BYTE (String) | VB, LB, *VD, *LD, *AC
Output (OUT) BOOL ,Q,V,M, SM, S, T, C, L, Power Flow
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Conversion Instructions

Standard Conversion Instructions amATic | ec 1131
Numerical Conversions T =
The Byte to Integer (BTI), Integer to Byte (ITB), Integer to Double E_I E_I
Integer (ITD), Double Integer to Integer (DTI), Double Integer to Real e ol B
(DTR), BCD to Integer (BCDI) and Integer to BCD (IBCD) i auT F
instructions convert an input value IN to the specified format and o L oUT =
stores the output value in the memory location specified by OUT. For
example, you can convert a double integer value to a real number. E_I BCD_
You can also convert between integer and BCD formats. I_E SR
Ll RN
Round and Truncate ol TRURC
The Round instruction (ROUND) converts a real value IN to a bR =Ea
double integer value and places the rounded result into the variable
specified by OUT. SIMATIC  IEC 1131
The Truncate instruction (TRUNC) converts a real number IN into a LAD FED
_double integer and plz_iges the whole-number portion of the result ETo ] ETo ]
into the variable specified by OUT. ey o b | den to |
M ouT [
Segment i alT
The Segment instruction (SEG) allows you to generate a bit pattern
that illuminates the segments of a seven-segment display. BTo | BCD_To|
I_To_B I_To_BCD
I_Te_Dl TRIME
Ll_Td_ SEG
LI_TO_R
R_To_DI
SIMATIC
STL
BTl IM,oUT  BCDI QUT
ITE  IM.OUT  gcp OUT
ITD M. OUT  TRUMC M, QUT
LTI IM.OUT  ROUMD I, QUT
DTR IM.CUT  SEG M, ST

Table 6-16  Valid Operands for the Standard Conversion Instructions

Inputs/Outputs Data Type Operands

IN BYTE B, QB, VB, MB, SMB, SB, LB, AC, *VD, *LD, *AC, Constant
WORD, INT | IW, QW, VW, MW, SMW, SW, T, C, LW, AIW, AC, *VD, *LD, *AC, Constant
DINT ID, QD, VD, MD, SMD, SD, LD, HC, AC, *VD, *LD, *AC, Constant
REAL ID, QD, VD, MD, SMD, SD, LD, AC, *VD, *LD, *AC, Constant

ouT BYTE B, QB, VB, MB, SMB, SB, LB, AC, *VD, *LD, *AC

WORD, INT | IW, QW, VW, MW, SMW, SW, T, C, LW, AC, *VD, *LD, *AC
DINT, REAL | ID, QD, VD, MD, SMD, SD, LD, AC, *VD, *LD, *AC
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%

Operation of the BCD to Integer and Integer to BCD Instructions

The BCD to Integer instruction (BCDI) converts the binary-coded
decimal value IN to an integer value and loads the result into the
variable specified by OUT. The valid range for IN is 0 to 9999 BCD.

The Integer to BCD instruction (IBCD) converts the input integer
value IN to a binary-coded decimal and loads the result into the
variable specified by OUT. The valid range for IN is 0 to 9999
integer.

Operation of the Double Integer to Real Instruction

The Double Integer to Real instruction (DTR) converts a 32-bit,
signed integer IN into a 32-bit real number and places the result into
the variable specified by OUT.

Operation of the Double Integer to Integer Instruction

The Double Integer to Integer instruction (DTI) converts the double
integer value IN to an integer value and places the result into the
variable specified by OUT.

If the value that you are converting is too large to be represented in
the output, then the overflow bit is set and the output is not affected.

Operation of the Integer to Double Integer Instruction

The Integer to Double Integer instruction (ITD) converts the integer
value IN to a double integer value and places the result into the
variable specified by OUT. The sign is extended.

Operation of the Byte to Integer Instruction

The Byte to Integer instruction (BTI) converts the byte value IN to an
integer value and places the result into the variable specified by
OUT. The byte is unsigned, therefore there is no sign extension.

Operation of the Integer to Byte Instruction

The Integer to Byte instruction (ITB) converts the word value IN to a
byte value and places the result into the variable specified by OUT.
Values 0 to 255 are converted. All other values result in overflow
and the output is not affected.

Tip

Error conditions that set ENO =0
m SML1.6 (invalid BCD)

m 0006 (indirect address)

SM bits affected:
m SML1.6 (invalid BCD)

Error conditions that set ENO =0
m 0006 (indirect address)

Error conditions that set ENO =0
= SM1.1 (overflow)

m 0006 (indirect address)

SM bits affected:
= SM1.1 (overflow)

Error conditions that set ENO =0
m 0006 (indirect address)

Error conditions that set ENO =0
m 0006 (indirect address)

Error conditions that set ENO =0
= SM1.1 (overflow)

m 0006 (indirect address)

SM bits affected:
= SM1.1 (overflow)

To change an integer to a real number, use the Integer to Double Integer instruction and then use the

Double Integer to Real instruction.
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Operation of the Round and Truncate Instructions

The Round instruction (ROUND) converts the real-number value IN  Error conditions that set ENO =0
to a double integer value and places the result into the variable m SM1.1 (overflow)
specified by OUT. If the fraction portion is 0.5 or greater, the number

is rounded up. m 0006 (indirect address)

The Truncate instruction (TRUNC) converts a real-number value IN ~ SM bits affected:
into a double integer and places the result into the variable specified = SM1.1 (overflow)
by OUT. Only the whole number portion of the real number is

converted, and the fraction is discarded.

If the value that you are converting is not a valid real number or is too large to be represented in the
output, then the overflow bit is set and the output is not affected.

Example: Standard Conversion Instructions

Network 1 Network 1 /IConvert inches to centimeters:
//1. Load a counter value (inches) into AC1.
0.0 I_D1
| /12. Convert the value to a real number.
_l | M ENO >| /3. Multiply by 2.54 (convert to centimeters).
/l4. Convert the value back to an integer.
C104IM OUTEACT LD 10.0
ITD C10, AC1
DTR AC1, VDO
DI_R MOVR VDO, VD8
EN  END ﬁ *R VD4, VD8
ROUND VD8, VD12
ACTHIM OUTHYDO
Network 2 /IConvert a BCD value to an integer
LD 10.3
WL R BCDI ACO
N ENol—)
WOO4IM1T OUTEYDE
W44 IM2
ROUND
EM  EMNO ﬁ
WOEA M OUTFT1 2
Network 2
0.3 BCD_|
—| |— EN  ENO ﬁ
ACOAIN OUTEFACD
Double Word Integer to Real and Round BCD to Integer
C10 101 Count = 101 inches ACO | 1234
VDO 101.0| Count (as a real number) BCDI
VD4 2.54 constant (inches to centimeters) ACO |04D2
VD8 256.54 | 256.54 centimeters as real number
VD12 257 | 257 centimeters as double integer
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Operation of the Segment Instruction

To illuminate the segments of a seven-segment display, the Segment instruction (SEG) converts the
character (byte) specified by IN to generate a bit pattern (byte) at the location specified by OUT.

The illuminated segments represent the character in the least Error conditions that set ENO =0
significant digit of the input byte. Figure 6-13 shows the m 0006 (indirect address)
seven-segment display coding used by the Segment instruction.

(IN) Segment (OUT) (IN) Segment (OUT)

LSD | Display -gfe dchba LSD Display | —gfe dcba
0 o 0011 1111 8 - 0111 1111
1 i 0000 0110 g 9 o 0110 0111
2 2 0101 1011 fI g |b A o 0111 0111
3 - 0100 1111 el—lc B :E' 0111 1100
4 - 0110 0110 - C L 0011 1001
5 o 0110 1101 d D o 0101 1110
6 - 0111 1101 E - 0111 1001
7 o 0000 0111 F p 0111 0001

Figure 6-13  Coding for a Seven-Segment Display

Example: Segment Instruction

Network 1
Network 1 SEG
11.0 SEG LD 1.0 VB48 AC1

—en enop— SEG  VB48,AC1

~1 (display character)

WB484IN OUTFACH
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ASCII Conversion Instructions
Valid ASCII characters are the hexadecimal values 30 to 39, and 41 to 46.

Converting between ASCIl and Hexadecimal Values

SIMATIC ¢ IEC 1131
The ASCII to Hexadecimal instruction (ATH) converts a number LEN
of ASCII characters, starting at IN, to hexadecimal digits starting at LAD FED
OUT. The Hexadecimal to ASCII instruction (HTA) converts the ITA ITH
hexadecimal digits, starting with the input byte IN, to ASCII ar e = | Em EMO -
characters starting at OUT. The number of hexadecimal digits to be =M oUT
converted is specified by length LEN. ] 'F”MT GUTE T
The maximum number of ASCII characters or hexadecimal digits
that can be converted is 255. ATH ATH
— EM EMC = | EM EMO |
Error conditions that set ENO =0 -1 QUT =
. . ™ QUTE | LEn
m SML1.7 (illegal ASCII) ASCII to Hexadecimal only < LEM

m 0006 (indirect address)
ITH LTH RTH
= 0091 (operand out of range) ATH HTR
SM bits affected:
m SM1.7 (illegal ASCII)

SIMATIC
Converting Numerical Values to ASCII 271
The Integer to ASCII (ITA), Double Integer to ASCII (DTA), and Real ITA N, QUT, FT
to ASCII (RTA) instructions convert integer, double integer, or real E;S :m EH% Em
number values to ASCII characters. ATH 1M, OUT, LEN
HTA  IM, QUT, LEN
Table 6-17  Valid Operands for the ASCII Conversion Instructions
Inputs/Outputs Data Type Operands
IN BYTE 1B, QB, VB, MB, SMB, SB, LB, *VD, *LD, *AC
INT IW, QW, VW, MW, SMW, SW, T, C, LW, AC, AIW, *VD, *LD, *AC, Constant
DINT ID, QD, VD, MD, SMD, SD, LD, AC, HC, *VD, *LD, *AC, Constant
REAL ID, QD, VD, MD, SMD, SD, LD, AC, *VD, *LD, *AC, Constant
LEN, FMT BYTE 1B, QB, VB, MB, SMB, SB, LB, AC, *VD, *LD, *AC, Constant
ouT BYTE 1B, QB, VB, MB, SMB, SB, LB, *VD, *LD, *AC

Operation of the Integer to ASCII Instruction

The Integer to ASCII instruction (ITA) converts an integer word IN to  Error conditions that set ENO =0
an array of ASCII characters. The format FMT specifies the ® 0006 (indirect address)
conversion precision to the right of the decimal, and whether the
decimal point is to be shown as a comma or a period. The resulting
conversion is placed in 8 consecutive bytes beginning with OUT. = nnn>5

= |llegal format

The array of ASCII characters is always 8 characters.

Figure 6-14 describes the format operand for the Integer to ASCI!I instruction. The size of the output buffer
is always 8 bytes. The number of digits to the right of the decimal point in the output buffer is specified by
the nnn field. The valid range of the nnn field is 0 to 5. Specifying 0 digits to the right of the decimal point
causes the value to be displayed without a decimal point. For values of nnn bigger than 5, the output
buffer is filled with ASCII spaces. The c bit specifies the use of either a comma (c=1) or a decimal point
(c=0) as the separator between the whole number and the fraction. The upper 4 bits must be zero.
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Figure 6-14 shows examples of values that are formatted using a decimal point (c=0) with three digits to
the right of the decimal point (nnn=011). The output buffer is formatted according to the following rules:

1 Positive values are written to the output buffer without a sign.
1 Negative values are written to the output buffer with a leading minus sign (-).

1 Leading zeros to the left of the decimal point (except the digit adjacent to the decimal point) are
suppressed.

1 Values are right-justified in the output buffer.

FMT
Out [Out [Out [Out | Out| Out| Out | Out
MSB LsB +1 |+2 [+3 [+4 | +5 | +6 | +7
7 6 5 4 3 2 1 0 in=12 0 . 0 1 2
‘olofolo]lclnln]n] in=—123 —lo 1] 2] 3
¢ = comma (1) or decimal point (0) in=1234 1 2 3 4
nnn = digits to right of decimal point in =-=12345 — 1 2 3 4 5

Figure 6-14 FMT Operand for the Integer to ASCII (ITA) Instruction

Operation of the Double Integer to ASCII Instruction

The Double Integer to ASCII (DTA) instruction converts a double Error conditions that set ENO =0
word IN to an array of ASCII characters. The format operand FMT m 0006 (indirect address)

specifies the conversion precision to the right of the decimal. The
resulting conversion is placed in 12 consecutive bytes beginning
with OUT. ® nnn>5

= |llegal format

The size of the output buffer is always 12 bytes.

Figure 6-15 describes the format operand for the Double Integer to ASCII instruction. The number of digits
to the right of the decimal point in the output buffer is specified by the nnn field. The valid range of the nnn
field is 0 to 5. Specifying O digits to the right of the decimal point causes the value to be displayed without
a decimal point. For values of nnn bigger than 5, the output buffer is filled with ASCII spaces. The c bit
specifies the use of either a comma (c=1) or a decimal point (c=0) as the separator between the whole
number and the fraction. The upper 4 bits must be zero.

Figure 6-15 shows examples of values that are formatted using a decimal point (c=0) with four digits to the
right of the decimal point (hnn=100). The output buffer is formatted according to the following rules:

1 Positive values are written to the output buffer without a sign.
1 Negative values are written to the output buffer with a leading minus sign (-).

1 Leading zeros to the left of the decimal point (except the digit adjacent to the decimal point) are
suppressed.

1 Values are right-justified in the output buffer.

FMT
s s Out| Out| Out| Out| Out| Out| Out| Out| Out Out| Out | Out
MSB LSB +1| +2 | +3| +4| +5| +6| +7| +8] +9| +10| +11
lololololcinlnln] _ Jn=-12 P R B I
in=1234567 1121 3| .]4al5] 6|7

¢ = comma (1) or decimal point (0)
nnn = digits to right of decimal point

Figure 6-15 FMT Operand for the Double Integer to ASCII (DTA) Instruction
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Operation of the Real to ASCII Instruction

The Real to ASCI!I instruction (RTA) converts a real-number value IN  Error conditions that set ENO =0

to ASCII characters. The format FMT specifies the conversion m 0006 (indirect address)
precision to the right of the decimal, whether the decimal point is
shown as a comma or a period, and the output buffer size. nnn >S5

B sSSSss<3

The resulting conversion is placed in an output buffer beginning with )
OUT. m ssss< number of characters in OUT

The number (or length) of the resulting ASCII characters is the size of the output buffer and can be
specified to a size ranging from 3 to 15 bytes or characters.

The real-number format used by the S7-200 supports a maximum of 7 significant digits. Attempting to
display more than 7 significant digits produces a rounding error.

Figure 6-16 describes the format operand (FMT) for the RTA instruction. The size of the output buffer is
specified by the ssss field. A size of 0, 1, or 2 bytes is not valid. The number of digits to the right of the
decimal point in the output buffer is specified by the nnn field. The valid range of the nnn field is O to 5.
Specifying 0 digits to the right of the decimal point causes the value to be displayed without a decimal
point. The output buffer is filled with ASCII spaces for values of nnn bigger than 5 or when the specified
output buffer is too small to store the converted value. The c bit specifies the use of either a comma (c=1)
or a decimal point (c=0) as the separator between the whole number and the fraction.

Figure 6-16 also shows examples of values that are formatted using a decimal point (c=0) with one digit to

the right of the decimal point (nnn=001) and a buffer size of six bytes (ssss=0110). The output buffer is
formatted according to the following rules:

1 Positive values are written to the output buffer without a sign.
1 Negative values are written to the output buffer with a leading minus sign (-).

1 Leading zeros to the left of the decimal point (except the digit adjacent to the decimal point) are
suppressed.

1 Values to the right of the decimal point are rounded to fit in the specified number of digits to the right
of the decimal point.

1 The size of the output buffer must be a minimum of three bytes more than the number of digits to
the right of the decimal point.

1 Values are right-justified in the output buffer.

FMT Out| Out| Ouf Ouf Out| Out
MSB LsB +1] +2| +3| +4]| +5
in=1234.5 11 2| 3] 4 5
|s[s[s[s[c|n[n[n] in = —-0.0004 0 0
ssss = size of output buffer in=-3.67526 -1 3 7
P = igis 6 ight of decmal ot in=1.95 2 0

Figure 6-16 FMT Operand for the Real to ASCII (RTA) Instruction
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Example: ASCII to Hexadecimal Instruction

Network 1 Network 1
13.2 ATH LD 13.2

—1en ENOH ATH VB30, VB40, 3

wEI0HIM OUTEVE40

34LEN
3 E A
ATH Note: The X indicates that the “nibble” (half of a byte) is
VB30 VB40 unchanged.

Example: Integer to ASCII Instruction

Network 1 Network 1 /IConvert the integer value at VW2
123 A /lto 8 ASCII characters starting at VB10,
/lusing a format of 16#0B
|7 Er EMNO H
/l(a comma for the decimal point,

[[followed by 3 digits).
W2 QUTEYETD

16#0B-{FMT LD 2.3
ITA VW2, VB10, 16408
o R Y3 4
m (2] [ [0 [32] (2] (=] (=] [5]
Vw2 VB10  VBIL

Example: Real to ASCII Instruction

Network 1 Network 1 /IConvert the real value at VD2

123 5T A /lto 10 ASCII characters starting at VB10,
|7 EN  ENO %l /lusing a format of 16#A3
//(a period for the decimal point,
voad i outhven [[followed by 3 digits).
16#AI{EMT LD 12.3
RTA VD2, VB10, 16#A3
- - - 0 o 3 71 5 0
123.45 RTa |20 | [20 [[ 20 |[31 |[32|[33|[2E]||34][35]]30 ]|
VD2 VB10 VBl1
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String Conversion Instructions

Converting Numerical Values to String

The Integer to String (ITS), Double Integer to String (DTS), and Real
to String (RTS) instructions convert integers, double integers, or real
number values (IN) to an ASCII string (OUT).

Operation of the Integer to String

The Integer to String instruction (ITS) converts an integer word IN to
an ASCII string with a length of 8 characters. The format (FMT)
specifies the conversion precision to the right of the decimal, and
whether the decimal point is to be shown as a comma or a period.
The resulting string is written to 9 consecutive bytes starting at OUT.
See the section, format for strings in/Chapter 4 for more information.

Error conditions that set ENO =0
m 0006 (indirect address)

= 0091 (operand out of range)

= |llegal format (hnn > 5)

Figure 6-17 describes the format operand for the Integer to String
instruction. The length of the output string is always 8 characters.
The number of digits to the right of the decimal point in the output
buffer is specified by the nnn field. The valid range of the nnn field is
0 to 5. Specifying 0 digits to the right of the decimal point causes the
value to be displayed without a decimal point. For values of nnn
greater than 5, the output is a string of 8 ASCII space characters.
The c bit specifies the use of either a comma (c=1) or a decimal
point (c=0) as the separator between the whole number and the
fraction. The upper 4 bits of the format must be zero.

Figure 6-17 also shows examples of values that are formatted using
a decimal point (c= 0) with three digits to the right of the decimal
point (nnn = 011).The value at OUT is the length of the string.

The output string is formatted according to the following rules:

1 Positive values are written to the output buffer without a sign.

SIMATIC l IEC 1131 ]
LAC FEL
I_5 I_5
— EM EMCO - | EM EMC -
= IM CUT =
— Iy OUuT - A FraT
— FMT
I_5 DI_% R_%
SIMATIC  EC113
LAC FEL
1_To_5 1_To_5
— EM EMCO - | EM EMC -
= IM CUT |-
— Iy OUuT - A FraT
— FMT
1T 5 DI_To.S R_To.S
SIMATIC
STL
ITS IM, FRT, 2UT
DTS IM.FMT, OUT
RTS  IM,FRT, QUT

1 Negative values are written to the output buffer with a leading minus sign (-).

1 Leading zeros to the left of the decimal point (except the digit adjacent to the decimal point) are

suppressed.

1 Values are right-justified in the output string.

Table 6-18  Valid Operands for the Instructions That Convert Numerical Values to Strings

Inputs/Outputs Data Type Operands

IN BYTE (String) ' VB, LB, *VD, *LD, *AC
INT IW, QW, VW, MW, SMW, SW, T, C, LW, AIW, *VD, *LD, *AC, Constant
DINT ID, QD, VD, MD, SMD, SD, LD, AC, HC, *VD, *LD, *AC, Constant
REAL ID, QD, VD, MD, SMD, SD, LD, AC, *VD, *LD, *AC, Constant

INDX, FMT BYTE 1B, QB, VB, MB, SMB, SB, LB, AC, *VD, *LD, *AC, Constant

ouT BYTE (String) ' VB, LB, *VD, *LD, *AC
INT IW, QW, VW, MW, SMW, SW, T, C, LW, AC, AQW, *VD, *LD, *AC

DINT, REAL ID, QD, VD, MD, SMD, SD, LD, AC, *VD, *LD, *AC
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FMT
Out [Out |Out |Out |Out | Out| Out | Out|Out
MSB LSB +1| +2 | +3| +4| +5| +6| +7| +8
7 6 5 4 3 2 10 in=12 | 8 0 o 1] 2
‘ofofofofc[n[n[n] in=—123 | 8 0 1] 2| 3
¢ = comma (1) or decimal point (0) in=1234 8 1 2 3 4
nnn = digits to right of decimal point in =-=12345 8 — 1 2 3 4 5
Figure 6-17 FMT Operand for the Integer to String Instruction
Operation of the Double Integer to String
The Double Integer to String instruction (DTS) converts a double Error conditions that set ENO =0
integer IN to an ASCII string with a length of 12 characters. The ® 0006 (indirect address)

format (FMT) specifies the conversion precision to the right of the
decimal, and whether the decimal point is to be shown as a comma
or a period. The resulting string is written to 13 consecutive bytes m lllegal format (nnn > 5)
starting at OUT. For more information, see the section that describes

the format for strings in/Chapter 4.

= 0091 (operand out of range)

Figure 6-18 describes the format operand for the Integer to String instruction. The length of the output
string is always 8 characters. The number of digits to the right of the decimal point in the output buffer is
specified by the nnn field. The valid range of the nnn field is 0 to 5. Specifying 0 digits to the right of the
decimal point causes the value to be displayed without a decimal point. For values of nnn greater than 5,
the output is a string of 12 ASCII space characters. The c bit specifies the use of either a comma (c=1) or
a decimal point (c=0) as the separator between the whole number and the fraction. The upper 4 bits of the
format must be zero.

Figure 6-18 also shows examples of values that are formatted using a decimal point (c= 0) with four digits
to the right of the decimal point (hnn = 100). The value at OUT is the length of the string. The output string
is formatted according to the following rules:

1 Positive values are written to the output buffer without a sign.
1 Negative values are written to the output buffer with a leading minus sign (-).

1 Leading zeros to the left of the decimal point (except the digit adjacent to the decimal point) are
suppressed.

1 Values are right-justified in the output string.

FMT

Out [Out |Out |Out [Out| Out| Out | Out|Out | Out| Out| Out| Out
MSB LSB +1| +2| +3| +4| +5| +6]| +7| +8 | +9|+10|+11 [+12
7 6 543 2 10 in=12 | 12 .l - 0 .| O] O 1| 2
(oJojofofc[n[n[n]| in=—1234567 | 12 i 2] 3] ] 4] s 6] 7

¢ = comma (1) or decimal point (0)
nnn = digits to right of decimal point

Figure 6-18 FMT Operand for the Double Integer to String Instruction
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Operation of the Real to String

The Real to String instruction (RTS) converts a real value IN to an Error conditions that set ENO =0
ASCI! string. The format (FMT) specifies the conversion precision to = 0006 (indirect address)
the right of the decimal, whether the decimal point is to be shown as

a comma or a period and the length of the output string. = 0091 (operand out of range)

m |llegal format:

The resulting conversion is placed in a string beginning with OUT. nnn>5

The length of the resulting string is specified in the format and can ssss < 3

be 3 to 15 characters. For more information, see the section that ssss < number of characters
describes the format for strings in Chapter 4. required

The real-number format used by the S7-200 supports a maximum of 7 significant digits. Attempting to
display more than the 7 significant digits produces a rounding error.

Figure 6-19 describes the format operand for the Real to String instruction. The length of the output string
is specified by the ssss field. A size of 0, 1, or 2 bytes is not valid. The number of digits to the right of the
decimal point in the output buffer is specified by the nnn field. The valid range of the nnn field is O to 5.
Specifying 0 digits to the right of the decimal point causes the value to be displayed without a decimal
point. The output string is filled with ASCII space characters when nnn is greater than 5 or when the
specified length of the output string is too small to store the converted value. The c bit specifies the use of
either a comma (c=1) or a decimal point (c=0) as the separator between the whole number and the
fraction.

Figure 6-19 also shows examples of values that are formatted using a decimal point (c= 0) with one digit
to the right of the decimal point (nnn = 001) and a output string length of 6 characters (ssss = 0110). The
value at OUT is the length of the string. The output string is formatted according to the following rules:

1 Positive values are written to the output buffer without a sign.
1 Negative values are written to the output buffer with a leading minus sign (-).

1 Leading zeros to the left of the decimal point (except the digit adjacent to the decimal point) are
suppressed.

1 Values to the right of the decimal point are rounded to fit in the specified number of digits to the right
of the decimal point.

1 The size of the output string must be a minimum of three bytes more than the number of digits to the
right of the decimal point.

(1 Values are right-justified in the output string.

FMT
Out |Out |Out |Out |Out| Out| Out
MSB LsB +1| +2 | +3| +4| +5| +6
in=1234.5 6] 1 2 3 4 5
‘s‘s|s|s‘c‘n‘n‘n‘ in=-0.0004 6 0 0
ssss = length of output string in=-3.67526 6 - 3 7
¢ = comma (1) or decimal point (0) in=1.95 6 2 0

nnn = digits to right of decimal point

Figure 6-19 FMT Operand for the Real to String Instruction
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Converting Substrings to Numerical Values

SIMATIC l IEC 1131 ]

The Substring to Integer (STI), Substring to Double Integer (STD),
and Substring to Real (STR) instructions convert a string value IN, LA FEL:
starting at the offset INDX, to an integer, double integer or real o | o |
number value OUT. ar e b | Em M -

. —IH UT |-
Error conditions that set ENO =0 1M OUTE | e
m 0006 (indirect address) T IND
= 0091 (operand out of range) 5| 5.0l 5 R

009B (index = 0)
SM1.1 (overflow)

SIMATIC  EC113
The Substring to Integer and Substring to Double Integer convert
strings with the following form: [spaces] [+ or —] [digits 0 — 9] LAD FED
5_To| 5_To|
The Substring to Real instruction converts strings with the following —EN Mo | e Mo
form: [spaces] [+ or ] [digits 0 — 9] [. or ,] [digits 0 — 9] —IM oUT -
=14 QUTE | Jinps
The INDX value is normally set to 1, which starts the conversion with ||| Ml
the first character of the string. The INDX value can be set to other
values to start the conversion at different points within the string. 5T0l s ToDl S TOR

This can be used when the input string contains text that is not part
of the number to be converted. For example, if the input string is

“Temperature: 77.8”, you set INDX to a value of 13 to skip over the SIMATIE
word “Temperature: " at the start of the string.

STL
The Substring to Real instruction does not convert strings using g'D :m :mgi g%
scientific notation or exponential forms of real numbers. The STR I IO LT

instruction does not produce an overflow error (SM1.1) but converts
the string to a real number up to the exponential and then terminates
the conversion. For example, the string ‘1.234E6’ converts without
errors to a real value of 1.234.

The conversion is terminated when the end of the string is reached or when the first invalid character is
found. An invalid character is any character which is not a digit (0 — 9).

The overflow error (SM1.1) is set whenever the conversion produces an integer value that is too large for
the output value. For example, the Substring to Integer instruction sets the overflow error if the input string
produces a value greater than 32767 or less than —32768.

The overflow error (SM1.1) is also set if no conversion is possible when the input string does not contain a
valid value. For example, if the input string contains ‘A123’, the conversion instruction sets SM1.1
(overflow) and the output value remains unchanged.

Table 6-19  Valid Operands for the Instructions That Convert Substrings to Numerical Values

Inputs/Outputs Data Type Operands

IN BYTE (string) | 1B, QB, VB, MB, SMB, SB, LB, *VD, *LD, *AC, Constant
INDX BYTE VB, IB, QB, MB, SMB, SB, LB, AC, *VD, *LD, *AC, Constant
ouT BYTE (string) | VB, IB, QB, MB, SMB, SB, LB, *VD, *LD, *AC, Constant

INT VW, IW, QW, MW, SMW, SW, T, C, LW, AC, AQW, *VD, *LD, *AC

DINT, REAL VD, ID, QD, MD, SMD, SD, LD, AC, *VD, *LD, *AC
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Valid Input Strings
for Integer and Double Integer

Valid Input Strings
for Real Numbers

Invalid Input Strings

Input String Output Integer Input String Output Real Input String
‘123 123 ‘123 123.0 ‘A123’
‘~00456’ —-456 ‘~00456’ -456.0 L
'123.45’ 123 '123.45’ 123.45 ‘++123’
‘+2345’ 2345 ‘+2345’ 2345.0 ‘+-123
‘000000123ABCD’ 123 ‘00.000000123’ 0.000000123 '+ 123

Figure 6-20 Examples of Valid and Invalid Input Strings

Example: String Conversion: Substring to Integer, Double Integer and Real

Network 1

Network 1 /IConverts the numeric string to an integer.
0.0 5 [/IConverts the numeric string to a double integer.
I EM ENO H /IConverts the numeric string to a real.
LD 10.0
VB0 IN QUTEAWI00 | g7y VB0,7,VW100
7D STD  VBO0,7,vD200
=5 STR  VB0,7,vD300
EN  ENof—
VBOAIN OUTFvD200
7INDx
S_R
EN  ENO—)
VB0 IN OUT VD300
71D
VB0 VB11
|ll|'T’|'e’|'m’|'p’|' | | '9’|'8’| | '6’|'F’|

After executing the network:
VW100 (integer) = 98
VD200 (double integer) = 98
VD300 (real) = 98.6
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Encode and Decode Instructions

Encode SIMATIC £ EC1131
The Encode instruction (ENCO) writes the bit number of the least
significant bit set of the input word IN into the least significant LAD FED
“nibble” (4 bits) of the output byte OUT. MO MO

—{ EN EMG = | o EM EMO |-
Decode EL ouT |-
The Decode instruction (DECO) sets the bit in the output word OUT i o
that corresponds to the bit number represented by the least ENCO DECO
significant “nibble” (4 bits) of the input byte IN. All other bits of the
output word are set to 0.

SIMATIC

SM Bits and ENO
For both the Encode and Decode instructions, the following =TL EMCO M. aUT
conditions affect ENO. DECD  IN. T
Error conditions that set ENO =0

m 0006 (indirect address)

Table 6-20  Valid Operands for the Encode and Decode Instructions

Inputs/Outputs Data Types

Operands

IN BYTE 1B, QB, VB, MB, SMB, SB, LB, AC, *VD, *LD, *AC, Constant

WORD W, QW, VW, MW, SMW, SW, T, C, LW, AC, AIW, *VD, *LD, *AC, Constant
ouT BYTE 1B, QB, VB, MB, SMB, SB, LB, AC, *VD, *LD, *AC

WORD IW, QW, VW, MW, SMW, SW, T, C, LW, AC, AQW, *VD, *LD, *AC

Example: Decode and Encode Instructions

Network 1 Network 1 /IAC2 contains error bits.
51 OECo //1. The DECO instruction sets the bit in VW40
1 /I that corresponds to this error code.
— EN  ENOF—) ' .
I /12. The ENCO instruction converts
/I the least significant bit set to an error code
ACZIN QUT R0 /I that is stored in VB50.
LD 13.1
=D DECO AC2, VW40
ENCO AC3, VB50
EN  ENO—
ACIHIN OUTFVES0
15 9 0
AC2 AC3 [1000 0010 0000 0000]
15 DECO 2 o ENCO
VW40 [ 0000 0000 0000 1000] VB50 [ 9]
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SIMATIC Counter Instructions SIATIC | ec 1121
Count Up Counter T e
The Count Up instruction (CTU) counts up from the current value et et
each time the count up (CU) input makes the transition from off to 1 T i ;U T
on. When the current value Cxx is greater than or equal to the IR Apw
preset value PV, the counter bit Cxx turns on. The counter is reset 1py
when the Reset (R) input turns on, or when the Reset instruction is
executed. The counter stops counting when it reaches the D D
maximum value (32,767). =D CTD D T
LD
STL operation : L Py
= Reset input: Top of stack —{PY
= Count Up input: Value loaded in the second stack location Cx Cx
U CTUD U CTUD
Count Down Counter 4 i ;D
The Count Down instruction (CTD) counts down from the current 4 - P
value of that counter each time the count down (CD) input makes
the transition from off to on. When the current value Cxx is equal to o i
0, the counter bit Cxx turns on. The counter resets the counter bit
Cxx and loads the current value with the preset value PV when the
load input LD turns on. The counter stops upon reaching zero, and
. SIMATIE
the counter bit Cxx turns on.
STL operation: ST CTU  Cxo, PY
® Load input: Top of stack (D Cooe, PY
CTUD o, PY
= Count Down input: Value loaded in the second stack location.

Count Up/Down Counter

The Count Up/Down instruction (CTUD) counts up each time the count up (CU) input makes the
transition from off to on, and counts down each time the count down (CD) input makes the transition from
off to on. The current value Cxx of the counter maintains the current count. The preset value PV is
compared to the current value each time the counter instruction is executed.

Upon reaching maximum value (32,767), the next rising edge at the count up input causes the current
count to wrap around to the minimum value (—32,768). On reaching the minimum value (—32,768), the
next rising edge at the count down input causes the current count to wrap around to the maximum value
(32,767).

When the current value Cxx is greater than or equal to the preset value PV, the counter bit Cxx turns on.
Otherwise, the counter bit turns off. The counter is reset when the Reset (R) input turns on, or when the
Reset instruction is executed. The CTUD counter stops counting when it reaches PV.

STL operation:
m  Reset input: Top of stack
= Count Down input: Value loaded in the second stack location

m  Count Up input: Value loaded in the third stack location

Table 6-21  Valid Operands for the SIMATIC Counter Instructions

Inputs/Outputs Data Types Operands

Cxx WORD Constant (CO to C255)

CU, CD,LD,R BOOL ,Q,V, M, SM, S, T, C, L, Power Flow

PV INT IW, QW, VW, MW, SMW, SW, LW, T, C, AC, AIW, *VD, *LD, *AC, Constant
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Tip

Since there is one current value for each counter, do not assign the same number to more than one
counter. (Up Counters, Up/Down Counters, and Down counters with the same number access the same
current value.)

When you reset a counter using the Reset instruction, the counter bit is reset and the counter current

value is set to zero. Use the counter number to reference both the current value and the counter bit of
that counter.

Table 6-22  Operations of the Counter Instructions

Type  Operation Counter Bit Power Cycle/First Scan

CTU CU increments the current value. The counter bit turns on when: | Counter bit is off.
Current value continues to increment Current value >= Preset Current value can be retained.!
until it reaches 32,767.

CTUD | CU increments the current value. The counter bit turns on when: | Counter bit is off.
CD decrements the current value. Current value >= Preset Current value can be retained.t
Current value continues to increment or
decrement until the counter is reset.

CTD CD decrements the current value until The counter bit turns on when: | Counter bit is off.
the current value reaches 0. Current value = 0 Current value can be retained.t

1 You can select that the current value for the counter be retentive. See Chapter 4 for information about memory retention
for the S7-200 CPU.

Example: SIMATIC Count Down Counter Instruction

Network 1 Network 1 //ICount down counter C1 current value counts from 3 to O
0.0 c1 /Iwith 10.1 off,
— |p———co cm /10.0 Off—on decrements C1 current value
/110.1 On loads countdown preset value 3
0.1
_| D LD 10.0
LD 10.1
adey CTD C1,+3
Network 2 /IC1 bit is on when counter C1 current value = 0
Network 2 LD Cl
i Qon.a = Q0.0
— )

Timing Diagram

i - —i 2
C1 |eunmnl) J"I :|—u

C1 |biya00 _l—l—l—
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Example: SIMATIC Count Up/Down Counter Instruction

Network 1 Network 1 /110.0 counts up
0.0 C48 /110.1 counts down
— |——} cto 1110.2 resets current value to 0
LD 10.0

0.1
_| | D LD 10.1
LD 10.2

0.2 CTUD C48, +4

+4{Py

al

Network 2 /ICount Up/Down counter C48 turns on C48 bit
/lwhen current value >= 4

LD C48

= Q0.0

Network 2
il

— )

Timing Diagram — _|_|_|_|_|_|_|_|_|_| |—|_|—|

TSN N S S S B

: i-I Il.: :l.I
C4a jox imnp 0 " o
Cia|biiang | |_| |
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IEC Counter Instructions

Up Counter AT TEC 1131
The Count Up instruction (CTU) counts up from the current value to
the preset value (PV) on the rising edges of the Count Up (CU) LAD FED
. . i i
input. When the current value (CV) is greater than or equal to the
; AU CTu AU Tl
preset value, the counter output bit (Q) turns on. The counter resets Ik
when the reset input (R) is enabled. The Up Counter stops counting -k py ak
when it reaches the preset value. 1p ok ok
Down Counter Sy
The Count Down instruction (CTD) counts down from the preset S S
g . A T A D T
value (PV) on the rising edges of the Count Down (CD) input. When di
the current value (CV) is equal to zero, the counter output bit (Q) - LD py ak
turns on. The counter resets and loads the current value with the dpy ok ok
preset value when the load input (LD) is enabled. The Down ol
Counter stops counting when it reaches zero.
i i
Up/Down Counter Al CTUD A CTUD
A D
The Count Up/Down instruction (CTUD) counts up or down from the A0 4R
current value (CV) on the rising edges of the Count Up (CU) or dr — LD
Count Down (CD) input. When the current value is equal to preset, - Py QU
the up output (QU) turns on. When the current value is equal to zero, - LD ele) o
the down output (QD) turns on. The counter loads the current value 1p auk M
with the preset value (PV) when the load (LD) input is enabled.
L . Qb
Similarly, the counter resets and loads the current value with 0 when vl
the reset (R) is enabled. The counter stops counting when it reaches
preset or 0.
Table 6-23  Valid Operands for the IEC Counter Instructions
Inputs/Outputs Data Types Operands
Cxx CTU, CTD, CTUD | Constant (CO to C255)
CU, CD,LD,R BOOL ,Q,V,M, SM, S, T, C, L, Power Flow
PV INT IW, QW, VW, MW, SMW, SW, LW, AC, AIW, *VD, *LD, *AC, Constant
Q, QU, QD BOOL 1,Q,V,M, SM, S, L
Ccv INT IW, QW, VW, MW, SW, LW, AC, *VD, *LD, *AC

Tip
@ Since there is one current value for each counter, do not assign the same number to more than one
counter. (Up Counters, Down Counters, and Up/Down Counters access the same current value.)
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Example: IEC Counter Instructions

Network 1 Timing Diagram
%I14.0 %C48 14.0
=CU CTUD CU-Up
13.0
%13.0 CD - Down
|— =C0 12.0
R — Reset
%I12.0
11.0
—| |— R LD - Load
%l1.0
Lo VWO
cv-—
Current Value
+4 4P QUF%Q0.0
QDOF%a0.1
Cv %0 Q0.0
QU -Up
Q0.1
QD — Down
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High-Speed Counter Instructions

High-Speed Counter Definition SIMATIC 7 EC1131
The High-Speed Counter Definition instruction (HDEF) selects the
operating mode of a specific high-speed counter (HSCx). The mode LAD FED
selection defines the clock, direction, start, and reset functions of the HO'EF HO'EF
high-speed counter. — EM M = | o EM EMO -
—{ Hs¢
You use one High-Speed Counter Definition instruction for each e | MODE
high-speed counter. MODE
Error conditions that set ENO =0 Ha¢ Ha¢
. . . —EN EMC - | o EM EMO |
m 0003 (input point conflict) dn
m 0004 (illegal instruction in interrupt) gl
m  000A (HSC redefinition)
SIMATIC
High-Speed Counter =
The High-Speed Counter (HSC) instruction configures and controls HDEF  HSC, MODE
the high-speed counter, based on the state of the HSC special HSC N
memory bits. The parameter N specifies the high-speed counter

Tips and Tricks

%

number.

The high-speed counters can be configured for up to twelve different modes of operation. See Table
6-25.

Each counter has dedicated inputs for clocks, direction control, reset, and start, where these functions
are supported. For the two-phase counters, both clocks can run at their maximum rates. In quadrature
modes, you can select one times (1x) or four times (4x) the maximum counting rates. All counters run at
maximum rates without interfering with one another.

Error conditions that set ENO =0

= 0001 (HSC before HDEF)

m 0005 (simultaneous HSC/PLS)

Table 6-24  Valid Operands for the High-Speed Counter Instructions

Inputs/Outputs Data Types Operands
HSC, MODE BYTE Constant
N WORD Constant

Refer to the Tips and Tricks on the documentation CD for programs that use high-speed counters. See
Tip 4 and Tip 29.

High-speed counters count high-speed events that cannot be controlled at S7-200 scan rates. The
maximum counting frequency of a high-speed counter depends upon your S7-200 CPU model. Refer to
Appendix A for more information.

Tip
CPU 221 and CPU 222 support four high-speed counters: HSCO, HSC3, HSC4, and HSC5. These
CPUs do not support HSC1 and HSC2.

CPU 224, CPU 226, and CPU 226XM support six high-speed counters: HSCO to HSC5.
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Typically, a high-speed counter is used as the drive for a drum timer, where a shaft rotating at a constant
speed is fitted with an incremental shaft encoder. The shaft encoder provides a specified number of
counts per revolution and a reset pulse that occurs once per revolution. The clock(s) and the reset pulse
from the shaft encoder provide the inputs to the high-speed counter.

The high-speed counter is loaded with the first of several presets, and the desired outputs are activated
for the time period where the current count is less than the current preset. The counter is set up to provide
an interrupt when the current count is equal to preset and also when reset occurs.

As each current-count-value-equals-preset-value interrupt event occurs, a new preset is loaded and the
next state for the outputs is set. When the reset interrupt event occurs, the first preset and the first output
states are set, and the cycle is repeated.

Since the interrupts occur at a much lower rate than the counting rates of the high-speed counters, precise
control of high-speed operations can be implemented with relatively minor impact to the overall PLC scan
cycle. The method of interrupt attachment allows each load of a new preset to be performed in a separate
interrupt routine for easy state control. (Alternatively, all interrupt events can be processed in a single
interrupt routine.)

Understanding the Different High-Speed Counters

All counters function the same way for the same counter mode of operation. There are four basic types of
counters: single-phase counter with internal direction control, single-phase counter with external direction
control, two-phase counter with 2 clock inputs, and A/B phase quadrature counter. Note that every mode
is not supported by every counter. You can use each type: without reset or start inputs, with reset and
without start, or with both start and reset inputs.

1 When you activate the reset input, it clears the current value and holds it clear until you deactivate
reset.

1 When you activate the start input, it allows the counter to count. While start is deactivated, the
current value of the counter is held constant and clocking events are ignored.

1 Ifresetis activated while start is inactive, the reset is ignored and the current value is not changed.
If the start input becomes active while the reset input is active, the current value is cleared.

Before you use a high-speed counter, you use the HDEF instruction (High-Speed Counter Definition) to
select a counter mode. Use the first scan memory bit, SMO0.1 (this bit is turned on for the first scan and is
then turned off), to call a subroutine that contains the HDEF instruction.

Programming a High-Speed Counter

&

Instruction
Wizard

112

You can use the HSC Instruction Wizard to configure the counter. The wizard uses the following
information: type and mode of counter, counter preset value, counter current value, and initial counting
direction. To start the HSC Instruction Wizard, select the Tools > Instruction Wizard menu command and
then select HSC from the Instruction Wizard window.

To program a high-speed counter, you must perform the following basic tasks:
Define the counter and mode.

Set the control byte.

Set the current value (starting value).

Set the preset value (target value).

Assign and enable the interrupt routine.

UUJodUod

Activate the high-speed counter.
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Defining Counter Modes and Inputs
Use the High-Speed Counter Definition instruction to define the counter modes and inputs.

Table 6-25 shows the inputs used for the clock, direction control, reset, and start functions associated with
the high-speed counters. The same input cannot be used for two different functions, but any input not
being used by the present mode of its high-speed counter can be used for another purpose. For example,
if HSCO is being used in mode 1, which uses 10.0 and 10.2, 10.1 can be used for edge interrupts or for
HSC3.

Tip

Note that all modes of HSCO always use 10.0 and all modes of HSC4 always use 10.3, so these points
are never available for other uses when these counters are in use.

Table 6-25  Inputs for the High-Speed Counters

Mode Description Inputs

HSCO 10.0 10.1 10.2
HSC1 10.6 10.7 10.2 11.1
HSC2 11.2 11.3 11.1 11.2
HSC3 10.1
HSC4 10.3 10.4 10.5
HSC5 10.4

0 Single-phase counter with internal Clock

1 direction control Clock Reset

2 Clock Reset Start

3 Single-phase counter with external Clock Direction

4 direction control Clock Direction Reset

5 Clock Direction Reset Start

6 Two-phase counter with 2 clock inputs  Clock Up Clock Down

7 Clock Up Clock Down Reset

8 Clock Up Clock Down Reset Start

9 A/B phase quadrature counter Clock A Clock B

10 Clock A Clock B Reset

11 Clock A Clock B Reset Start
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Examples of HSC Modes

The timing diagrams in Figure 6-21 through Figure 6-25 show how each counter functions according to
mode.

Current value loaded to 0, preset loaded to 4, counting direction set to up.
Counter enable bit set to enabled.

PV=CV interrupt generated
Direction changed within interrupt routine

1
cock  o— - LI LI LI L L L L L
l ! 1 1 1 1 ' ' ' ' '
Internal Lt ' ' || ' ' ' ' '
Direction 0—
Control
(1=Up)
Counter
Current
Value -

Figure 6-21  Operation Example of Modes 0, 1, or 2

Current value loaded to 0, preset loaded to 4, counting direction set to up.
Counter enable bit set to enabled.

PV=CV interrupt generated

PV=CV interrupt generated and
Direction Changed interrupt generated

Clock 0_

External 1 __
Direction
Control

(1=Up)

Counter
Current
Value

0—

Figure 6-22  Operation Example of Modes 3, 4, or 5
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When you use counting modes 6, 7, or 8, and rising edges on both the up clock and down clock inputs

occur within 0.3 microseconds of each other, the high-speed counter could see these events as

happening simultaneously. If this happens, the current value is unchanged and no change in counting
direction is indicated. As long as the separation between rising edges of the up and down clock inputs is
greater than this time period, the high-speed counter captures each event separately. In either case, no

error is generated and the counter maintains the correct count value.

Current value loaded to 0, preset loaded to 4, initial counting direction set to up.
Counter enable bit set to enabled.

PV=CV interrupt generated

Count 1 PV=CV interrupt generated and

Ugun - '_|_|_l_\_l_\_l_\_‘_| Direction Changed interrupt generated
Clock 0—

Count 1

Down

Clock 0—

Counter

Current

Value 0o__

Figure 6-23  Operation Example of Modes 6, 7, or 8

Current value loaded to 0, preset loaded to 3, initial counting direction set to up.
Counter enable bit set to enabled.

PV=CV interrupt
generated

Phase A 1__

il N Hpl

PhaseB 1 __ | \

Clock .
oc| 0— - -

Counter
Current
Value 0

PV=CV interrupt generated and
Direction Changed interrupt generated

Figure 6-24  Operation Example of Modes 9, 10, or 11 (Quadrature 1x Mode)
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Current value loaded to 0, preset loaded to 9, initial counting direction set to up.

Counter enable bit set to enabled.

PV=CV interrupt generated

Direction Changed
interrupt generated

PV=CV
interrupt generated

L

Phase A ,
cock o | LI L1

' PR R R T B T B B I
Phase B 1 ' I
Clock 0: I ' ' ' ' ' '

12

Counter Current
Value 0

Figure 6-25

Reset and Start Operation

Operation Example of Modes 9, 10, or 11 (Quadrature 4x Mode)

The operation of the reset and start inputs shown in Figure 6-26 applies to all modes that use reset and
start inputs. In the diagrams for the reset and start inputs, both reset and start are shown with the active

state programmed to a high level.

Example with Reset

and without Start and Start

Start 1
(Active High)

Reset interrupt
generated

Reset 1
1 (Active High)

Reset
(Active High)

+2,147,483,647 —

Example with Reset

_ I

+2,147,483,647 —

| Reset interrupt Reset interrupt

generated generated
Counter | Counter Counter Counter
disabled | enabled disabled enabled

N [T

Counter 0— Counter 0— Cl;re;t Cl;re;t
Current Value Current Value vaul vaul
frozen frozen
—2,147,483,648 — \ /‘ —2,147,483,648 — K /‘ /

Y 7
Counter value is somewhere in this range.

\ 7
Counter value is somewhere in this range.

Figure 6-26  Operation Examples Using Reset with and without Start
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Four counters have three control bits that are used to configure the active state of the reset and start
inputs and to select 1x or 4x counting modes (quadrature counters only). These bits are located in the
control byte for the respective counter and are only used when the HDEF instruction is executed. These
bits are defined in Table 6-26.

Tip
You must set these three control bits to the desired state before the HDEF instruction is executed.
Otherwise, the counter takes on the default configuration for the counter mode selected.

Once the HDEF instruction has been executed, you cannot change the counter setup unless you first
place the S7-200 in STOP mode.

Table 6-26  Active Level for Reset, Start, and 1x/4x Control Bits

HSCO HSC1 HSC2 HSC4 Description (used only when HDEF is executed)

Active level control bit for Reset!:
0 = Reset is active high 1 = Reset is active low

SM37.0 SM47.0 SM57.0 SM147.0

Active level control bit for Start!:

— | SM47.1 ) SM57.1 — 0 = Start is active high 1 = Start is active low

Counting rate selection for quadrature counters:

SM37.2 | SM47.2 | SM57.2 | SM147.2 0 = 4X counting rate 1 = 1X counting rate

1 The default setting of the reset input and the start input are active high, and the quadrature counting rate is 4x (or four
times the input clock frequency).

Example: High-Speed Counter Definition Instruction

M Network 1 Network 1 //On the first scan:
? S0 MOV B Zl tSetlject tr:_e stre]l_rt hand drestTt |r;auts ;
| ] EN ENO )I 0 be active high and select 4x mode.
N I /[2.  Configure HSC1 for quadrature mode
1earadin ouT FemBaT /I with reset and start inputs
LD SMO0.1
MOVB  16#F8, SMB47
HOEF HDEF 1,11
EN  ENOF—)
14HSC
114{MODE
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Setting the Control Byte

After you define the counter and the counter mode, you can program the dynamic parameters of the
counter. Each high-speed counter has a control byte that allows the following actions:

1 Enabling or disabling the counter
1 Controlling the direction (modes 0, 1, and 2 only), or the initial counting direction for all other modes
1 Loading the current value
1 Loading the preset value
Examination of the control byte and associated current and preset values is invoked by the execution of
the HSC instruction. Table 6-27 describes each of these control bits.
Table 6-27  Control Bits for HSCO, HSC1, HSC2, HSC3, HSC4, and HSC5
HSCO HSC1 HSC2 HSC3 HSC4 HSC5 Description

Counting direction control bit:

SM37.3 SM47.3 SM57.3 SM137.3 SM147.3 SM157.3 0 = Count down 1 = Count up

Write the counting direction to the HSC:

SM37.4 SM47.4 SM57.4 SM137.4 SM147.4 SM157.4 0 = No update 1 = Update direction

Write the new preset value to the HSC:

SM37.5 SM47.5 SM57.5 SM137.5 SM147.5 SM157.5 0 = No update 1 = Update preset

Write the new current value to the HSC:
0 = No update 1 = Update current value

Enable the HSC:
0 = Disable the HSC 1 = Enable the HSC

SM37.6 SM47.6 SM57.6 SM137.6 SM147.6 SM157.6

SM37.7 SM47.7 SM57.7 SM137.7 SM147.7 SM157.7

Setting Current Values and Preset Values

Each high-speed counter has a 32-bit current value and a 32-bit preset value. Both the current and the
preset values are signed integer values. To load a new current or preset value into the high-speed
counter, you must set up the control byte and the special memory bytes that hold the current and/or preset
values, and also execute the HSC instruction to cause the new values to be transferred to the high-speed
counter. Table 6-28 lists the special memory bytes used to hold the new current and preset values.

In addition to the control bytes and the new preset and current holding bytes, the current value of each
high-speed counter can only be read using the data type HC (High-Speed Counter Current) followed by
the number (0, 1, 2, 3, 4, or 5) of the counter. The current value is directly accessible for read operations,
but can only be written with the HSC instruction.

Table 6-28  Current and Preset Values of HSCO, HSC1, HSC2, HSC3, HSC4, and HSC5

Value to be Loaded HSCO HSC1 HSC2 HSC3 HSC4 HSC5
New current SMD38 SMDA48 SMD58 SMD138 SMD148 SMD158
New preset SMD42 SMD52 SMD62 SMD142 SMD152 SMD162
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Addressing the High-Speed Counters (HC)

To access the count value for the high-speed counter, specify the address of the high-speed counter,
using the memory type (HC) and the counter number (such as HCO). The current value of the high-speed
counter is a read-only value that can be addressed only as a double word (32 bits), as shown in

Figure 6-27.

HC 2 MSB LsSB
; 31 0
High-speed counter number — —
| Most significant Least significant

Area identifier (high-speed counter)
Byte 3 Byte 2 Byte 1 Byte 0

Figure 6-27  Accessing the High-Speed Counter Current Values

Assigning Interrupts

All counter modes support an interrupt on current value equal to the preset value. Counter modes that use
an external reset input support an interrupt on activation of the external reset. All counter modes except
modes 0, 1, and 2 support an interrupt on a change in counting direction. Each of these interrupt
conditions can be enabled or disabled separately. For a complete discussion on the use of interrupts, see
the section on Communications and Interrupt instructions.

Notice

A fatal error can occur if you attempt either to load a new current value or to disable and then re-enable
the high-speed counter from within the external reset interrupt routine.

Status Byte

A status byte for each high-speed counter provides status memory bits that indicate the current counting
direction and whether the current value is greater or equal to the preset value. Table 6-29 defines these
status bits for each high-speed counter.

Tip
Status bits are valid only while the high-speed counter interrupt routine is being executed. The purpose

of monitoring the state of the high-speed counter is to enable interrupts for the events that are of
consequence to the operation being performed.

Table 6-29  Status Bits for HSCO, HSC1, HSC2, HSC3, HSC4, and HSC5
HSCO HSC1 HSC2 HSC3 HSC4 HSC5 Description

SM36.0 SM46.0 SM56.0 SM136.0 SM146.0 SM156.0 Not used
SM36.1 SM46.1 SM56.1 SM136.1 SM146.1 SM156.1 Not used
SM36.2 SM46.2 SM56.2 SM136.2 SM146.2 SM156.2 Not used
SM36.3 SM46.3 SM56.3 SM136.3 SM146.3 SM156.3 Not used
SM36.4 SM46.4 SM56.4 SM136.4 SM146.4 SM156.4 Not used

SM36.5 SM46.5 SM56.5 SM136.5 SM146.5 SM156.5 Current counting direction status bit:

0 = Counting down
1 = Counting up

SM36.6 SM46.6 SM56.6 SM136.6 SM146.6 SM156.6 Currentvalue equals preset value status bit:

0 = Not equal
1=Equal

SM36.7 SM46.7 SM56.7 SM136.7 SM146.7 SM156.7 Current value greater than preset value status bit:

0 = Less than or equal
1 = Greater than
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Sample Initialization Sequences for the High-Speed Counters

HSC1 is used as the model counter in the following descriptions of the initialization and operation
sequences. The initialization descriptions assume that the S7-200 has just been placed in RUN mode,
and for that reason, the first scan memory bit is true. If this is not the case, remember that the HDEF
instruction can be executed only one time for each high-speed counter after entering RUN mode.
Executing HDEF for a high-speed counter a second time generates a run-time error and does not change
the counter setup from the way it was set up on the first execution of HDEF for that counter.

Tip
Although the following sequences show how to change direction, current value, and preset value

individually, you can change all or any combination of them in the same sequence by setting the value
of SMBA47 appropriately and then executing the HSC instruction.

Initialization Modes O, 1, or 2

The following steps describe how to initialize HSC1 for Single Phase Up/Down Counter with Internal
Direction (Modes 0, 1, or 2).

1. Use the first scan memory bit to call a subroutine in which the initialization operation is performed.
Since you use a subroutine call, subsequent scans do not make the call to the subroutine, which
reduces scan time execution and provides a more structured program.

2. Inthe initialization subroutine, load SMB47 according to the desired control operation. For example:

SMBA47 = 16#F8 Produces the following results:
Enables the counter
Writes a new current value
Writes a new preset value
Sets the direction to count up
Sets the start and reset inputs to be active high

3. Execute the HDEF instruction with the HSC input set to 1 and the MODE input set to one of the
following: O for no external reset or start, 1 for external reset and no start, or 2 for both external reset
and start.

4. Load SMDA48 (double-word-sized value) with the desired current value (load with O to clear it).
Load SMD52 (double-word-sized value) with the desired preset value.

6. In order to capture the current value equal to preset event, program an interrupt by attaching the
CV = PV interrupt event (event 13) to an interrupt routine. See the section that discusses the
Interrupt Instructions for complete details on interrupt processing.

7. Inorder to capture an external reset event, program an interrupt by attaching the external reset
interrupt event (event 15) to an interrupt routine.

8. Execute the global interrupt enable instruction (ENI) to enable interrupts.
9. Execute the HSC instruction to cause the S7-200 to program HSC1.

10. Exit the subroutine.
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Initialization Modes 3, 4, or 5

The following steps describe how to initialize HSC1 for Single Phase Up/Down Counter with External
Direction (Modes 3, 4, or 5):

1.

9.

Use the first scan memory bit to call a subroutine in which the initialization operation is performed.
Since you use a subroutine call, subsequent scans do not make the call to the subroutine, which
reduces scan time execution and provides a more structured program.

In the initialization subroutine, load SMB47 according to the desired control operation. For example:

SMBA47 = 16#F8 Produces the following results:
Enables the counter
Writes a new current value
Writes a new preset value
Sets the initial direction of the HSC to count up
Sets the start and reset inputs to be active high

Execute the HDEF instruction with the HSC input set to 1 and the MODE input set to one of the
following: 3 for no external reset or start, 4 for external reset and no start, or 5 for both external reset
and start.

Load SMDA48 (double-word-sized value) with the desired current value (load with O to clear it).
Load SMD52 (double-word-sized value) with the desired preset value.

In order to capture the current-value-equal-to-preset event, program an interrupt by attaching the
CV = PV interrupt event (event 13) to an interrupt routine. See the section that discusses the
Interrupt Instructions for complete details on interrupt processing.

In order to capture direction changes, program an interrupt by attaching the direction changed
interrupt event (event 14) to an interrupt routine.

In order to capture an external reset event, program an interrupt by attaching the external reset
interrupt event (event 15) to an interrupt routine.

Execute the global interrupt enable instruction (ENI) to enable interrupts.

10. Execute the HSC instruction to cause the S7-200 to program HSC1.

11. Exit the subroutine.

Initialization Modes 6, 7, or 8

The following steps describe how to initialize HSC1 for Two Phase Up/Down Counter with Up/Down
Clocks (Modes 6, 7, or 8):

1.

Use the first scan memory bit to call a subroutine in which the initialization operations are
performed. Since you use a subroutine call, subsequent scans do not make the call to the
subroutine, which reduces scan time execution and provides a more structured program.

In the initialization subroutine, load SMB47 according to the desired control operation. For example:

SMBA47 = 16#F8 Produces the following results:
Enables the counter
Writes a new current value
Writes a new preset value
Sets the initial direction of the HSC to count up
Sets the start and reset inputs to be active high

Execute the HDEF instruction with the HSC input set to 1 and the MODE set to one of the following:
6 for no external reset or start, 7 for external reset and no start, or 8 for both external reset and start.

Load SMDA48 (double-word-sized value) with the desired current value (load with O to clear it).
Load SMD52 (double-word-sized value) with the desired preset value.

In order to capture the current-value-equal-to-preset event, program an interrupt by attaching the
CV = PV interrupt event (event 13) to an interrupt routine. See the section on interrupts.
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7. Inorder to capture direction changes, program an interrupt by attaching the direction changed
interrupt event (event 14) to an interrupt routine.

8. In order to capture an external reset event, program an interrupt by attaching the external reset
interrupt event (event 15) to an interrupt routine.

9. Execute the global interrupt enable instruction (ENI) to enable interrupts.
10. Execute the HSC instruction to cause the S7-200 to program HSC1.

11. Exit the subroutine.

Initialization Modes 9, 10, or 11

The following steps describe how to initialize HSC1 for A/B Phase Quadrature Counter (for modes 9, 10,
or 11):

1. Use the first scan memory bit to call a subroutine in which the initialization operations are
performed. Since you use a subroutine call, subsequent scans do not make the call to the
subroutine, which reduces scan time execution and provides a more structured program.

2. Inthe initialization subroutine, load SMB47 according to the desired control operation.

Example (1x counting mode):
SMBA47 = 16#FC Produces the following results:
Enables the counter
Writes a new current value
Writes a new preset value
Sets the initial direction of the HSC to count up
Sets the start and reset inputs to be active high

Example (4x counting mode):
SMBA47 = 16#F8 Produces the following results:
Enables the counter
Writes a new current value
Writes a new preset value
Sets the initial direction of the HSC to count up
Sets the start and reset inputs to be active high

3. Execute the HDEF instruction with the HSC input set to 1 and the MODE input set to one of the
following: 9 for no external reset or start, 10 for external reset and no start, or 11 for both external
reset and start.

4. Load SMDA48 (double-word-sized value) with the desired current value (load with O to clear it).
Load SMD52 (double-word-sized value) with the desired preset value.

6. In order to capture the current-value-equal-to-preset event, program an interrupt by attaching the
CV = PV interrupt event (event 13) to an interrupt routine. See the section on enabling interrupts
(ENI) for complete details on interrupt processing.

7. Inorder to capture direction changes, program an interrupt by attaching the direction changed
interrupt event (event 14) to an interrupt routine.

8. In order to capture an external reset event, program an interrupt by attaching the external reset
interrupt event (event 15) to an interrupt routine.

9. Execute the global interrupt enable instruction (ENI) to enable interrupts.
10. Execute the HSC instruction to cause the S7-200 to program HSC1.

11. Exit the subroutine.
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Change Direction in Modes 0, 1, or 2
The following steps describe how to configure HSC1 for Change Direction for Single Phase Counter with
Internal Direction (Modes 0, 1, or 2):

1. Load SMB47 to write the desired direction:

SMB47 = 16#90 Enables the counter
Sets the direction of the HSC to count down

SMBA47 = 16#98 Enables the counter
Sets the direction of the HSC to count up

2. Execute the HSC instruction to cause the S7-200 to program HSC1.

Loading a New Current Value (Any Mode)
Changing the current value forces the counter to be disabled while the change is made. While the counter
is disabled, it does not count or generate interrupts.

The following steps describe how to change the counter current value of HSC1 (any mode):

1. Load SMB47 to write the desired current value:

SMB47 = 16#C0 E